Notes for the reader

Introduction

This manual helps you to use the Océ TDS450. The manual contains a description of the Océ TDS450 and guidelines to use and operate the Océ TDS450. There are also tips to increase your knowledge of the Océ TDS450 and to help you manage the workflow even better.

Definition

Attention Getters

Parts of this manual require your special attention. These parts provide important, additional information or are about the prevention of damage to your properties.

Note, Attention and Caution

The words Note, Attention and Caution indicate these important parts.

- The word Note comes before additional information about the correct operation of the Océ TDS450 or a tip.
- A part marked with Attention contains information to prevent damage to items, for example the Océ TDS450, an original or a file.
- A part marked with Caution contains information to prevent personal injury. Caution is found only in manuals that describe physical products.

Safety information

The safety information for this product is included in a separate manual with the title Safety manual. This manual is part of the documentation set that you received with your product.
Contents

Notes for the reader 3

Chapter 1
Introduction
The product concept and complete workflow 12
How to use this manual 14
Available documentation 15
The Océ TDS450 users 18

Chapter 2
Get to know the Océ TDS450 scanner
The Océ TDS450 scanner 22
The scanner operator panel 24

Chapter 3
Get to know the Océ Power Logic® controller applications
The Océ Power Logic® controller 28
Océ Settings Editor 31
   Introduction to the Océ Power Logic® controller: Océ Settings Editor 31
   Overview 33
      Overview of the Océ Settings Editor 33
      Start the Océ Power Logic® controller applications 40
   Use the Océ Settings Editor 41
      Define the settings in the Océ Settings Editor 41
      Save, load, and print the settings 42
Océ System Control Panel 44
   Introduction to the Océ Power Logic® controller: Océ System Control Panel 44
   Overview of the Océ System Control Panel 45
   Icons 49
Océ Queue Manager 50
   Introduction to the Océ Power Logic® controller: Océ Queue Manager 50
   Overview of the Océ Queue Manager 52
   Icons 56
Océ Scan Manager 57
   Introduction to the Océ Power Logic® controller: Océ Scan Manager 57
   Overview of the Océ Scan Manager 58
Océ Remote Logic® 62
   Introduction to Océ Remote Logic® 62
   Install and start Océ Remote Logic 63
      Install Océ Remote Logic® on your system 63
      Start the applications with Océ Remote Logic® 66
Connect to the controller 69
Use Océ Remote Logic 71
Automatic logon 71
Change the password 72
Log on to the controller applications 73

Océ License Logic 75
About Océ License Logic 75
The possibilities of Océ License Logic 76
The basic workflow of license activation 77
The structure of license files and licenses 78

Chapter 4
Get to know the Océ TDS450 printer
The Océ TDS450 printer 82
The printer operator panel 84
The menu structure of the printer 86

Chapter 5
Get to know the finishing options
Introduction 92
The folder components 95

Chapter 6
Get to know the software applications
Job submission software 98
Job submission methods 98
Accounting software: Océ Account Center 99
Introduction 99
An overview of Océ Account Center 99
Océ Account Logic 101
Introduction to Océ Account logic 101
Summary of Océ Account Logic 102
Océ Power Logic® controller setup 103
Océ Account Console 106
Introduction to Océ Account Console 106
Summary of Océ Account Console 107
Document management software 108
Océ Repro Desk 108
Océ Engineering Exec® 109

Chapter 7
Prepare the Océ TDS450 for use
Turn the Océ TDS450 on and off 112
Turn the Océ TDS450 scanner on and off 112
Turn on and shut down the Océ Power Logic® controller 114
Turn the Océ TDS450 printer on and off 115
Print the menu card of the Océ TDS450 printer 116
Print the configuration report of the Océ TDS450 printer 117
Print the demo print of the Océ TDS450 printer 118

Define the display languages 119
  Define the display languages of the scanner and the controller 119
  Define the display language of the printer 120

Define the network settings 121
  Define the network settings with the Océ Settings Editor 121
  Define the network settings at the printer operator panel 122
    About the network settings 122
    Access the system settings in the system menu 123
    Define the DHCP server 124
    Define the IP address 125
    Define the subnet mask 126
    Define the default gateway 127

Define the time-outs 128
  About the time-out settings 128
  Behaviour of the unused Océ TDS450 scanner and time-out settings 129
  Define the sleep mode time-out of the Océ TDS450 scanner 130
  Define the panel time-out of the scanner operator panel 131
  Define the set time-out of a copy job 132
  Define the manual feed time-out at the printer operator panel 133

---

Chapter 8

Set up your workflow with the Océ Power Logic® controller applications

Introduction 136

Set up your workflow with the Océ Settings Editor 137
  Define the job templates 137
  Define the automatic original feed setting 139
  Define the original release mode 140
  Create the stamps and their default settings 141
  Define the media series 142

---

Chapter 9

Control your workflow with the Océ Power Logic® controller applications

Control your print and copy workflow with the Océ Queue Manager 144
  User operations in the Océ Queue Manager 144

Control your scan workflow with the Océ Scan Manager 147
  Create destinations 147
  Manage destinations 150
  Define a file name 152
  Manage the scanned files 153
  Introduction to Océ View Station LT 156
  Overview of Océ View Station LT 157

Control your licenses with Océ License Logic 162
  Log on to Océ License Logic 162
  View the current active licenses 164
  Get the host id of the Océ system 166
  Save the current active licenses 167
Chapter 10
Print jobs
Use the printer drivers to send jobs to the Océ TDS450 printer 172
Use Océ Print Exec® Workgroup LT to send print jobs to the Océ TDS450 printer 173
Print on a cut sheet 174
Cancel a print job 176

Chapter 11
Copy jobs
Introduction to copy jobs 178
Use the scanner operator panel 180
Do a basic copy job 184
Do an extended copy job 185
Stop a copy job 187
Extended copy jobs 188
Available settings for copy jobs 188
Improve the copy quality according to the original 190
Make multiple sets of copies 194
Make a copy with a stamp 197
Scale to another media size 199
Make a copy on a cut sheet 201
Make a copy and add a strip 203
Make a copy and remove a strip 205
Make a copy of a specific area of an original 207
Make a copy and delete a specific area of an original 209

Chapter 12
Scan-to-file jobs
Introduction to scan-to-file jobs 212
Use the scanner operator panel 214
Do a basic scan-to-file job 218
Do an extended scan-to-file job 219
Stop a scan-to-file job 221
Settings for extended scan-to-file jobs 222
Available settings for scan-to-file jobs 222
'File type' 224
'Resolution' 226
'Original type' and background compensation 227
'Original width' 228
'Remove strip' 229

Chapter 13
Finish copy and print jobs
Overview of the finishing settings 232
Define the folded output delivery 236
Define the folding method 237
  Define the folding legend 237
  Define the drawing method 238
Define the binding method 239
  Define the binding method 239
  Define the binding edge value 240
Define the folded package size 241
  Define the folded package length 241
  Define the folded package width 242
The reinforcement unit 243
The belt unit 244
Off-line folding 245

Chapter 14
Maintain the Océ TDS450
Clear the set memory 248
Maintain the Océ TDS450 scanner 250
  Clear an original jam 250
  Scanner error-messages and solutions 251
  Calibrate the scanner 252
  Clean the scan area 254
Maintain the Océ TDS450 printer 256
  Media 256
    Load the media 256
    Define the media type and media size 262
    Cut the media 264
    Define the media series of the Océ TDS450 printer 265
  Toner 266
    Refill the toner 266
Handle media jams at the Océ TDS450 printer 269
  Printer error-messages and solutions 269
  Printer system-messages and solutions 271
  Clear media jam in the media feed section of the printer 274
  Clear media jam in the fuser section 275
Maintain the finishing options 277
  The reinforcement unit 277
    Insert a new tape roll 277
    Empty the waste box 285
    Clean the reinforcement knives 287
  Handle errors at the reinforcement unit 289
    No reinforcement strips on the output 289
    Clear tape jam in the reinforcement unit 291
Handle media jams at the folder 293
  Clear media jams in the folder 293
Appendix A

**System specifications 301**
Specifications Océ TDS450 scanner 302
Original types for the Océ TDS450 scanner 304
Specifications Océ Power Logic® controller 306
Specifications Océ TDS450 printer 309
Supported media types and sizes for the Océ TDS450 printer 310
  - Available media types 310
  - Available media sizes 312
Standard scale factor 314
Specifications Océ Scan Logic® 316
Specifications drivers and job submission software 318

Appendix B

**Miscellaneous 321**
Reader's comment sheet 322
Addresses of local Océ organisations 324
Chapter 1
Introduction
The product concept and complete workflow

Definition

A complete Océ solution includes several different hardware and software products to manage your complete document workflow. The complete document workflow includes several different jobs and documents. The following illustration gives an overview of a complete Océ solution and the document workflow.

Illustration

Different documents

The complete workflow includes the following different documents.

<table>
<thead>
<tr>
<th>Nr.</th>
<th>Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Original</td>
</tr>
<tr>
<td>2</td>
<td>Copy</td>
</tr>
<tr>
<td>3</td>
<td>Print</td>
</tr>
<tr>
<td>4</td>
<td>File</td>
</tr>
</tbody>
</table>
Different products
The complete Océ solution is a combination of the following elements.

- Scanner
- Controller
- Printer
- Finishing options
- Job submission software
- Document management software.

Different jobs
The arrows in the illustration show the different possible jobs (see figure 1 on page 12). The complete document workflow of the Océ solution includes the following different jobs.

- Print job.
  A print job starts with a file (4) and ends with a print (3).
- Copy job.
  A copy job starts with an original (1) and ends with a copy (2).
- Scan-to-file job.
  A scan-to-file job starts with an original (1) and ends with a file (4).
- Set-up and control the complete workflow.

Do which job where
Use the following products to do the following jobs.

- Print jobs on the job submission software
- Copy jobs on the scanner operator panel
- Scan-to-file jobs on the scanner operator panel
- Set up and control the complete workflow on the controller.

Note: A setting in the job submission software or driver always overrules a system setting.
How to use this manual

Introduction

You can access a topic quickly through the following methods.
- Refer to the alphabetical index at the end of the manual.
- Refer to the table of contents at the beginning of this manual.

Before you turn to the complete table of contents, you can also use the following table to find a topic quickly.

The sections of this manual

The following table gives an overview of how the chapters are arranged logically.

<table>
<thead>
<tr>
<th>Chapters</th>
<th>Section</th>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - 6</td>
<td>Get to know the system</td>
<td>■ The product concept and complete workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Scanner</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Controller</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Printer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Finishing options.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Software applications.</td>
</tr>
<tr>
<td>7 - 9</td>
<td>Set up and control the system</td>
<td>■ Set up the system.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Set up the workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Control the workflow.</td>
</tr>
<tr>
<td>10 - 13</td>
<td>Use the system</td>
<td>■ Copy job</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Print job</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Scan job</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Finishing options.</td>
</tr>
<tr>
<td>14</td>
<td>Maintain the system</td>
<td>■ Replace media</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Add toner</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Maintain the scanner, printer and finishing options.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Find solutions.</td>
</tr>
<tr>
<td>Appendix A &amp; B</td>
<td>Specifications</td>
<td>■ System specifications</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Supported media types and sizes.</td>
</tr>
</tbody>
</table>
Available documentation

Introduction

This manual is part of a complete documentation set. The following table shows a complete overview of the available documentation.
## Available documentation

<table>
<thead>
<tr>
<th>Product</th>
<th>Documentation</th>
<th>Medium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Océ TDS450</td>
<td>Océ TDS450 User manual.</td>
<td>CD-ROM, as a PDF file in multiple languages.</td>
</tr>
<tr>
<td>Océ Power Logic® controller</td>
<td>Océ TDS-TCS connectivity manual.</td>
<td>CD-ROM, as a PDF file in English only.</td>
</tr>
<tr>
<td></td>
<td>Océ Power Logic® applications on-line help</td>
<td>Embedded in the applications, as an on-line help file in multiple languages.</td>
</tr>
<tr>
<td>Océ Windows® Printer Driver</td>
<td>Océ Windows® Printer Driver User Manual</td>
<td>CD-ROM, as a PDF file in multiple languages on Océ Driver Pack CD-ROM.</td>
</tr>
<tr>
<td></td>
<td>Océ Windows® Printer Driver on-line help</td>
<td>Embedded in the driver application as on-line help file in multiple languages.</td>
</tr>
<tr>
<td>Océ PostScript® 3 driver</td>
<td>Océ PostScript® 3 driver Getting Started</td>
<td>CD-ROM, as a PDF file in multiple languages on Océ Driver Pack CD-ROM.</td>
</tr>
<tr>
<td></td>
<td>Océ PostScript® 3 driver Getting Started</td>
<td>Embedded in the driver application as on-line help file in multiple languages.</td>
</tr>
<tr>
<td>Océ HDI Driver</td>
<td>Océ HDI Driver User Manual</td>
<td>CD-ROM, as a PDF file in multiple languages on Océ Driver Pack CD-ROM.</td>
</tr>
<tr>
<td></td>
<td>Océ HDI driver on-line help</td>
<td>Embedded in the driver application as on-line help file in multiple languages.</td>
</tr>
<tr>
<td>Product</td>
<td>Documentation</td>
<td>Medium</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Océ Windows® Raster Driver</td>
<td>Océ Windows® Raster Driver User Manual</td>
<td>CD-ROM, as a PDF file in multiple languages on Océ Driver Pack CD-ROM.</td>
</tr>
<tr>
<td></td>
<td>Océ Windows® Raster Driver on-line help</td>
<td>Embedded in the driver application as on-line help file in multiple languages.</td>
</tr>
<tr>
<td>Océ Account Center</td>
<td>Océ Account Center User Manual</td>
<td>CD-ROM, as a PDF file in multiple languages.</td>
</tr>
<tr>
<td></td>
<td>Océ Account Logic on-line help.</td>
<td>Embedded in the application, as an on-line help file in multiple languages.</td>
</tr>
<tr>
<td></td>
<td>Océ Account Console on-line help.</td>
<td>Embedded in the application, as an on-line help file in multiple languages.</td>
</tr>
<tr>
<td>Océ License Logic</td>
<td>Océ License Logic on-line help</td>
<td>Embedded in the application, as an on-line help file in multiple languages.</td>
</tr>
<tr>
<td>Océ Print Exec® Workgroup</td>
<td>Océ Print Exec® Workgroup User Manual</td>
<td>CD-ROM, as a PDF file in multiple languages.</td>
</tr>
<tr>
<td></td>
<td>Océ Print Exec® Workgroup on-line help</td>
<td>Embedded in the driver application as on-line help file in multiple languages.</td>
</tr>
</tbody>
</table>

[1] Available documentation

**Note:** Visit Océ on the internet at www.oce.com for the latest information.
The Océ TDS450 users

Introduction

The Océ TDS450 has the following types of users.
- Common user
- Repro operator
- Key operator
- System administrator.

Common user

The common user is a person who uses the system for print, copy and scan-to-file jobs. The common user has no permission to change the system settings. Therefore, the common user is referred to as an anonymous user. In order to be consistent with the Océ Power Logic® controller software, in this manual the common user is referred to as an anonymous user.

Repro operator

The repro operator is responsible for the daily use of the Océ TDS450 in a central repro department. The repro operator has no permission to change the settings in the Océ Settings Editor.
The repro operator has full permission in the Océ Queue Manager.

Key operator

The key operator is responsible for the user maintenance and the system settings of the Océ TDS450.
The key operator has the permission to define the key operator settings in the Océ Settings Editor.

<table>
<thead>
<tr>
<th>Key operator settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode</strong></td>
</tr>
</tbody>
</table>
| Key operator | - System settings  
- Printer settings  
- Scanner settings  
- Job settings for print jobs  
- Job settings for copy jobs  
- Job settings for scan-to-file jobs |
The key operator has full permission in the Océ Queue Manager.

**System administrator**

The system administrator is responsible for the installation and the configuration of the Océ TDS450 in the network environment.

The system administrator has the permission to define the system administrator settings in the Océ Settings Editor.

<table>
<thead>
<tr>
<th>System administrator settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode</strong></td>
</tr>
<tr>
<td>System administrator</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
Chapter 2
Get to know the Océ TDS450 scanner
The Océ TDS450 scanner

**Introduction**

The Océ TDS450 scanner is a wide-format scanner with an optical resolution of 600 dpi.

**Illustration**

![The Océ TDS450 scanner diagram](image-url)
The main components of the Océ TDS450 scanner

<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Top cover</td>
<td>Get access to the glass plate.</td>
</tr>
<tr>
<td>2</td>
<td>Original feed table</td>
<td>Feed the original.</td>
</tr>
<tr>
<td>3</td>
<td>Operator panel</td>
<td>Define the job settings.</td>
</tr>
<tr>
<td>4</td>
<td>On / off switch</td>
<td>Turn the Océ TDS450 scanner on and off.</td>
</tr>
<tr>
<td>5</td>
<td>Integrated receiving tray</td>
<td>Receive the originals.</td>
</tr>
</tbody>
</table>
The scanner operator panel

Introduction

Use the scanner operator panel to do a copy or scan-to-file job.

Illustration

[3] The operator panel of the Océ TDS450 scanner
# The keys and their functions

<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
</table>
| 1      | Green and red light| Indicate the status of the scanner.  
- A green light indicates that the scanner is ready.  
- A blinking green light indicates that the scanner is busy.  
- A red light indicates that an error occurred.  
- A blinking red light indicates that the scanner is busy and an error occurred. |
| 2      | Screen             | Show the system information in text and icons.                          |
| 3, 12  | Upper softkeys     | The upper-left softkey can have one of the following functions.  
- Select the job, 'Copy' or 'Scan-to-file'.  
- Return to the home screen with the 'Home' function.  
- Cancel a set with 'Cancel set' in case of a set copy.  
The upper-right softkey can have one of the following functions.  
- Cancel a setting with the 'Cancel' function.  
- Create and close a set with the 'Create set' and 'Close set' function. |
| 4      | Scroll-wheel key   | ■ Open a template or a setting  
■ Close a setting  
■ Define a toggle setting.                         |
| 5      | Scroll wheel       | ■ Scroll to a setting or template  
■ Define the value of a setting.                     |
| 6, 10  | Lower softkeys     | The lower-left softkey can have one of the following functions.  
- Select another language.  
- Reset the settings of the templates with the 'Defaults' function.  
The lower-right softkey can have one of the following functions.  
- Close a setting with the 'Close' function.  
- Open the system settings with the 'System' function. |
<table>
<thead>
<tr>
<th>Number</th>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Start key</td>
<td>Start a copy or scan-to-file job.</td>
</tr>
<tr>
<td>8</td>
<td>Stop key</td>
<td>- Stop a copy or scan-to-file job</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Release an original.</td>
</tr>
<tr>
<td>9</td>
<td>Numeric keys</td>
<td>Enter a numeric value.</td>
</tr>
<tr>
<td>11</td>
<td>Left softkeys</td>
<td>- Open a template.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Define a setting that contains two values. This setting is called a toggle setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Open a setting that contains various values. This setting is called a grouped setting.</td>
</tr>
</tbody>
</table>

[2] The keys and their functions

**Note:** The function of a softkey depends on where you are in the definition the job settings step.
Chapter 3
Get to know the Océ Power Logic®
controller applications
The Océ Power Logic® controller

Introduction

The Océ Power Logic® controller is based on a PC platform running Windows® XP embedded.

The Océ Power Logic® controller is required for the following.
- Process the print jobs
- Define the default system settings
- Manage the job queue
- Manage the set memory
- Receive jobs over the network.

The location of the Océ Power Logic® controller

You can place the Océ Power Logic® controller in one of the following locations.
- Inside the controller cabinet of the Océ TDS450 printer.
- When you have a monitor, a keyboard and a mouse connected to the Océ Power Logic® controller, the controller is always placed inside a separate controller cabinet.
The applications that run on the Océ Power Logic® controller

<table>
<thead>
<tr>
<th>Application</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Océ System Control Panel</td>
<td>■ Display the status of the printer&lt;br&gt;■ Display the media available on the system&lt;br&gt;■ Display the status of the scanner&lt;br&gt;■ Display the volume of set memory in use&lt;br&gt;■ Print the configuration settings&lt;br&gt;■ Print a demo print.</td>
</tr>
<tr>
<td>Océ Settings Editor</td>
<td>With the Océ Settings Editor you can view or edit the default settings of the system. The repro operator and the anonymous users can only view the default settings. To edit the default settings you need a password. There are two types of settings.&lt;br&gt;■ Key operator settings (KO settings). To edit the key operator settings you need a key-operator password.&lt;br&gt;■ System administrator settings (SA settings). To edit the system administrator settings you need a system administrator password.</td>
</tr>
<tr>
<td>Océ Queue Manager</td>
<td>■ Control and view the job queue&lt;br&gt;■ Inspect the progress of a job by set and page.&lt;br&gt;■ Cancel jobs&lt;br&gt;■ Delete jobs&lt;br&gt;■ Pause and restart jobs&lt;br&gt;■ Move jobs to the top of the queue&lt;br&gt;■ Reprint multiple sets from the history queue.&lt;br&gt;■ Print jobs from the inbox queue&lt;br&gt;■ View the properties of jobs in the print queue, inbox queue and history queue.</td>
</tr>
<tr>
<td>Océ Scan Manager</td>
<td>■ Create and manage the destinations for scan to file&lt;br&gt;■ Define the file names&lt;br&gt;■ Manage the files&lt;br&gt;■ View the scanned files.</td>
</tr>
<tr>
<td>Océ Account Logic</td>
<td>■ Create an exact record of the print, copy and scan-to-file volume for accounting purposes.</td>
</tr>
</tbody>
</table>
### Application | Function
--- | ---
Océ License Logic | ■ Manage the licenses for the Océ software applications
Océ Remote Logic® | Use Océ Remote Logic® to access the Océ System Control Panel, the Océ Settings Editor, and the Océ Queue Manager from a remote workstation.

[3] Océ applications that can run on the Océ Power Logic® controller

**Note:** To perform some of these actions you need a password.
Océ Settings Editor

Introduction to the Océ Power Logic® controller: Océ Settings Editor

Definition

This chapter gives information about the Océ Settings Editor. The on-line help of the Océ Settings Editor application contains exact information about specific settings.

You can access the Océ Settings Editor locally on the controller if you have a keyboard, mouse and monitor with your Océ Power Logic® controller. You must use Océ Remote Logic® to connect to the Océ Settings Editor when you do not have a keyboard, mouse and monitor with your Océ Power Logic® controller.

Description of the Océ Settings Editor

Use the Océ Settings Editor to define the default settings for the system according to your requirements.

The Océ Settings Editor contains the following types of settings.

- Key Operator settings (KO settings).
- System Administrator settings (SA settings).
- A password protects the KO settings and the SA settings. Without a password, you can only view the settings.

The key operator is allowed to change the following groups of settings (see ‘Define the settings in the Océ Settings Editor’ on page 41).

- Job settings for the print jobs
- Printer settings
- System settings.
The system administrator is allowed to change the following groups of settings (see ‘Define the settings in the Océ Settings Editor’ on page 41).

- Poker settings
- Printer language (PDL) settings
- Pen settings
- Automatic Language Selection (ALS) settings
- Controller identification settings
- Set memory reservation settings
- Connectivity settings.

In the ‘Anonymous’ mode, the operator is not logged on. The anonymous user is allowed only to view the settings.
Overview

Overview of the Océ Settings Editor

Introduction

The Océ Settings Editor has the following fields.

- The menu bar
- The top toolbar
- The left toolbar
- The settings area
- The status bar.
Illustration

[4] The structure of the Océ Settings Editor

File  Edit  View  Help

[5] The menu bar

[6] The top toolbar
[7] The left toolbar
The settings area

Use this setting to define the default number of prints for each job in the system memory.

Default: 1
Range: [1 - 99]
Accuracy: 1
The menu bar

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
</table>
| 'File'  | ■ Log on to a user mode  
         ■ Log off from the previous user mode  
         ■ Open a file that contains saved settings  
         ■ Save the current settings to a file  
         ■ Connect to a different controller (for remote users only).  
         ■ Close the application. |
| 'Edit'  | ■ Define the host name  
         ■ Define the default system you want to connect to at the start-up  
         ■ Use 'Automatic logon', to start the Océ Settings Editor application automatically in the defined user mode. |
| 'View'  | ■ Toggle between the display languages  
         ■ Toggle between the display of the KO settings and the SA settings. |
| 'Help'  | ■ Access the contents of the on-line help  
         ■ Get more information about the copyright and the version of the application. |
The top toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Open'</td>
<td>Open a file that contains saved settings.</td>
</tr>
<tr>
<td>'Save as...'</td>
<td>Save all the KO settings or the SA settings in a file.</td>
</tr>
<tr>
<td>'Apply'</td>
<td>Apply the changes you made to the settings.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> <em>The button is enabled after you change a setting.</em> The button is disabled after you apply the settings, or after an undo action.*</td>
</tr>
<tr>
<td>'Undo'</td>
<td>Restore the settings to the state before the settings were changed. The 'Undo' button does not restore the factory default.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> <em>The button is enabled after you change a setting.</em> The button is disabled after you apply a changed setting.*</td>
</tr>
</tbody>
</table>

[5] The buttons of the top toolbar

The left toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Jobs'</td>
<td>Gives access to the settings for the jobs.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> <em>The 'Jobs' button is only available in the key operator view.</em></td>
</tr>
<tr>
<td>'Printer'</td>
<td>Gives access to the settings for the printer.</td>
</tr>
<tr>
<td>'System'</td>
<td>Gives access to the settings for the system.</td>
</tr>
<tr>
<td>'Scanner'</td>
<td>Gives access to the settings for the scanner.</td>
</tr>
</tbody>
</table>

[6] The buttons of the left toolbar

Click a button to access the special group of settings of this button. A shadow highlight indicates which button is activated.

The on-line help in the Océ Settings Editor includes complete information about the different settings.
The settings area

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tree structure</td>
<td>Display the settings.</td>
</tr>
<tr>
<td></td>
<td>Open a folder to show all the settings in that folder.</td>
</tr>
<tr>
<td></td>
<td>The display does not include the unavailable settings for the system components.</td>
</tr>
<tr>
<td>Update area</td>
<td>Define the settings selected in the tree structure.</td>
</tr>
<tr>
<td></td>
<td>The update area can contain additional information (definition and values) about the selected setting.</td>
</tr>
<tr>
<td></td>
<td>Only authorised users can change the settings. If the user is not authorised to change a setting, the update area is greyed out.</td>
</tr>
</tbody>
</table>

[7] The parts of the settings area

The status bar

The status bar at the bottom of the Océ Settings Editor displays the following (from left to right).

- The system status ('connected' or 'disconnected').
- The system name ('local host' if you are working on the controller).
- The user mode (key operator, system administrator or anonymous).
- The view mode (KO Settings or SA Settings).

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Connected" /></td>
<td>The Océ Settings Editor is connected to a system.</td>
</tr>
<tr>
<td><img src="image" alt="Disconnected" /></td>
<td>The Océ Settings Editor is not connected to a system.</td>
</tr>
</tbody>
</table>

[8] The icons for the connection status
Start the Océ Power Logic® controller applications

Introduction

You can start the Océ Power Logic® controller applications locally on the controller or from a remote workstation. This section describes how to start the applications locally on the Océ Power Logic® controller. The section 'Start the applications with Océ Remote Logic®' describes how to start the applications from a remote workstation (see ‘Start the applications with Océ Remote Logic®’ on page 66).

Start the applications locally on the Océ Power Logic® Controller

1. Select the 'Launcher' application.
2. Select the required application.
   The application starts with your default system.
Use the Océ Settings Editor

Define the settings in the Océ Settings Editor

Introduction

The Océ Settings Editor allows you to define the following settings.
- Key operator settings (KO settings)
- System administrator settings (SA settings).

You need a password to change the KO settings and SA settings (see ‘Log on to the controller applications’ on page 73).

Note: Only one key operator, system administrator or repro operator at a time is authorised to change the settings. An error message appears when a second user tries to log on to the key operator mode or system administrator mode. Multiple users are authorised to view the settings.

How to define the key operator settings

1. Log on to the key operator mode.
2. Use the buttons on the left toolbar to display the required group of settings.
3. Select the required settings in the tree structure.
4. Define the settings in the update area.
5. Click the ‘Apply’ button to confirm the new settings.
6. Log off from the key operator mode to prevent unauthorised use of the application.

How to define the system administrator settings

1. Log on to the system administrator mode.
2. Use the buttons on the left toolbar to display the required group of settings.
3. Select the required settings in the tree structure.
4. Define the settings in the update area.
5. Click the 'Apply' button to confirm the new settings.
6. Log off from the system administrator mode to prevent unauthorised use of the application.
Save, load, and print the settings

Introduction

It is possible that you need different settings for different customers, departments or other conditions. For this reason, you can save the settings to a file and then load the settings from a file.

The Océ TDS450 has the following special files for your use.

1. **Backup.kos/Backup.sas**
   These files contain the previous values for the key operator settings and the system administrator settings before the last 'Apply'.

2. **Current.kos/Current.sas**
   These files contain the values for the key operator settings and the system administrator settings after the last 'Apply'.

If you need a complete overview of all settings defined in the Océ Settings Editor, you can print a list of all current settings.

How to save the settings to a file

1. From the 'File' menu, select 'Save as'.
   You can also click the 'Save as' button on the toolbar.
   If the client is a local client, the screen displays a dialogue box. The user can enter a file name. The file is saved in the specified directory on the system. If the client is a remote client, the screen displays a dialogue box. The user can enter a directory name and a file name.
   
   **Note:** Repro operators and anonymous users are not authorised to save the settings to a file.
How to load the settings from a file

1. From the 'File' menu, select 'Open'.
   You can also click the 'Open' button on the toolbar.
   The screen displays a dialogue box from where you can browse to the required file.
2. Click the 'Apply' button.
   The settings are transferred to the system.
   When you are logged on as a key operator, the system only loads the KO settings.
   When you are logged on as a system administrator, the system only loads the SA settings.
   Repro operators and anonymous users are not authorised to load the settings from a file.

How to print a list of the current settings

1. From the 'System' menu in the Océ System Control Panel, select 'Print settings'.
   A list of the current settings on the Océ Power Logic® controller is printed.
Océ System Control Panel

Introduction to the Océ Power Logic® controller: Océ System Control Panel

Definition

The Océ System Control Panel application provides you with the following information about the status of the system.

- Status of the printer
- Descriptions of the different types and sizes of available media on the system
- Status of the scanner
- Status of the controller
- The amount of set memory in use.

You can access the Océ System Control Panel locally on the controller if you have a keyboard, mouse and monitor with your Océ Power Logic® controller. If you do not have a keyboard, mouse and monitor with your Océ Power Logic® controller you must use Océ Remote Logic® to connect to the Océ System Control Panel.

See 'Océ Power Logic® controller: Océ Settings Editor' for information about how to start the application locally on the controller. (see ‘Start the Océ Power Logic® controller applications’ on page 40).

See 'Océ Power Logic® controller: Océ Remote Logic®' for information about how to start the application from a remote workstation. (see ‘Start the applications with Océ Remote Logic®’ on page 66).

User operations in the Océ System Control Panel

The Océ System Control Panel allows you to

- Print your system configuration (see ‘Save, load, and print the settings’ on page 42)
- Clear the system memory (see ‘Clear the set memory’ on page 248)
- Shut down the system (see ‘Turn on and shut down the Océ Power Logic® controller’ on page 114)
Overview of the Océ System Control Panel

Introduction

The Océ System Control Panel contains the following items.

1. The menu bar
2. The toolbar, with buttons to access the view area
3. The status of the printer
4. An overview of the loaded media types
5. The status of the scanner
6. The status of the Océ Power Logic® controller
7. The amount of set memory in use
8. The status bar

Illustration

![The structure of the Océ System Control Panel](image)

[9] The structure of the Océ System Control Panel
### The menu bar

<table>
<thead>
<tr>
<th>Menu</th>
<th>Items</th>
</tr>
</thead>
</table>
| 'File' | ■ Click 'Log on' to select the user mode. Then enter the password.  
■ Click 'Log off' to leave the user mode.  
■ Click 'Connect to' and select a different controller (only for remote users).  
■ Click 'Close' to leave the Océ System Control panel. |
| 'Edit' | Click 'Options' to define the following.  
■ The 'Host name'.  
■ The 'Default system'.  
■ The 'Automatic logon'. Use 'Automatic logon' to start up automatically in the defined user mode.  
■ Select the two screen languages. |
| 'View' | ■ Select one of the display languages for the application.  
■ Display the items for the status control. Click an item to view the status. The items correspond with the buttons of the toolbar. |
| 'System' | ■ Click 'Print settings' to print a report of the configuration settings.  
■ Click 'Demo print' to make a demo print.  
■ Click 'Clear system' to remove all the jobs from the system.  
■ Click 'Shut down' to shut down the system. |
| 'Help' | ■ Click 'Contents' to access the topics of the on-line help.  
■ Click 'About' for general information about the Océ System Control Panel. |

[9] The items of the menu bar
The toolbar

Click the buttons on the toolbar of the Océ System Control Panel to check the status of the items in the view area. If operator action is required, the appropriate button will flash.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Printer'</td>
<td>View the status of the printer. If the printer operator panel displays an error, the 'Printer' status window of the Océ System Control Panel will display the same error.</td>
</tr>
<tr>
<td>'Media'</td>
<td>View the status of the media (available, empty or disabled). The 'Media' display also shows information about the available media sizes and media types. <strong>Note:</strong> When a roll is disabled, the roll icon is greyed out. The text '-disabled-' replaces the media information.</td>
</tr>
<tr>
<td>'Controller'</td>
<td>View the status of the controller.</td>
</tr>
</tbody>
</table>
| 'Memory' | Check the amount of set memory that is available. The percentage on the right-hand side of the set memory meter indicates the amount of set memory in use. The colours indicate the following.  
  ■ Green indicates that the set memory has sufficient space for a large print job or many small jobs.  
  ■ Orange indicates that the set memory approaches the red zone. Large print jobs may not be possible.  
  ■ Red indicates that the set memory is (nearly) full. The system does not accept new print jobs. Remove files or wait until files are printed and automatically removed from the memory.  
  **Note:** Define the threshold values for the orange zone and the red zone in the Océ Settings Editor. |

[10] The buttons of the toolbar
The status bar

The status bar at the bottom of the Océ System Control Panel displays the following.

- The system status (connected or disconnected).
- The system name ('local host' if you work on the Océ Power Logic® controller).
- The job status (for example 'Printing').
- The user mode (Key operator, Repro operator, System administrator, Service operator or 'Anonymous').

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>The Océ System Control Panel is connected to a system.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>The Océ System Control Panel is not connected to a system.</td>
</tr>
</tbody>
</table>

Icons

The Océ System Control Panel uses a number of icons to display the information about the media available on the printer. The following icons are used.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon 1]</td>
<td>The media roll is available and the roll is ready to print</td>
</tr>
<tr>
<td>![Icon 2]</td>
<td>The media roll is disabled.</td>
</tr>
<tr>
<td>![Icon 3]</td>
<td>The media roll is enabled but empty.</td>
</tr>
</tbody>
</table>
Océ Queue Manager

Introduction to the Océ Power Logic® controller: Océ Queue Manager

Definition

This chapter describes how to view and manage the jobs with the Océ Queue Manager.

You can access the Océ Queue Manager locally on the controller if you have a keyboard, mouse and monitor with your Océ Power Logic® controller. You must use Océ Remote Logic® to connect to the Océ Queue Manager when you do not have a keyboard, mouse and monitor with your Océ Power Logic® controller.

(see ‘Introduction to the Océ Power Logic® controller: Océ Settings Editor’ on page 31) for information about how to start the application locally on the controller. (see ‘Start the Océ Power Logic® controller applications’ on page 40).
(see ‘Start the applications with Océ Remote Logic®’ on page 66) for information about how to start the application from a remote workstation.

Description of the Océ Queue Manager

The Océ Queue Manager application provides you with a graphical image of the print queue, the history queue or the inbox queue.

The Océ Queue Manager allows you to do the following.

■ View the queue of jobs.
■ Cancel the current job.
■ Delete jobs in the queue.
■ Place jobs on hold in the queue.
■ Print jobs from the history queue.
■ Print jobs from the inbox queue.
■ Move jobs to the top of the queue.
■ Give priority to jobs in the queue.
■ Restart the jobs that were placed on hold in the queue.
User modes

The Océ Queue Manager has the following user modes.

■ The key operator mode
■ The repro operator mode
■ The system administrator mode
■ The service operator mode.

Note: The service operator mode is for the Océ service engineer only.
The user modes provide the following permissions.

The key operator, the repro operator and the system administrator user modes allow you to hold, resume or delete the jobs or to move the jobs to the top of the queue.

The anonymous user mode only allows the user to view the queue. All the buttons and menu items are disabled in this mode. The anonymous user is allowed to delete the jobs when the user works locally with the Océ Queue Manager on the controller.

Note: The key operator, the system administrator and the repro operator have the same access permissions to functions in the Océ Queue Manager and the Océ System Control Panel. The permissions to access the settings in the Océ Settings Editor vary according to the different user modes.
Overview of the Océ Queue Manager

Introduction

This section contains an overview of the Océ Queue Manager application. Use the Océ Queue Manager to manage the jobs in the job queue.

Illustration

The structure of the Océ Queue Manager

The Océ Queue Manager contains the following items.

1. The menu bar
2. The tool bar
3. The window for the print queue
4. The window for the inbox queue or history queue
5. The status bar
The Océ Queue Manager uses columns to display the following information for each job.

- The current status and the schedule of the job
- The name of the job
- The type of job (a print job or a copy job)
- The name of the user who sent the print job
- The number of sets and pages
- Remarks.

**Note:** Drag the table header separators to change the width of the columns. Drag a column to a new position to change the sequence of the columns.

---

**The menu bar**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Items</th>
</tr>
</thead>
</table>
| 'File' | ■ Click 'Log on' to select the user mode. Then enter the password.  
   ■ Click 'Log off' to leave the user mode.  
   ■ Click 'Connect to' and select a different controller (only for remote users).  
   ■ Click 'Close' to leave the Océ Queue Manager. |
| 'Edit' | Click 'Options' to define the following.  
   ■ The 'Host name'.  
   ■ The 'Default system'.  
   ■ The 'Automatic logon'. Use 'Automatic logon' to start up automatically in the defined user mode.  
   ■ Select the two screen languages. |
| 'View' | ■ Toggle between the defined display languages.  
   ■ Toggle between the 'Inbox' queue and the 'History' queue.  
   ■ Define the 'Column options'. Select the table headers you want to see when you open the Océ Queue Manager. |
| 'Job'  | Display the actions for a job. The menu items correspond with the toolbar buttons. |
| 'Help' | ■ Click 'Contents' to access the topics of the on-line help.  
   ■ Click 'About' for general information about the Océ Queue Manager. |
The toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Hold'</td>
<td>Place a job on hold in the print queue</td>
</tr>
<tr>
<td>'Resume'</td>
<td>Continue a job that was placed on hold</td>
</tr>
<tr>
<td>'Move to top'</td>
<td>Move a job to the top of the print queue, to give the job priority.</td>
</tr>
<tr>
<td>'Delete'</td>
<td>Delete a job from the print queue</td>
</tr>
<tr>
<td>'Properties'</td>
<td>View the properties of a selected job</td>
</tr>
<tr>
<td>'Print'</td>
<td>Print a job from the print queue</td>
</tr>
</tbody>
</table>

[13] The toolbar buttons

The status bar

The status bar at the bottom of the Océ Queue Manager displays the following.

- The system status (connected or disconnected).
- The system name ('local host' if you work on the Océ Power Logic® controller).
- The job status (for example 'Printing').
- The user mode ('Key operator', 'Repro operator', 'System administrator', 'Service operator' or 'Anonymous').

The window for the print queue

The print queue window in the left-hand pane contains two sections.

- The top section above the separation line shows the job that is printed.
- The bottom section under the separation line shows the jobs that wait to be printed. The window displays the jobs in the order in which the jobs are received.

The window for the inbox queue or history queue

The inbox queue in the right-hand pane contains the jobs that were sent to the inbox on the controller. You can print the jobs, delete the jobs and view the properties of the jobs. The print jobs are sent to the inbox when the setting KO - System - Job management - Print jobs in the Océ Settings Editor is set to inbox or when 'Send to inbox' is enabled in the driver.

The history queue in the right-hand pane contains the jobs that have been printed. You can print the jobs, delete the jobs and view the properties of the
jobs. Use the setting **KO - System - Job management - History queue - Print job lifetime** in the Océ Settings Editor to define how long the jobs must remain in the history queue.
The Océ Queue Manager uses a number of icons to display information about a job in the queue. The following icons are used.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Receiving a job in the inbox or the print queue.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Received a job in the print queue.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Processing a job in the print queue.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Processed a job in the print queue.</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>An active job in the print queue (bold font and above the grey separation line).</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Printing a job.</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Delivering a job to the history queue.</td>
</tr>
<tr>
<td><img src="image8" alt="Icon" /></td>
<td>Delivered a job to the history queue.</td>
</tr>
<tr>
<td><img src="image9" alt="Icon" /></td>
<td>Deleted a job.</td>
</tr>
<tr>
<td><img src="image10" alt="Icon" /></td>
<td>A job that is put on hold by default. This icon indicates that the job is displayed in the inbox.</td>
</tr>
<tr>
<td><img src="image11" alt="Icon" /></td>
<td>A job is on hold.</td>
</tr>
<tr>
<td><img src="image12" alt="Icon" /></td>
<td>Warning, a media request.</td>
</tr>
</tbody>
</table>
Océ Scan Manager

Introduction to the Océ Power Logic® controller: Océ Scan Manager

Definition

This chapter describes how to use the Océ Scan Manager for your scan-to-file jobs.

Access the Océ Scan Manager local on the controller. You must have a keyboard, mouse and monitor with your Océ Power Logic® controller to use the Océ Scan Manager.

See "Océ Power Logic® controller: Océ Settings Editor" for information about how to start the application locally on the controller. (see ‘Start the Océ Power Logic® controller applications’ on page 40).

Description of the Océ Scan Manager

The Océ Scan Manager allows you to do the following.

- Create the destinations for scan-to-file
- Define the file names
- Print scanned files
- Retrieve scanned files.

Océ View Station LT

Océ View Station LT is an application that runs with Océ Scan Manager. Océ View Station LT enables you to view the scanned file.

When 'Auto view' is enabled, Océ View Station LT starts automatically to display the scanned file when the scan to file is complete. (see ‘Manage the scanned files’ on page 153).

User modes

Only the key operator and the service operator are allowed to make changes in Océ Scan Manager.
Overview of the Océ Scan Manager

Introduction

This section contains an overview of the Océ Scan Manager application. Use the Océ Scan Manager for scan to file.

Illustration

![Image of Océ Scan Manager](image)

[11] The Océ Scan Manager

The structure of the Océ Scan Manager

The Océ Scan Manager has the following fields.

- The menu bar
- The top tool bar
- The destination area
- The scanned files area
- The status bar.
## The menu bar

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
</table>
| 'File'    | When no objects are selected, you can do the following from the 'File' menu.  
|           | ■ Log on to a user mode  
|           | ■ Log off from the previous user mode.  
|           | When a destination is selected, you can do the following from the 'File' menu.  
|           | ■ Add a new destination  
|           | ■ Delete the selected destination  
|           | ■ View the properties of the selected destination  
|           | ■ Open the destination  
|           | ■ Save the destination.  
|           | When a file is selected, the 'File' menu includes the following items.  
|           | ■ View the properties of the selected file  
|           | ■ Delete the selected file  
|           | ■ Print the selected file  
|           | ■ View the selected file.  
| 'Edit'    | Use 'Automatic logon', to start the Océ Scan Manager application automatically in the defined user mode.  
| 'View'    | Toggle between the display languages  
|           | Refresh the list of files.  
| 'System'  | Clear the temporary store  
|           | Use 'Auto view' to enable or disable the automatic view of the scan file.  
| 'Help'    | Access the contents of the on-line help  
|           | Get more information about the copyright and the version of the application.  

[14] The menu bar items
The tool bar

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'New'</td>
<td>Create a destination</td>
</tr>
<tr>
<td>'Delete'</td>
<td>Delete a destination</td>
</tr>
<tr>
<td>'View'</td>
<td>View the scanned file</td>
</tr>
<tr>
<td>'Refresh'</td>
<td>Update the screen.</td>
</tr>
<tr>
<td>'Print'</td>
<td>Print a scanned file.</td>
</tr>
</tbody>
</table>

[15] The buttons of the toolbar

The destination area

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>The tree structure (left-hand pane of the main window)</td>
<td>Displays the following.</td>
</tr>
<tr>
<td></td>
<td>■ The destinations</td>
</tr>
<tr>
<td></td>
<td>■ The temporary store</td>
</tr>
<tr>
<td></td>
<td>■ The 'Unsent' folder</td>
</tr>
<tr>
<td>The destination area (right-hand pane of the main window)</td>
<td>Displays the following.</td>
</tr>
<tr>
<td></td>
<td>■ The file name</td>
</tr>
<tr>
<td></td>
<td>■ The file type</td>
</tr>
<tr>
<td></td>
<td>■ The file resolution</td>
</tr>
<tr>
<td></td>
<td>■ The file size</td>
</tr>
<tr>
<td></td>
<td>■ The pixel size of the image</td>
</tr>
<tr>
<td></td>
<td>■ The original size</td>
</tr>
</tbody>
</table>

[16] The parts of the destination area

The scanned files area

The scanned files area shows the files scanned to the destination selected in the destination area.

The scanned files that are scanned last, are shown on the bottom of the list. When you cannot see the files that are scanned last, use the 'Refresh' button on the toolbar to update the view or select 'Refresh' in the 'View' menu.
The following information is shown for each file.
- The file name
- The file size
- When the file was last modified
- The resolution of the file
- The size of the image in the file
- The progress status of the current scan job.

**The status bar**

The status bar of Océ Scan Manager displays the following information.
- The system status (connected, disconnected)
- The system to which Océ Scan Manager is connected
- The scan clicks (indicates the area that is scanned)
- A message field
- The user mode.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Connected Icon](Connected Icon.png)</td>
<td>Océ Scan Manager is connected to a system.</td>
</tr>
<tr>
<td>![Disconnected Icon](Disconnected Icon.png)</td>
<td>Océ Scan Manager is not connected to a system.</td>
</tr>
</tbody>
</table>
Introduction to Océ Remote Logic®

The applications of Océ Remote Logic®

You must use Océ Remote Logic® to connect to the Océ Power Logic® controller applications when you do not have a keyboard, mouse and monitor with your Océ Power Logic® controller.

You can use Océ Remote Logic® to run the following applications from a remote workstation.

- **Océ Settings Editor**
  Use the application to change the default settings of the system.

- **Océ Queue Manager**
  Use the application to manage the print jobs.

- **Océ System Control Panel**
  Use the application to view the status of the printer, the scanner and the controller. You can also view the media available on the printer and the amount of set memory in use.

User modes

The Océ Remote Logic® controller applications have different user modes (see ‘The Océ TDS450 users’ on page 18). An additional user mode is the 'Service operator' mode. This mode is for the Océ technician only.
Install and start Océ Remote Logic

Install Océ Remote Logic® on your system

Introduction

The Océ Remote Logic® application can run on all platforms with Java™ Virtual Machine. This section describes the installation procedures for the different types of platforms.

Before you begin

To install Océ Remote Logic® on Windows® 9.x, NT, ME, XP, or 2000, your system must be at least equipped with a Pentium® 233 with 32 Mb RAM.

Installation procedure for Microsoft® Windows® platforms

1. Insert the Océ Remote Logic® CD-ROM or the Océ Power Logic® controller CD-ROM into the CD-ROM drive of your PC.
2. The installation starts automatically. If does not start automatically, run Setup.exe.
3. Select the required language in the installation wizard and click 'OK'.

4. Follow the instructions on the screen to complete the installation of Océ Remote Logic®.

**Note:** You can only use Océ Remote Logic® when TCP/IP is enabled on your system. Refer to your system administrator for help with the installation procedure for TCP/IP.
Installation procedure for UNIX™ platforms

1. Check if a Java™ Runtime Environment (JRE) is installed on the system.
2. From the directory Products/remotelogic/UNIX, unpack the contents of the file RemoteLogic_vX.tar to a subdirectory on the system.
3. Use tar xvf RemoteLogic_vX.tar to unpack the file.
4. Set the environment variable RL_VM_HOME to point to the installation of the JVM.
5. Run the file remotelogic with the applications as parameters (for example remotelogic QM SCP SE to start the three applications), or use remotelogic AL as the application launcher.

UNIX™ versions and the required JRE

<table>
<thead>
<tr>
<th>UNIX™ version</th>
<th>OS version</th>
<th>JRE</th>
<th>Default installation directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM® AIX</td>
<td>4.1.5</td>
<td>1.1.6</td>
<td>/usr/jdk_base</td>
</tr>
<tr>
<td>IBM® AIX</td>
<td>4.2.1</td>
<td>1.1.8</td>
<td>/usr/jdk_base</td>
</tr>
<tr>
<td>IBM® AIX</td>
<td>4.3.3 + fix</td>
<td>1.2.2</td>
<td>/usr/jdk_dev2</td>
</tr>
<tr>
<td>IBM® AIX</td>
<td>4.3.3.10 + fix</td>
<td>1.3.0</td>
<td>/usr/jdk_java130</td>
</tr>
<tr>
<td>SUN® Solaris™</td>
<td>2.6</td>
<td>1.1.6</td>
<td></td>
</tr>
<tr>
<td>HP-UX</td>
<td>10.20</td>
<td>1.1.3</td>
<td></td>
</tr>
<tr>
<td>LINUX®</td>
<td>1.0</td>
<td>1.1.3</td>
<td></td>
</tr>
<tr>
<td>LINUX®</td>
<td>1.2</td>
<td>1.1.8</td>
<td></td>
</tr>
</tbody>
</table>

Note: OS = Operating System, JRE = Java™ Runtime Environment
Where to download the Java™ Runtime Environments

<table>
<thead>
<tr>
<th>Platform</th>
<th>Preferred version</th>
<th>Download location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.1.8</td>
<td><a href="http://www.ibm.com/java">http://www.ibm.com/java</a></td>
</tr>
<tr>
<td>2</td>
<td>C.01.18.xx</td>
<td><a href="http://www.unix.hp.com/ja">http://www.unix.hp.com/ja</a> va</td>
</tr>
<tr>
<td>3</td>
<td>N/A</td>
<td><a href="http://www.ibm.com/java">http://www.ibm.com/java</a></td>
</tr>
</tbody>
</table>

[17] Download Java™ Runtime Environments

Installation procedure for other platforms

1. Install Java™ Virtual Machine (version 1.1.8).
2. From the Océ Remote Logic® CD-ROM, load RemoteLogic_vX.tar or RemoteLogic_vX.zip.
3. Set the environment variable RL_VM_HOME to point to the Java™ Products/remotelogic/UNIX installation directory.
4. If necessary, edit the Océ Remote Logic® script or batch file.
5. Use the Océ Remote Logic® script or batch file to start the applications.
Start the applications with Océ Remote Logic®

Introduction

Use the following 2 methods to start the applications with Océ Remote Logic®.

- Use the programs menu of your operating system.
- Use a command line parameter.

Use the programs menu to start the applications

1. Select 'Océ Remote Logic'
2. Select the 'Launcher' application.
3. Select the required application.

The application starts with your default system.

Note: You can select another system than your default system (see ‘Connect to the controller’ on page 69).

Use command line parameters to start the applications

Six command line parameters are available to facilitate the start of the applications.

- configfile=<config_file>
  Sets the configuration file to use.
- server=server
  Sets the indicated server as the server to connect to.
- language1=lang
  Specifies the first language in combination with the parameter country1=country
- country1=country
  Specifies the first language in combination with the parameter language1=language
- language2=lang
  Specifies the second language in combination with the parameter country2=country
- country2=country
  Specifies the second language in combination with the parameter language2=language
Note: Always use a matching combination of language and country (see the following table).

Parameters of supported languages

<table>
<thead>
<tr>
<th>Language</th>
<th>Language parameters</th>
<th>Country parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Danish</td>
<td>da</td>
<td>DK</td>
</tr>
<tr>
<td>Swedish</td>
<td>sv</td>
<td>SV</td>
</tr>
<tr>
<td>Norwegian</td>
<td>no</td>
<td>NO</td>
</tr>
<tr>
<td>Finnish</td>
<td>fi</td>
<td>FI</td>
</tr>
<tr>
<td>Hungarian</td>
<td>hu</td>
<td>HU</td>
</tr>
<tr>
<td>Czech</td>
<td>cs</td>
<td>CZ</td>
</tr>
<tr>
<td>Polish</td>
<td>pl</td>
<td>PO</td>
</tr>
<tr>
<td>German</td>
<td>de</td>
<td>DE</td>
</tr>
<tr>
<td>Dutch</td>
<td>nl</td>
<td>NL</td>
</tr>
<tr>
<td>UK English</td>
<td>en</td>
<td>GB</td>
</tr>
<tr>
<td>US English</td>
<td>en</td>
<td>US</td>
</tr>
<tr>
<td>French</td>
<td>fr</td>
<td>FR</td>
</tr>
<tr>
<td>Italian</td>
<td>it</td>
<td>IT</td>
</tr>
<tr>
<td>Spanish</td>
<td>es</td>
<td>ES</td>
</tr>
<tr>
<td>Portuguese</td>
<td>pt</td>
<td>PT</td>
</tr>
<tr>
<td>Chinese simplified</td>
<td>cn</td>
<td>CN</td>
</tr>
<tr>
<td>Chinese traditional</td>
<td>cn</td>
<td>TW</td>
</tr>
<tr>
<td>Japanese</td>
<td>ja</td>
<td>JP</td>
</tr>
</tbody>
</table>

[18] Parameters of supported languages

Apply the parameters to the applications

Apply the parameters to the following applications.
- QM.exe (Océ Queue Manager)
- SCP.exe (Océ System Control Panel)
- SE.exe (Océ Settings Editor)
- AL.exe (Application launcher).

The easiest method to apply the parameters to the applications is to create a shortcut for an application. Then add the command line properties.
**Note:** The .exe files are usually located in **C:\Program Files\Remote Logic\Bin**.

**Example of a command line parameter**

The example below shows how to start the controller applications with the configuration file 'Myconfig.cfg', connected to the 'MyTCS400' server. The first language is set to UK English and the second language is set to French.

```
C:\Program Files\Remote Logic\Bin\AL.exe
    configFile=Myconfig.cfg
    server=MyTCS400 language1=en country1=GB language2=fr
country2=FR
```
Connect to the controller

Introduction

After you start one of the Océ Remote Logic® applications, you must connect to the Océ Power Logic® controller of the Océ TDS450. You must connect to the system for every separate application.

You can do the following when you connect to the controller.
■ Select a system from the drop-down list.
■ Add a system to the drop-down list.
■ Remove a system from the drop-down list.

When the Océ TDS450 is not available in the 'Connect to' dialogue box, you must add the Océ TDS450 to the list of available systems.

How to connect to a system

1. Open the application you want to run.
2. From the 'File' menu, select 'Connect to'.
3. Select the system from the drop-down list.
4. Click 'OK'.

   **Note:** From the 'File' menu, select 'Options' to define the default system. This is recommended if you frequently connect to the same system.

How to add a system

1. From the 'File' menu, select 'Connect to'.
2. Click 'Edit'.
   The 'Edit systems' dialogue box appears.
3. Enter the IP address or the name of the system in the 'Systems' box.
4. Click 'Add'.
   The system is added to the list.
5. Click 'OK' 2 times to return to the application.
How to remove a system

1. From the 'File' menu, select 'Connect to'.
2. Click 'Edit'.
   The 'Edit systems' dialogue box appears.
3. Select the system you want to remove.
4. Click 'Remove'.
   The system is removed from the list.
5. Click 'OK' 2 times to return to the application.
Use Océ Remote Logic

Automatic logon

Introduction

The 'Automatic logon' option enables you to start an application automatically in the indicated user mode.

How to enable automatic logon

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the 'Edit' menu, select 'Options'. The 'Options' window appears.</td>
</tr>
<tr>
<td>2</td>
<td>Select the 'Enable automatic logon' checkbox.</td>
</tr>
<tr>
<td>3</td>
<td>From the drop-down box, select the user mode for the automatic logon.</td>
</tr>
<tr>
<td>4</td>
<td>Enter the password that corresponds to the selected user mode.</td>
</tr>
<tr>
<td>5</td>
<td>Click 'OK'.</td>
</tr>
</tbody>
</table>

Automatic logon is now enabled.
Change the password

How to change the password

1. From the 'File' menu, select 'Log on'.
2. Click 'Password' in the dialogue box.
3. Open the drop-down list and select a user.
4. Enter the old password.
5. Enter the new password.
6. Enter the new password a second time to confirm.
7. Click 'OK' to save the new password.
Log on to the controller applications

User modes

The Océ Power Logic® controller has the following user modes.
■ Key operator
■ Repro operator
■ System administrator
■ Service operator.

Chapter 1 contains more information about the types of users (see ‘The Océ TDS450 users’ on page 18). Chapter 12 contains more information about the user modes in the Océ Settings Editor (see ‘Introduction to the Océ Power Logic® controller: Océ Settings Editor’ on page 31). Log on to the correct user mode in the Océ Settings Editor to change the key operator settings or the system administrator settings.

Only assigned operators are allowed to use the user modes. Different passwords are required to access the user modes.
You do not need a password for the anonymous user mode.

Passwords

■ The default password for the system administrator is SysAdm.
■ The default password for the key operator is KeyOp.
■ The default password for the repro operator is ReproOp.

When a user is logged on, the user can change the password for the current user mode. (see ‘Change the password’ on page 72)

Note: The passwords are case sensitive.
Authorisation

Only one key operator, system administrator or repro operator at a time is authorised to change the settings.
An error message appears when a second user tries to log on to the key operator mode or system administrator mode.
There is no limitation of users authorised to view the settings.

![Error message when a second user tries to log on]

[13] Error message when a second user tries to log on

How to log on to the controller applications

1. From the 'File' menu, select 'Log on'.

2. Select the required user name.

3. Enter the password.

4. Click 'OK'.

You are now logged on as special user. When you are not logged on, you have 'Anonymous' user permissions. (see ‘The Océ TDS450 users’ on page 18).

The status bar at the bottom shows the user mode.

The logon is limited to one user only.

Note: You must separately log on to each application.

How to log off from the controller applications

From the 'File' menu, select 'Log off'.
You return to the anonymous user mode. Log off from the controller applications to prevent unauthorised use.

Note: You must separately log off from each application.
Océ License Logic

About Océ License Logic

Introduction

The Océ applications and options are protected against unauthorised use. You need to activate the license to enable an application or option for use. Océ License Logic enables you to manage the licenses very easy.

This section describes the following.
- The basic concept of Océ License Logic
- How to use Océ License Logic.
The possibilities of Océ License Logic

Introduction

Océ License Logic has the following possibilities.

Possibilities

- View the current active licenses
- Get the host id of the Océ system
- Save the active licenses
- Perform a license activation job.
  You can activate new licenses or saved licenses.
The basic workflow of license activation

Introduction

Before you can use the possibilities of Océ License Logic, you must log on to Océ License Logic. The following workflow describes per step when to use which possibility.

The workflow

1. Select the new options you need.
   Use the following possibilities of Océ License Logic to do so.
   - View the current active licenses
     You can make a list of new options you need and make a list of license numbers. Océ needs the list of new options and the license numbers to create a new license file.
   - Get the host id of the Océ system.
     Océ needs the host id of your Océ system to create a new license file.

2. Send the list of new options you need, the list of license numbers and the host id to Océ.
   Océ creates and delivers one or more new license files.

3. Create a back-up of the current active licenses if necessary.
   Use the following possibility of Océ License Logic to do so.
   - Save the current active licenses

4. Activate the licenses.
   Use the following possibility of Océ License Logic to do so.
   - Perform a license activation job.
     The license activation job guides you through the following steps.
     1. Locate the license file
     2. Preview the new active licenses
     3. Accept the end user license agreement
     4. Finish the license activation job
     5. Restart the controller of the Océ system.

   Note: Perform the license activation job for each license file.
The structure of license files and licenses

Introduction

A license file contains a license per option of your Océ system. You can view the current active licenses with Océ License Logic. You can preview the new active licenses with Océ License Logic during the license activation job.

A license file contains licenses of the same license-type

A license file you receive from Océ contains only licenses of the same license-type. The following license types are possible.

- Demo
- Resale.

If you order demo and resale licenses, you receive 2 license files.
What you see per situation

What you see per situation depends on the license file you use.

<table>
<thead>
<tr>
<th>Situation</th>
<th>What do you see</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the current active licenses.</td>
<td>You see the following.</td>
</tr>
<tr>
<td></td>
<td>■ All current active demo licenses</td>
</tr>
<tr>
<td></td>
<td>■ All current active resale licenses</td>
</tr>
<tr>
<td></td>
<td>■ All current other not active options.</td>
</tr>
<tr>
<td>Océ delivered one or more license files.</td>
<td>You see one of the following options.</td>
</tr>
<tr>
<td></td>
<td>■ A demo license file</td>
</tr>
<tr>
<td></td>
<td>■ A resale license file</td>
</tr>
<tr>
<td></td>
<td>■ A demo license file and a resale license file.</td>
</tr>
<tr>
<td>Preview the demo licenses during the license activation job if you use the license file with demo licences.</td>
<td>You see the following.</td>
</tr>
<tr>
<td></td>
<td>■ All current active demo licenses</td>
</tr>
<tr>
<td></td>
<td>■ All new active demo licenses.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> <em>You can not see the current active resale licenses at this point.</em></td>
</tr>
<tr>
<td>Preview the resale licenses during the license activation job if you use the license file that contains the resale licences.</td>
<td>You see the following.</td>
</tr>
<tr>
<td></td>
<td>■ All current active resale licenses</td>
</tr>
<tr>
<td></td>
<td>■ All new active resale licenses.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> <em>You can not see the current active demo licenses at this point.</em></td>
</tr>
<tr>
<td>Preview the demo and resale licenses during the license activation job if you use the saved licenses of your back-up file.</td>
<td>You see the following.</td>
</tr>
<tr>
<td></td>
<td>■ All demo licenses that where active at the time you created the back-up file</td>
</tr>
<tr>
<td></td>
<td>■ All resale licenses that where active at the time you created the back-up file</td>
</tr>
<tr>
<td>The license activation job is finished.</td>
<td>You see the following.</td>
</tr>
<tr>
<td></td>
<td>■ All current active demo licenses</td>
</tr>
<tr>
<td></td>
<td>■ All new active demo licenses.</td>
</tr>
<tr>
<td></td>
<td>■ All current active resale licenses</td>
</tr>
<tr>
<td></td>
<td>■ All new resale licenses</td>
</tr>
<tr>
<td></td>
<td>■ All current other not active options.</td>
</tr>
</tbody>
</table>

[19] What you see depends on the situation
Chapter 4
Get to know the Océ TDS450 printer
The Océ TDS450 printer

Introduction

The printer is a 36 inch black and white LED printer with a true resolution of 600 dpi. The Océ TDS450 printer is default available with an automatic 1-roll unit and an Integrated Receiving Tray as the output delivery device. An automatic 2-roll unit is available as an option. Each of the rolls can contain different types and sizes of media. The size and type of the available media are indicated on the operator panel.

Illustration

[14] The Océ TDS450 printer
### The main components of the Océ TDS450 printer

<table>
<thead>
<tr>
<th>Nr.</th>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Left cover</td>
<td>Provide access to the toner</td>
</tr>
<tr>
<td>2</td>
<td>Fuser unit</td>
<td>Provide access to the fuser section</td>
</tr>
<tr>
<td>3</td>
<td>Operator panel</td>
<td>Set up the print system and the folder settings</td>
</tr>
<tr>
<td>4</td>
<td>Manual feed table</td>
<td>Use if you need to print or copy on a cut sheet.</td>
</tr>
<tr>
<td>5</td>
<td>Drawer with media roll</td>
<td>Provide access to the media roll</td>
</tr>
<tr>
<td>6</td>
<td>Integrated Receiving Tray</td>
<td>Receive the copies and prints</td>
</tr>
</tbody>
</table>
**The printer operator panel**

**Introduction**

This section describes the parts and the functions of the Océ TDS450 printer operator panel. Use the printer operator panel to select your print settings or finishing settings.

![The Océ TDS450 Printer operator panel](image)

The components of the User manual operator panel.

1. The display
2. The 'previous' key
3. The 'next/select' key
4. The 'stop' key
5. The 'on-line' key with green LED
6. The navigation keys.
The display

In the on-line mode the display shows the feedback about the print job status and system messages.
In the off-line mode the display shows the off-line menu. (see ‘The menu structure of the printer’ on page 86)

On the right-hand side the display shows the menu level indicator. The menu level indicator presents in a graphic way the active printer menu level. The menu structure of the printer has a maximum of 4 printer menu levels.

The keys

The printer operator panel contains the following keys.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'previous'</td>
<td>Return to a higher menu level</td>
</tr>
<tr>
<td>'next/select'</td>
<td>Select an option or a setting in the menu</td>
</tr>
<tr>
<td>'stop'</td>
<td>Stop the current print job</td>
</tr>
</tbody>
</table>
| 'on-line'      | ■ Switch between the on-line mode (the green light above the key is on) and the off-line mode (the green light above the key is off) of the printer.  
                 | ■ Activate the program mode and enter the top menu level |
| navigation     | ■ select another mode at the same menu level       |
|                | ■ display the next or the previous option from the option list |

[20] The keys
The menu structure of the printer

Introduction

In the off-line mode the printer operator panel allows you to define settings.

The table below shows the menu structure of the printer. If you browse through the tree, the menu level indicator shows the actual menu level.
The menu structure of the Océ TDS450 printer with setting references

<table>
<thead>
<tr>
<th>'Media settings'</th>
<th>'Roll 1' / 'Roll 2'</th>
<th>'Width' / 'Material'</th>
<th>Setting reference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>(see ‘Define the media type and media size’ on page 262)</td>
</tr>
<tr>
<td>'Manual feed'</td>
<td>'Material'</td>
<td></td>
<td>(see ‘Define the media type and media size’ on page 262)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Time out'</td>
<td>(see ‘Define the manual feed time-out at the printer operator panel’ on page 133)</td>
</tr>
<tr>
<td>'Cut media'</td>
<td></td>
<td></td>
<td>(see ‘Cut the media’ on page 264)</td>
</tr>
<tr>
<td>'Print info'</td>
<td>'Configuration'</td>
<td></td>
<td>(see ‘Print the configuration report of the Océ TDS450 printer’ on page 117)</td>
</tr>
<tr>
<td>'Menu card'</td>
<td></td>
<td></td>
<td>(see ‘Print the menu card of the Océ TDS450 printer’ on page 116)</td>
</tr>
<tr>
<td>Setting reference</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Demo print'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(see ‘Print the demo print of the Océ TDS450 printer’ on page 118)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Folding'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Delivery'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Stacker' / 'Belt' / 'First Fold'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(see ‘Define the folded output delivery’ on page 236)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Input'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Legend'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Trailing' / 'Leading'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(see ‘Define the folding legend’ on page 237)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Method'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Standard' / 'Afnor' / 'Ericsson'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(see ‘Define the drawing method’ on page 238)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Binding'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Off' / 'On' / 'Reinforce'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(see ‘Define the binding method’ on page 239)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Binding edge'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(see ‘Define the binding edge value’ on page 240)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Package'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Length'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(see ‘Define the folded package length’ on page 241)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Width'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(see ‘Define the folded package width’ on page 242)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>'Clean RU knife'</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Menu Structure of the Océ TDS450 Printer

- **Configuration**
  - 'Language'  
  - (see ‘Define the display language of the printer’ on page 120)
- **Paper series**  
  - (see ‘Define the media series of the Océ TDS450 printer’ on page 265)
- **System**
  - 'Clear setmem'
- **Diagnostic mode**
- **Network sett.**
  - 'adapter 1' / 'adapter 2'
  - 'Use DHCP server'  
  - (see ‘Define the DHCP server’ on page 124)
- **IP address**  
  - (see ‘Define the IP address’ on page 125)
- **Subnetmask**  
  - (see ‘Define the subnet mask’ on page 126)
- **Default gateway**  
  - (see ‘Define the default gateway’ on page 127)
- **Installation**
  - 'start install.'

---

**Note:** The menu structure is also displayed in the menu card of the Océ TDS450 printer that you can print. (see ‘Print the menu card of the Océ TDS450 printer’ on page 116)

---

[21] The menu structure of the Océ TDS450 printer
Chapter 5
Get to know the finishing options
The Océ TDS450 printer is default available with an automatic 1-roll unit and an Integrated Receiving Tray as the output delivery device. The Integrated Receiving Tray is advised for a low production environment and a lot of same size output.

It is possible to expand your standard configuration with one of the following finishing options.
## Finishing options

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
<th>Position of the component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Delivery Tray</td>
<td>Collects output at the rear side of the printer. This option is advised for a higher production environment with many different output sizes that you want to stack neatly. The stack capacity is 150 prints. <strong>Note:</strong> If you install an Output Delivery Tray, the printer requires more space.</td>
<td>![Output delivery tray]</td>
</tr>
<tr>
<td>Compact Output Stacker</td>
<td>Collects output in the Integrated Receiving Tray, but has a mechanism to prevent the output of different sizes to collide. This option is also advised for a higher production environment with many different output sizes that you want to stack neatly. The stack capacity is 100 prints. <strong>Note:</strong> If you install an Compact Output Tray, the printer requires the same space.</td>
<td>![Compact output stacker]</td>
</tr>
<tr>
<td>Folder</td>
<td>Folds the output</td>
<td>![Folder]</td>
</tr>
<tr>
<td>Component</td>
<td>Function</td>
<td>Position of the component</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
<td>---------------------------</td>
</tr>
<tr>
<td><strong>Reinforcement unit</strong></td>
<td>The optional <strong>reinforcement unit</strong> adds reinforcement strips to folded output</td>
<td><img src="image1" alt="Reinforcement unit" /></td>
</tr>
<tr>
<td><strong>Belt unit</strong></td>
<td>The optional <strong>belt unit</strong> transports the folded output and provides high capacity stacking of the folded output</td>
<td><img src="image2" alt="Belt unit" /></td>
</tr>
</tbody>
</table>

**Note:** You can use both a Compact Output Stacker and a folder. You can not use both an Output Delivery Tray and a folder.
The folder components

**Introduction**

The folder folds the output according to the selected folding settings.

**Attention:** You can only fold paper. If you attempt to fold polyester, transparent or vellum media, a media jam will occur.

**Illustration**

![Océ TDS450 folder](image-url)

[21] Océ TDS450 folder
Folder components

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Lever</td>
</tr>
<tr>
<td>2</td>
<td>Stacker</td>
</tr>
<tr>
<td>3</td>
<td>Belt unit</td>
</tr>
<tr>
<td>4</td>
<td>Second fold section</td>
</tr>
<tr>
<td>5</td>
<td>Reinforcement unit</td>
</tr>
<tr>
<td>6</td>
<td>Folder transport section</td>
</tr>
<tr>
<td>7</td>
<td>First fold section</td>
</tr>
<tr>
<td>8</td>
<td>First fold delivery</td>
</tr>
</tbody>
</table>

[23] The components of the folder
Chapter 6
Get to know the software applications
Job submission software

Job submission methods

Send print jobs to the Océ TDS450

You can send your print jobs to the Océ TDS450 in various ways. The default configuration of the Océ TDS450 contains printer drivers, Océ Print Exec® Workgroup LT and FTP

**Note:** You upgrade to the full version of Océ Print Exec® workgroup with a license key in Océ License Logic.

After you send jobs to the printer, you can manage the jobs through the Océ Queue Manager and the printer operator panel.

**Note:** The settings defined in the printer drivers or the job submission tools always overrule the settings defined in the Océ Settings Editor.
Accounting software: Océ Account Center

Introduction

An overview of Océ Account Center

Introduction

Use Océ Account Center to manage the account information of the print, copy and scan-to-file jobs for your Océ TDS and Océ TCS devices.

Océ Account Center consists of the following two software modules.

■ Océ Account Logic
  Océ Account Logic runs on the Océ Power Logic® controller. You can connect to Océ Account Logic from a remote workstation through a web browser.
  The users use Océ Account Logic to enter the account information. The user can enter the account information for the copy and scan-to-file jobs and for the print jobs. The users can enter the account information at the Océ Power Logic® controller and at the workstation.
  The administrator can manage Océ Account Logic from the 'Administration' screen on the application.

■ Océ Account Console.
  Océ Account Console runs on a PC that functions as a server. You can connect to Océ Account Console from a remote workstation through a web browser. Access to Océ Account Console application is password protected and limited to authorised personnel.
  The administrator uses Océ Account Console to create the 'Account information' dialogue. The administrator publishes the 'Account information' dialogue for Océ Account Logic and other applications. The bookkeeper uses Océ Account Console to retrieve and export the log data. The bookkeeper uses the log data for accounting purposes.

Definition
Overview of the workflow

The administrator defines and distributes the 'Account information' dialogue. The users enter the account information when the users print, copy or scan to file. The bookkeeper collects the account data and converts the account data to invoices.
Océ Account Logic

Introduction to Océ Account logic

Definition

Use Océ Account Logic to link account information to your job. The account information requirements are defined and managed by the administrator.

Purpose

Use Océ Account Logic for the following.

■ Enter the account information for the print jobs
■ Manage print jobs that do not have valid account information
■ Enter account information for the copy and scan-to-file jobs
■ Lock and unlock the scanner
■ Administer Océ Account Logic (administrators only).
Summary of Océ Account Logic

Sections

Océ Account Logic has the following three sections.

- The 'Copy & File' tab
  Use this tab to enter account information for copy jobs and scan-to-file jobs.

- The 'Print' tab
  Use this tab to enter account information for print jobs.

- The 'Administration' window.
  Use this window to define the administrative settings for the application.
  Access to this window is password protected and limited to the application administrator.
Océ Power Logic® controller setup

Introduction
Before you begin to use Océ Account logic, you must define the correct settings in the Océ Settings Editor on the Océ Power Logic Controller.

Before you begin
Before you can define the correct settings in the Océ Settings Editor on the Océ Power Logic Controller, log on as a Key Operator (KO).

Note: Refer to the on-line help on the Océ Settings Editor for information about the settings and the location of the settings.

Example of the Océ Settings Editor

[Image of Océ Settings Editor]

[22] Path: KO - System - ... - ...
The correct settings

<table>
<thead>
<tr>
<th>The path to the setting in the Océ Settings Editor</th>
<th>Definition</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path: <strong>KO - System - Enabling passwords - Account logging</strong></td>
<td>Use the correct password to enable account logging.</td>
<td>Before you can use Océ Account Logic, enable account logging on Océ Power Logic® controller.</td>
</tr>
</tbody>
</table>
| Path: **KO - System - Job management - Print jobs** | Select 'Jobs in inbox'. | Océ Account Logic requires that all jobs are send to the Inbox.  
**Note:** The print jobs that have valid account information are automatically moved from the Inbox to the Print queue.  
Enter the account information for the print jobs that do not have valid account information on the 'Print' tab of Océ Account Logic. |
<table>
<thead>
<tr>
<th>The path to the setting in the Océ Settings Editor</th>
<th>Definition</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path: <strong>KO - System - Job management - Rights for printing</strong></td>
<td>Select 'Special user'.</td>
<td>Océ Account Logic is a special user on the Océ Power Logic® controller.</td>
</tr>
<tr>
<td>Path: <strong>KO - Scanner - Settings - Timers - Panel timeout</strong></td>
<td>Océ advises you to set the panel timeout to the minimum value (30 seconds).</td>
<td>The scanner locks when the scanner panel timeout expires. The scanner locks to prevent users to use the scanner without entering account information. When you set the timeout to a minimum value, the scanner locks after a minimum of time has passed.</td>
</tr>
</tbody>
</table>
Océ Account Console

Introduction to Océ Account Console

Definition

Océ Account Console is installed on the administrator’s workstation. Access to Océ Account Console is password protected and limited to the administrator.

Purpose

Use Océ Account Console is intended for the following:

- Manage, preview, and publish the account information dialogue for Océ Account Logic
- Retrieve and export the log files.
Summary of Océ Account Console

Sections

Océ Account Console has the following three sections.

■ The 'Account fields' tab
  Use this tab to create, manage, preview, and publish the 'Account information' dialog for Océ Account Logic.

■ The 'Account data' tab
  Use this tab to define the devices from where the log files are retrieved.
  Use this tab to export the log files.

■ The 'Administration' window.
  Use this screen to define the administrative settings for the application, and to change the password for Océ Account Console.
Document management software

Océ Repro Desk

Introduction

Océ Repro Desk is a print management solution for reprographers.

Océ Repro Desk consists of two parts.

1. Océ Repro Desk Client
   Océ Repro Desk Client is available in two versions. Both versions allow you to create, process and preview jobs, print to A4-size paper and submit drawings electronically.
   - Océ Repro Desk Remote Client allows you to submit jobs for printing via Internet, modem or FTP communication.
   - Océ Repro Desk LAN Client allows you to submit jobs for printing via LAN communication.

2. Océ Repro Desk Server
   With the Océ Repro Desk Server software you can receive jobs from the clients by a modem, network, FTP or disk and you can arrange, prepare and print the digital files.
   Océ Repro Desk Scan-to-file is an optional software application, used to scan paper originals and store them as digital files.

**Note:** For this application a separate Océ Repro Desk user manual is available.
Océ Engineering Exec®

Introduction

Océ Engineering Exec® is an integrated suite of applications to distribute, print and archive documents across the enterprise.

Océ Engineering Exec® products

Océ Engineering Exec® includes the following products.

- Océ Doc Exec® Pro
  An application to organise, archive and share documents.

- Océ Print Exec® Pro
  An application to provide controlled access to the documents, printing and distribution resources.

- Océ Print Exec® Workgroup.
  An application to define and control the print jobs via your web browser.

- An application to define and control the print jobs.

Note: Visit Océ on the internet at www.oce.com for the latest information.
Chapter 7
Prepare the Océ TDS450 for use
Turn the Océ TDS450 on and off

Introduction

When you turn on the Océ TDS450 scanner, the Océ TDS450 scanner needs some preparation time before it can handle jobs. The preparation time for scan-to-file and copy jobs is less than twenty seconds.

Illustration

1. Set the on / off switch at the right to position 1.

Result

The green light at the operator panel illuminates.
How to turn off the Océ TDS450 scanner

1. Set the on / off switch at the right to position 0.

Result

The green light at the operator panel is turned off.
Turn on and shut down the Océ Power Logic® controller

Introduction

When you turn on the Océ Power Logic® controller, the Océ Power Logic® controller needs some preparation time before it can handle jobs. The preparation time for print jobs is two and a half minutes, for scan-to-file jobs and copy jobs three minutes.

How to turn on the Océ Power Logic® controller

1. Press the on / off key of the Océ Power Logic® controller. After the initial system test of the controller the applications, Océ Queue Manager, Océ System Control Panel, Océ Settings Editor and Océ Scan Manager are automatically started. The Océ TDS450 is ready. 
   Note: The Océ Queue Manager and the Océ System Control Panel applications are shown on the screen. The Océ Settings Editor is minimised.

Result

The Océ Power Logic® controller starts up and displays the Océ Queue Manager and the Océ System Control Panel. The Océ Settings Editor is minimised.

How to shut down the Océ Power Logic® controller

1. Open the Océ System Control Panel.
2. Click 'System' to open the system menu.
3. Click 'Shutdown'
   A dialogue box displays.
4. Click 'Yes' to confirm.
5. Turn off the display.

Result

The green light of the on / off key is turned off. The Océ Power Logic® controller is turned off.
Turn the Océ TDS450 printer on and off

Introduction

When you turn on the Océ TDS450 printer, the Océ TDS450 printer needs some preparation time before it can handle jobs. The preparation time for print and copy jobs is less than one minute.

Illustration

![The on / off switch at the back of the Océ TDS450 printer](image)

How to turn on the Océ TDS450 printer

1. Set the on / off switch at the back of the Océ TDS450 printer to position 1.

Result

The green light of the on / off switch illuminates and the operator panel displays the message 'Ready'.

How to turn off the Océ TDS450 printer

1. Set the on / off switch at the back of the Océ TDS450 printer to position 0.

Result

The green light of the on / off switch is turned off and the operator panel displays no message.
Print the menu card of the Océ TDS450 printer

Introduction

You can print the following information with the Océ TDS450 printer
- The menu card to get an overview of the menu structure.
- The configuration report to get an overview of the configuration and the system settings.
- A demo print to check the controller and printer.

Before you begin

Use the ◀ key, the ▶ key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to print the menu card of the Océ TDS450 printer

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Print info' and select this menu.
3. Navigate to 'Menu card' and select this value.
4. Press the 'on-line' key to turn the printer on-line.

Result

The Océ TDS450 printer prints the menu card.
Print the configuration report of the Océ TDS450 printer

Introduction

You can print the following information with the Océ TDS450 printer

- The menu card to get an overview of the menu structure.
- The configuration report to get an overview of the configuration and the system settings.
- A demo print to check the controller and printer.

Before you begin

Use the ◀ key, the ▶ key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to print the configuration report of the Océ TDS450 printer

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Print info' and select this menu.
3. Navigate to 'Configuration' and select this value.
4. Press the 'on-line' key to turn the printer on-line.

Result

The Océ TDS450 printer prints the configuration report.
Print the demo print of the Océ TDS450 printer

Introduction

You can print the following information with the Océ TDS450 printer

- The menu card to get an overview of the menu structure.
- The configuration report to get an overview of the configuration and the system settings.
- A demo print to check the controller and printer.

Before you begin

Use the ◄ key, the ► key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to print the demo print of the Océ TDS450 printer

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Print info' and select this menu.
3. Navigate to 'Demo print' and select this value.
4. Press the 'on-line' key to turn the printer on-line.

Result

The Océ TDS450 printer prints the demo print.
Define the display languages

Define the display languages of the scanner and the controller

Introduction

You can toggle between two languages at the following system components.
- The applications of the Océ Power Logic® controller.
- The operator panel of the Océ TDS450 scanner.

The operator panel of the Océ TDS450 printer provides one language only.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the display languages

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - System - Regional settings - Display languages - First language.
3. Define the default language.
4. Navigate to KO - System - Regional settings - Display languages - Second language.
5. Define the alternative language.
6. Click 'Apply' to confirm the settings.
7. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

You can use the defined settings at the scanner operator panel and the applications of the Océ Power Logic® controller.
Define the display language of the printer

Introduction

You can toggle between two languages at the following system components.

■ The applications of the Océ Power Logic® controller.
■ The operator panel of the Océ TDS450 scanner.

The operator panel of the Océ TDS450 printer provides one language only.

Before you begin

Use the ⬅️ key, the ➤️ key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the display language

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Configuration' and select this menu.
3. Navigate to 'Language' and select this menu.
4. Navigate to the required language and select this value.
5. Press the 'on-line' key to turn the printer on-line.
6. Turn the printer off and on.

Result

The selected language appears on the printer operator panel.
Define the network settings

Define the network settings with the Océ Settings Editor

Introduction

You can define the network settings of the network adapter at the following locations.

- The Océ Settings Editor
- The printer operator panel of the Océ TDS450 printer.

Before you begin

Open the Océ Settings Editor and log on as System Administrator. Take the following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'System administrator' and enter the password.

How to define the network settings with the Océ Settings Editor

1. Click 'View' and select 'SA settings'.
2. Navigate to SA - System - Connectivity - TCP/IP
3. Define the required settings.
4. Click 'Apply'.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

The Océ TDS450 is connected to the local network.
Define the network settings at the printer operator panel

About the network settings

Introduction

You can define the network settings of the network adapter at the following locations.
- The Océ Settings Editor
- The printer operator panel of the Océ TDS450 printer.

Access the network settings

Before you can set the network settings, you need to enter the system menu.

Available network settings

You can use the following settings to define the network settings.
- Dynamic Host Configuration Protocol (DHCP) server.
  The DHCP protocol assigns Internet Protocol (IP) addresses in a network automatically. If you do not use the DHCP protocol, enter the IP address manually.
- Internet Protocol (IP) address.
- Subnetmask.
- Gateway.
Access the system settings in the system menu

Introduction

Use the following procedure to access the system menu.

Before you begin

Use the key, the key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to access the system settings

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'System' and select this menu.
   The string 'Enter password' appears. To enter this 'password' you must press the following keys in the right sequence.
3. Press the key.
4. Press the 'stop' key.
5. Press the key.
6. Press the 'stop' key.
7. Press the key.

Result

You have access to the system settings.
Define the DHCP server

Introduction

Use the following procedure to define the DHCP server.

Before you begin

Use the key, the key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the DHCP server

1. Make sure you have access to the system settings. (see ‘Access the system settings in the system menu’ on page 123)
2. Navigate to 'Network settings' and select this menu.
3. Navigate to 'Adapter 2' and select this menu.
4. Navigate to 'Yes' and select this value.
5. Navigate to the next network setting or press the 'on-line' key to put the printer on-line again.

Result

The DHCP setting is defined.
Define the IP address

Introduction

Use the following procedure to define the IP address.

Note: If the DHCP server is defined, you can skip this procedure.

Before you begin

Use the ◀ key, the ▶ key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the IP address

1. Make sure you have access to the system settings.
   (see ‘Access the system settings in the system menu’ on page 123)
2. Navigate to 'Network settings' and select this menu.
3. Navigate to 'Adapter 2' and select this menu.
4. Navigate to 'IP address' and select this menu.
   The first three digits flash.
5. Enter the first three numbers with the ◀ key and the ▶ key and press the 'next/select' key to confirm the value.
   The next three digits flash.
6. Enter the next three numbers with the ◀ key and the ▶ key and press the 'next/select' key to confirm the value.
   The next three digits flash.
7. Enter the next three numbers with the ◀ key and the ▶ key and press the 'next/select' key to confirm the value.
   The next three digits flash.
8. Enter the next three numbers with the ◀ key and the ▶ key and press the 'next/select' key to confirm the value.
   The next three digits flash.
9. Navigate to the next network setting or press the 'on-line' key to turn the printer on-line again.

Result

The IP address is defined.
Define the subnet mask

Introduction

Use the following procedure to define the subnet mask.

Note: If the DHCP server is defined, you can skip this procedure.

Before you begin

Use the ◀ key, the ► key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the subnet mask

1. Make sure you have access to the system settings.
   (see ‘Access the system settings in the system menu’ on page 123)
2. Navigate to 'Network settings' and select this menu.
3. Navigate to 'Adapter 2' and select this menu.
4. Navigate to 'Subnet mask' and select this menu.
   The first three digits flash.
5. Enter the first three numbers with the ◀ key and the ► key and press the 'next/select' key to confirm the value.
   The next three digits flash.
6. Enter the next three numbers with the ◀ key and the ► key and press the 'next/select' key to confirm the value.
   The next three digits flash.
7. Enter the next three numbers with the ◀ key and the ► key and press the 'next/select' key to confirm the value.
   The next three digits flash.
8. Enter the next three numbers with the ◀ key and the ► key and press the 'next/select' key to confirm the value.
   The next three digits flash.
9. Navigate to the next network setting or press the 'on-line' key to turn the printer on-line again.

Result

The subnet mask is defined.
Define the default gateway

Introduction

Use the following procedure to define the default gateway.

**Note:** *If the DHCP server is defined, you can skip this procedure.*

Before you begin

Use the ◀ key, the ▶ key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the default gateway

1. Make sure you have access to the system settings. (see ‘Access the system settings in the system menu’ on page 123)
2. Navigate to 'Network settings' and select this menu.
3. Navigate to 'Adapter 2' and select this menu.
4. Navigate to 'Default gateway' and select this menu. The first three digits flash.
5. Enter the first three numbers with the ◀ key and the ▶ key and press the 'next/select' key to confirm the value. The next three digits flash.
6. Enter the next three numbers with the ◀ key and the ▶ key and press the 'next/select' key to confirm the value. The next three digits flash.
7. Enter the next three numbers with the ◀ key and the ▶ key and press the 'next/select' key to confirm the value. The next three digits flash.
8. Enter the next three numbers with the ◀ key and the ▶ key and press the 'next/select' key to confirm the value. The next three digits flash.
9. Navigate to the next network setting or press the 'on-line' key to turn the printer on-line again.

Result

The default gateway is defined.
Define the time-outs

About the time-out settings

Introduction

You can use time-out settings to define the behaviour of the Océ TDS450 if the Océ TDS450 remains unused for a time.

Time-out settings of the Océ TDS450 scanner

You can define the following time-out settings for the Océ TDS450 scanner.

- The set time-out of an opened set in a copy job.
  When the scanner remains unused for a time after a set was opened, the set closes automatically.

- The panel time-out of the scanner operator panel.
  When the scanner operator panel remains unused for a time, the scanner operator panel returns to the home screen automatically. The Océ TDS450 scanner is ready for the next user.

- The sleep mode time-out of the scanner.
  When the Océ TDS450 scanner remains unused for a time, the Océ TDS450 scanner enters the sleep mode automatically and saves energy. When the Océ TDS450 scanner enters the sleep mode, the job settings are set to default.

Note: The time that the Océ TDS450 scanner enters the sleep mode depends on the values of the above settings and the status of the Océ TDS450 scanner.

Time-out settings of the Océ TDS450 printer

You can define the following time out settings for the Océ TDS450 printer.

- The sleep mode time-out of the printer.
  When the Océ TDS450 printer remains unused for a time, the Océ TDS450 printer enters the sleep mode automatically and saves energy.

Note: There is no sleep mode time-out for the Océ Power Logic® controller.
Behaviour of the unused Océ TDS450 scanner and time-out settings

Introduction

The automatic behaviour of the scanner when the scanner is unused for a while depends on two items, the status of the scanner and the values of the time-out settings. You are advised to define the time-out settings in the following order.

- Define the set time-out to the lowest value according to the sleep mode time-out and the scanner operator panel time-out setting.
- Define the scanner operator panel time-out to the middle value according to the sleep mode time-out and the set time-out setting.
- Define the sleep mode time-out as the highest value according to the set time-out and scanner operator panel time-out setting.

Automatic behaviour of the unused Océ TDS450 scanner

- The scanner operator panel was used for a copy or scan-to-file job.
  The scanner operator panel returns to the home screen when the scanner operator panel time-out expires. The settings are set to default. The scanner enters the sleep mode when the sleep mode timer expires.
- The scanner operator panel was used to copy a set.
  The set will close when the set time-out expires. The scanner operator panel returns to the home screen when the scanner operator panel time-out expires. The settings are set to default. The scanner enters the sleep mode when the sleep mode timer expires.
Define the sleep mode time-out of the Océ TDS450 scanner

Introduction

When the time-out of the Océ TDS450 scanner expires, the Océ TDS450 scanner enters the sleep mode to save energy. Use the Océ Settings Editor to set the sleep mode time-out of the Océ TDS450 scanner.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the sleep mode time-out of the system

1. Click 'View' and select 'SA settings'.
2. Navigate to Path: KO - System - Timers - Sleep mode timer scanner.
3. Define the required settings.
4. Click 'Apply'.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

The sleep mode time-out of the Océ TDS450 scanner is defined.
Define the panel time-out of the scanner operator panel

Introduction

When the scanner operator panel remains unused for a time, the scanner operator panel returns to the home screen automatically. The Océ TDS450 scanner is ready for the next user. Use the Océ Settings Editor to define the panel time-out.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the panel time-out of the scanner operator panel

1. Click 'View' and select 'KO settings'.
2. Navigate to **KO - Scanner - Timers - Panel time-out**.
3. Define the required settings.
4. Click 'Apply'.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

The panel time-out of the scanner operator panel is defined.
Define the set time-out of a copy job

Introduction

When the scanner operator panel remains unused for a time after a set was opened, the set closes automatically. Use the Océ Settings Editor to define the panel time-out.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the set time-out of a copy job

1. Click 'View' and select 'KO settings'.
2. Navigate to **KO - Scanner - Timers - Set time-out**.
3. Define the required settings.
4. Click 'Apply'.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

The set time-out of a copy job is defined.
Define the manual feed time-out at the printer operator panel

Introduction
You can define the time-out period for the manual feed function. The factory default value is 1 minute. This value indicates that the printer will inform you during 1 minute after you send the print job, to feed the media into the printer. After this time-out period expires, the printer prints the next job (either the print job that is in the queue, or the next print job that arrives if the queue is empty).

Before you begin
Use the ▼ key, the ► key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the manual feed time out
1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Media settings' and select this menu.
3. Navigate to 'Manual feed' and select this menu.
4. Navigate to 'Time out' and select this menu.
5. Navigate to the required time out and select this value.
6. Press the 'on-line' key to turn the printer on-line.
Chapter 8
Set up your workflow with the Océ Power Logic® controller applications
Introduction

The Océ Power Logic© controller has two important, main roles.

■ Set up the Océ TDS450 to integrate into your environment and create the most productive workflow.
■ Control your workflow for the print, copy and scan-to-file jobs.

Set up your workflow with the Océ Settings Editor

The Océ TDS450 offers a lot of settings to optimize your workflow. Use the Océ Settings Editor to define the most used settings for your jobs. Open the Océ Settings Editor to get a complete overview of the available settings. Refer to the on-line help of the Océ Settings Editor for an explanation of each setting.

Control your workflow

The Océ TDS450 offers the following applications to control your workflow.

■ Océ System Control Panel
■ Océ Queue Manager
■ Océ Scan Manager
■ Océ License Logic

See the on-line help files of these applications for a complete overview of the application.
Set up your workflow with the Océ Settings Editor

Define the job templates

Introduction

Job templates enable you to easily perform copy jobs and scan-to-file jobs that you do very often. Job templates appear on the scanner operator panel when you select 'Copy' or 'Scan-to-file'.

A job template defines the following.

- The top 5 settings.
  You can select 5 settings that you want to see immediately when you open the job template at the scanner operator panel. The top 5 settings are the settings that you need to change frequently if you use this job template. You can see the remaining settings when you scroll downwards.

- The default values for all available settings.
  You can define a default value per setting. Define a value that you use very often.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.
How to define a job template

1. Click 'View' and select 'KO settings'.
2. Navigate to **KO - Jobs - Copy - Copy job templates - Job templates** to define the copy job templates.
   Navigate to **KO - Jobs - Scan to file - Scan to file job templates - Job templates** to define the scan-to-file job templates.
3. Define the job template name and the job template description.
4. Select the top 5 settings that you want to see on the scanner operator panel when you open the job template.
5. Define the number of prints / sets.
6. Select a default value for all the settings that you want to pre-define for your job template.
7. Click 'Apply' to confirm the settings.
8. Click 'File' and select 'Log off' to prevent unauthorised use.
Define the automatic original feed setting

Introduction

This setting provides an easy method to feed a set of originals, because you only need to press the start key once. If you use this setting you can also define the original feed time-out.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the auto original feed settings

1. Click 'View' and select 'KO settings'.
2. Navigate to 'KO - Scanner - Original handling - Auto original feed'
3. Select 'On'
4. Define the original feed time-out if necessary.
5. Click 'Apply' to confirm the settings.
6. Click 'File' and select 'Log off' to prevent unauthorised use.

Note: You can also define the auto original feed setting at the scanner operator panel. Select 'System' - 'Auto feed' - 'On'.

Result

Feed a set of originals in a more productive way.
Define the original release mode

Introduction

Use the original release mode setting to define if the scanner must hold or release the original after the scan procedure.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the original release mode

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - Scanner - Original handling - Original release mode.
3. Select the required value.
   - Hold the original at the front.
   - Release the original at the front.
   - Hold the original at the back.
   - Release the original at the back.
4. Click 'Apply' to confirm the settings.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

   Note: You can also define the original release mode at the scanner operator panel. Select 'System' - 'Original release mode' - 'Release' / 'Hold'.

Result

The original release mode is defined.
Create the stamps and their default settings

Introduction

A stamp is a pre-defined text you can set on every copy. The stamp function is an option. Use Océ License logic to enable this option. Use the Océ Settings Editor to define a maximum of 10 stamps and their default values.

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to create the stamps

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - Printer - Stamps.
3. Define the name.
4. Define the text.
   - Enter '%DATE' if you need the date that the copy was made on a copy.
   - Enter '%TIME' if you need the time that the copy was made on a copy.
5. Define the font.
6. Click 'Apply' to confirm the settings.
7. Click 'File' and select 'Log off' to prevent unauthorised use.

How to define the default values of the stamp

1. Click 'View' and select 'KO settings'.
2. Navigate to KO - Jobs - Copy - Stamp - Copy stamp.
3. Define the required values.
4. Click 'Apply' to confirm the settings.
5. Click 'File' and select 'Log off' to prevent unauthorised use.

Result

You can apply the defined stamps to a copy directly from the scanner operator panel.
Define the media series

Introduction

Use this setting to define the default media range.

When you select a new media size on the operator panel of the printer, only the sizes in the defined paper series are available.
When 'Auto format' is enabled, the 'Paper series' setting selects which sizes are used (only those available in the paper series).

Before you begin

Open the Océ Settings Editor and log on as Key Operator. Take the following steps to log on.

1. Click 'File' and select 'Log on'.
2. Select 'Key operator' and enter the password.

How to define the media series

1. Click 'View' and select 'KO settings'.
3. Define the required value.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Group</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper series</td>
<td>■ 'DIN'</td>
<td>■ A4, A3, A2, A1, A0, E+, B1_707, B2_707</td>
</tr>
<tr>
<td></td>
<td>■ 'DIN carto'</td>
<td>■ A4, A3, A2, A1, A0, E+, B1_700, B2_700</td>
</tr>
<tr>
<td></td>
<td>■ 'ANSI small'</td>
<td>■ A, B, C, D, D+ E, E+, 30 inch</td>
</tr>
<tr>
<td></td>
<td>■ 'ANSI mixed'</td>
<td>■ A, A+, B, B+, C, C+ D, D+ E, E+, 30 inch</td>
</tr>
</tbody>
</table>

4. Click 'Apply' to confirm the settings.
5. Click 'File' and select 'Log off' to prevent unauthorised use.
Chapter 9
Control your workflow with the Océ Power Logic® controller applications
Control your print and copy workflow with the Océ Queue Manager

User operations in the Océ Queue Manager

Introduction

The Océ Queue Manager allows you to do the following.
- Print a job from the inbox queue or the history queue
- Cancel jobs
  This action deletes jobs from the print queue.
- Place jobs on hold
  This action places print jobs on hold. When you place jobs on hold other jobs take priority.
- Restart jobs on hold.
  This action resumes jobs that were previous placed on hold.
- Change the order
  This action changes the order of the jobs in the printer queue.

The Océ Queue Manager displays the jobs in the sequence that the jobs are received. By default the copy jobs have priority over the print jobs.

How to print jobs from the inbox queue or the history queue

1. Select the jobs in the history queue or the inbox queue.
   Print jobs are sent to the inbox queue when the setting "KO - System - Job management - Print jobs" is set to 'Inbox' or when you have enabled 'Send to inbox' in the printer driver.
   After you print a job from the print queue, the job moves to the history queue.
2. From the 'Job' menu select 'Print', click the 'Print' button on the toolbar or right-click and select 'Print'.
3. The job moves to the print queue.
   You can select more than one job with the mouse and the shift or control key.
How to print a number of copies of a job from the history queue

1. Log on as a key operator or as a system administrator.
2. Select the job in the history queue.
3. Open the 'Job properties' dialogue box.
   Use one of the following methods to open the 'Job properties' dialogue box.
   ■ From the 'Job' menu, select 'Properties' or,
   ■ Click the 'Properties' button on the toolbar or,
   ■ Right-click the job and select 'Properties'.
4. Select the 'Settings' tab in the 'Job properties' dialogue box.
5. Change the number of sets in the 'Sets' field.
6. Print the job as described in the paragraph above.
   The system prints the indicated number of sets.

How to cancel jobs from the Océ Queue Manager

**Attention:** You can never undo this action. The cancelled jobs are not saved in the history queue.

1. Select the jobs in the print queue, the history queue, or the inbox queue.
2. From the 'Job' menu, select 'Delete', or click the 'Delete' button on the toolbar.
   A cross icon indicates the deleted job.
   The system does not print the cancelled job.
   You can select more than one job with the mouse and the shift or control key.
   **Note:** An anonymous user cannot cancel a job from a remote system.

How to cancel active jobs from the Océ Queue Manager

**Attention:** You can never undo this action.

1. Select the active job in the print queue.
2. From the 'Job' menu, select 'Delete', or click the 'Delete' button on the toolbar.
   The printer stops the printing immediately.
   If the controller was still processing part of the job, the controller flushes the job.
   **Note:** An anonymous user cannot cancel a job from a remote system.
How to place jobs on hold in the Océ Queue Manager

1. Select the jobs in the print queue.
2. From the 'Job' menu, select 'Hold', or click the 'Hold' button on the toolbar.
   A job that is placed on hold keeps its position in the print queue. The job will not print until the job is resumed. While a job is on hold, other jobs are printed. The jobs that were in the queue behind the job on hold are also printed.
   You can select more than one job with the mouse and the shift or control key.
   **Note:** The active print job cannot be placed on hold in the Océ Queue Manager.

How to restart jobs in the Océ Queue Manager

1. Click the job that was placed on hold.
2. From the 'Job' menu, select 'Resume', or click the 'Resume' button on the toolbar.
   The job restarts.
   You can select more than one job with the mouse and the shift or control key.

How to give priority to jobs in the Océ Queue Manager

1. Select the jobs in the print queue.
2. From the 'Job' menu, select 'Move to top', or click the 'Move to top' button.
   You can select more than one job with the mouse and the shift or control key.
Control your scan workflow with the Océ Scan Manager

Create destinations

Introduction

You can scan to file to the following types of destination.

■ Local
  The local destinations are temporary and can only contain a small number of scanned files. Use the SA - System - Set memory reservation setting in the Océ Settings Editor to define the available space on the controller for scanned files.

■ A network destination with SMB

■ An internet destination with FTP.

You can create a maximum number of 10 destinations.

Note: You can only enter names in Japanese for remote destinations in SMB.

Create a local destination

1. Select 'Destinations' in the tree structure.
2. From the 'File' menu, select 'New'.
   You can also click the 'New' button on the toolbar.
The 'Destination properties' dialogue box opens.

3. Enter a name for the destination in the 'Name' text box. This name will appear on the scanner panel.
4. From the 'Type' drop-down list box, select 'On the controller'.
5. Enter a path of the target folder in the 'Path' text box. You can also click the 'Browse' button to select the path.
6. Click 'OK' to accept the destination properties.

Create a network destination with SMB

1. Create a shared folder on a workstation. For example c:\Scan.
2. From the 'File' menu on the Océ Scan Manager, select 'New'. You can also click the 'New' button on the toolbar.
3. From the 'Type' drop-down list box, select 'SMB'.
4. Enter the system name of the workstation where you created the shared folder in the 'System' text box.

Note: Find the system name of the workstation on the control panel of the workstation (Control panel - Network - Identification - System name)
5. Enter a path of the target folder in the 'Path' text box. 
   The path name is the name of the shared folder on your workstation. For 
   Windows NT®, Windows® 2000 and XP, use the DOS name of the shared 
   folder. For Windows 95/98® use the folder name. This is case sensitive. 
   You can also select a shared folder from the drop-down list.

6. If you defined a user name and a password for the shared folder on the 
   workstation, then enter the user name and the password in the required fields. 
   **Note:** *Make sure the user has write-access privileges on the destination.*

7. Define the required file naming properties.

8. Click 'OK'.
   Océ Scan Manager connects to the new SMB destination. Océ Scan Manager 
   then shows the contents of the new SMB destination.

---

Create an internet destination with FTP

1. Create a home directory and a subdirectory on a workstation. For example 
   c:Ftp/Scan

2. Enable FTP on the workstation.

3. From the 'File' menu on the Océ Scan Manager, select 'New'. 
   You can also click the 'New' button on the toolbar. 
   The 'Destination properties' dialogue box opens.

4. From the 'Type' drop-down list box, select 'FTP'.

5. Enter the system name of the workstation where you created the shared folder 
   in the 'System' text box. 
   **Note:** *Find the system name of the workstation on the control panel of the 
   workstation (Control panel - Network - Identification - System name)*

6. Enter a path of the target folder in the 'Path' text box. 
   The path name is the name of the destination folder on the workstation.

7. A user name and password is defined on the FTP server that runs on the 
   workstation to access to the directory on the workstation through FTP. Enter 
   this user name and this password in the required fields on the Destination 
   Properties dialogue box of the Océ Scan Manager. 
   **Note:** *Make sure the user has write-access privileges on the destination.*

8. Define the required file naming properties.

9. Click 'OK'.
   Océ Scan Manager connects to the new FTP destination. Océ Scan Manager 
   then shows the contents of the new FTP destination.
Manage destinations

Introduction

You can do the following to manage the destinations.

■ Lock a destination.
■ Unlock a destination
■ Delete a destination
■ Change the destination properties.

Purpose

When you lock a destination, an anonymous user cannot change the destination properties.

Lock or unlock a destination

1. Select a destination.
2. From the 'File' menu, select 'Properties'.
   You can also click the 'Properties' button on the toolbar.
3. Check the 'Locked' check box.
   Uncheck the 'Locked' check box to unlock the destination.
4. Click 'OK' to accept the destination properties

Delete a destination

1. Log on to the key operator mode or the repro operator mode.
2. Select a destination.
3. From the 'File' menu, select 'Delete'.
   You can also click the 'Delete' button on the toolbar.
   The selected destination is deleted.

   **Note:** *You cannot delete the last destination.*
Change the destination properties

1. Select a destination.
2. From the 'File' menu, select 'Properties'.
   You can also click the 'Properties' button on the toolbar.
3. Change the destination properties like described in the 'Create destinations' section. (see ‘Create destinations’ on page 147)
   
   **Note:** When the destination is locked, anonymous users cannot change the destination properties.
Define a file name

When to do

When you scan, the scanner operator panel shows the file name.
Before a new scan-to-file job, enter a new file name or replace the file name with ###.
When the file name is not changed, the new scan-to-file job writes over the previous scan-to-file job.

Define a file name

1. Select a destination.
2. From the 'File' menu, select 'Properties'.
   You can also click the 'Properties' button on the toolbar.
3. Enter a name in the 'Base name' text box.
   The 'Base name' can contain "###" for automatic file naming. An ascending number replaces the "###". There are no limits to the number of dots in the base name.
4. Select the check box 'Add correct file extension' to define a file extension. Use the setting **KO - System - Scan to file - File extension ...** in the Océ Settings Editor to define a file extension.
5. Click 'Apply' or press 'Enter' to accept the settings.
Manage the scanned files

Introduction

The right-hand pane of the destination area displays information about the scanned files.

You can do the following to manage the scanned files.

- View a scanned file 'Auto view'
  When is enabled, Océ View Station LT starts automatically to display the scanned file when the scan to file is complete.
- Print a scanned file
- Delete a scanned file
- View the properties of a scanned file.

View a scanned file

1. Select a file.
2. From the 'File' menu, select 'View'.
   You can also click the 'View' button on the toolbar.

   ![View button on the toolbar](image)

   Océ View Station LT starts and displays the file

Enable Auto view

1. From the 'System' menu, select 'Auto view'.
   A check mark in the menu in front of 'Auto view' indicates that 'Auto view' is enabled.

Print a scanned file

1. Select a file.
2. From the 'File' menu, select 'Print'.
   You can also click the 'Print' button on the toolbar.

   ![Print button on the toolbar](image)

   The system prints the selected file with the default settings defined in the Océ Settings Editor.
Delete a scanned file

1. Log on to the key operator mode or the repro operator mode.
2. Select a file.
3. From the 'File' menu, select 'Delete'.
   You can also click the 'Delete' button on the toolbar.

   ![](image)

   [28] The Delete button on the toolbar

   The system deletes the selected file.

Clear the temporary store

1. From 'System' menu, select 'Clear temporary store' or,
2. Use the settings KO - System - Disk cleanup - ... - ... in the Océ Settings Editor to clear the temporary store automatically.

View the properties of a scanned file

1. Select a file.
2. From the 'File' menu, select 'Properties'.
   You can also click the 'Properties' button on the toolbar.

   ![](image)

   [29] The Properties button on the toolbar
3. The 'Scanfile properties' window appears.

![Scanfile properties window]

4. Click 'OK' to close the 'Scanfile properties' window.
Introduction to Océ View Station LT

Definition

Océ View Station LT is a viewer included in Océ Scan Manager. Océ View Station LT displays the scanned files.

Auto view

When 'Auto view' is enabled, Océ View Station LT starts automatically to display the scanned file when the scan to file is complete. You can also start Océ View Station LT manually. View a scanned file
Overview of Océ View Station LT

Introduction

Océ View Station LT has the following fields.
- The menu bar
- The view ribbon
- The view area.
The menu bar

- The menu bar has the following menu's.
- 'File'
- 'View'
- 'Preference'
- 'Help'.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Close'</td>
<td>Close the active document.</td>
</tr>
<tr>
<td>'Properties'</td>
<td>Open the properties dialogue box of the document. The properties dialogue box enables you to change some properties of the document.</td>
</tr>
</tbody>
</table>

The File menu

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Fit'</td>
<td>Scale the image to fill the window.</td>
</tr>
<tr>
<td>'1:1'</td>
<td>Show the image at a 1:1 scale factor.</td>
</tr>
<tr>
<td>'Magnify'</td>
<td>Zoom into the page.</td>
</tr>
<tr>
<td>'Reduce'</td>
<td>Zoom out of the page.</td>
</tr>
<tr>
<td>'Refresh'</td>
<td>Refresh the view of all the windows that show the active document.</td>
</tr>
<tr>
<td>'Invert'</td>
<td>Reverse the black and white parts of the image.</td>
</tr>
<tr>
<td>'Mirror'</td>
<td>Mirror the image.</td>
</tr>
<tr>
<td>'Rotate 90 CCW'</td>
<td>Rotate the image 90 degrees counter-clockwise (to the left).</td>
</tr>
<tr>
<td>'Rotate 90 CW'</td>
<td>Rotate the image 90 degrees counter-clockwise (to the right).</td>
</tr>
<tr>
<td>'Rotate 180'</td>
<td>Rotate the image 180 degrees.</td>
</tr>
<tr>
<td>'Sample'</td>
<td>When active, 'Sample' shows only a sample of bilevel raster pixels.</td>
</tr>
<tr>
<td>'Negate'</td>
<td>Reverse the showed raster image pixels. Change the dominant raster image pixels for scaling.</td>
</tr>
</tbody>
</table>
### The View menu

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Scale to grey'</td>
<td>'Scale to grey' shows the active bilevel raster image as a greyscale image.</td>
</tr>
<tr>
<td>'Monochrome'</td>
<td>Show an image or screen with only background and foreground colours, like black-and-white or bilevel.</td>
</tr>
</tbody>
</table>

### The Preference menu

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'View ribbon'</td>
<td>Show the view ribbon. The view ribbon provides easy access to some 'File', 'View', and Preference menu items. See the 'View ribbon' section below.</td>
</tr>
<tr>
<td>'Status bar'</td>
<td>Shows the status bar at the bottom of the Océ View Station LT window. The Status Bar shows the pointer co-ordinates and a status line.</td>
</tr>
<tr>
<td>'Reference'</td>
<td>Show the 'Reference' window. The 'Reference' window is a small, normally floating window. The 'Reference' window shows the complete current page in miniature. The crossed box in the 'Reference' window indicates the part of the page showed in the document window. Move or change the size of the crossed box to change the area of the page showed.</td>
</tr>
<tr>
<td>'Detail'</td>
<td>Shows the 'Detail' window.</td>
</tr>
<tr>
<td>'Measurement'</td>
<td>Enables you to measure the lines and the areas on the image.</td>
</tr>
</tbody>
</table>

### The Help menu

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'About'</td>
<td>Show information about Océ View Station LT.</td>
</tr>
</tbody>
</table>
## The View Ribbon

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Reverse the black and white parts of the image.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Scale the image to fill the window.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Show the image at a 1:1 scale factor.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Zoom into the page.</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Zoom out of the page.</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Mirror the image.</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Rotate the image 90 degrees counter-clockwise (to the left).</td>
</tr>
<tr>
<td><img src="image8" alt="Icon" /></td>
<td>Rotate the image 90 degrees counter-clockwise (to the right).</td>
</tr>
<tr>
<td><img src="image9" alt="Icon" /></td>
<td>Rotate the image 180 degrees.</td>
</tr>
<tr>
<td><img src="image10" alt="Icon" /></td>
<td>Enables you to measure the lines and the areas on the image.</td>
</tr>
<tr>
<td><img src="image11" alt="Icon" /></td>
<td>How the 'Reference' window. The 'Reference' window is a small, normally floating window. The 'Reference' window shows the complete current page in miniature. The crossed box in the 'Reference' window indicates the part of the page showed in the document window. Move or change the size of the crossed box to change the area of the page showed.</td>
</tr>
<tr>
<td><img src="image12" alt="Icon" /></td>
<td>Shows the 'Detail' window.</td>
</tr>
</tbody>
</table>

[28] The View ribbon
The view area

The view area shows the scanned file.

The part of the memory that is allocated to viewer is limited. When you reach the limitation of the memory space, the viewer cannot show the scanned file. Then, the viewer shows a red border with a red cross.

![An error view in Océ View Station LT](image)

Use your right mouse button to click on the file shown in the view area. You can select the following menu items from the pop-up menu.

- 'Zoom ±'
- 'Pan' (Hand tool)
- 'Fit'
- 'Magnify'
- 'Reduce'
- 'Invert'
- 'Rotate 90 CCW'
- 'Rotate 90 CW'
- 'Rotate 180'.
Control your licenses with Océ License Logic

Log on to Océ License Logic

Introduction

You can run Océ License Logic on the controller of the Océ system or remote through a web browser. Access to Océ License Logic is password protected. Use the same System Administrator password as you use on the Océ system to log on.

Purpose

Log on to Océ License Logic for the following purposes.

- View the current active licenses
- Get the host id of the Océ system
- Save the current active licenses
- Perform a license activation job.
  You can activate new licenses or saved licenses.

Before you begin

To run Océ License Logic remote, you need the host name or IP address of the Océ system.

How to log on to Océ License Logic on the Océ Power Logic® controller

1. Open the Océ Settings Editor
2. Click 'Edit' in the menu bar
3. Click 'Licenses...' The logon window opens.
4. Select 'System administrator'
5. Enter the 'Password'
6. Click the 'Logon' button.
How to log on to Océ License Logic from a remote web browser

1. Open the web browser.
   Océ License logic supports Microsoft® Internet Explorer® version 5.5 or higher.
2. Enter the following URL in your browser:
   http://'printer-name'/LicenseLogic.html
   **Note:** *'Printer-name'* is the host name or IP address of the printer.
   The logon window opens.
3. Select 'System administrator'
4. Enter the 'Password'
5. Click the 'Logon' button.

Result

Océ License Logic starts with one of the following windows.

- The 'No active license' window.
  This window opens if there are no active licenses.
- The 'View licenses' window.
  This window opens if Océ License Logic detects active licenses.

**Note:** If the log on failed, Océ License Logic displays a message. Read the message carefully and follow the instructions.
View the current active licenses

Introduction

When you log on and Océ License Logic detects active licenses, the 'View licenses' window opens and displays the current active licenses. Per option the following fields with license information display.

- 'Option'
  This field displays the name of the option.
- 'State'
  This field displays one of the following license states.
  - 'Authorised'
  - 'Not authorised'
  - 'Expired'
  - 'Update configuration'
- 'License type'
  This field displays one of the following license types.
  - 'Resale'
  - 'Demo'
- 'Duration in days'
  This field displays the time your license is valid.
- 'License number'
  This field displays a license number.

Purpose

View the license information for the following purposes.

- Check the active licenses on license state, license type and license duration
- Check how long a demo license is valid
- View all options available for your Océ system.
  The list of options depends on the type and version of the Océ system.
- Make a list of new options you need
- Make a list of license numbers.

When to do

View the license information to make a list of new options you need and to make a list of license numbers.
Note: If an error occurs, Océ License Logic displays a message. Read the message carefully and follow the instructions.

Before you begin

Make sure that the print system has active licenses. If Océ License Logic does not detect active licenses, the ‘No active license’ opens (see ‘Log on to Océ License Logic’ on page 162).

How to view license

1. Log on to Océ License Logic.

Result

The 'View licenses' window opens.
Get the host id of the Océ system

Introduction

Océ needs the host id and the license numbers of your Océ system to create a new license file.

When to do

Get the host id to order a new demo or resale license file from Océ.

Before you begin

Open a text editor on the same system that you start Océ License Logic. You can store the host id in a document.

How to get the host id

1. Log on to Océ License Logic.
   The 'No active license' window opens if there are no active licenses.
   The 'View licenses' windows opens if Océ License Logic detects active licenses.
2. Click the 'Host id' link.
   The 'The host id of your Océ system' window opens.
3. Click the 'Copy' button to copy the host id to the clipboard.
4. Open a new document in a text editor.
5. Use the paste option of the text editor to copy the host id into the document.
6. Enter the different license numbers into the document.
7. Save the document.

Result

The host id is stored in a document. You can use this document to send the host id and license numbers to Océ.
Save the current active licenses

Introduction

You can save all current active licenses of different licenses types into one single file.

Purpose

Save the current active licenses for the following purposes.

- Collect and save all active licenses of different types into one single file
- Create a back-up file before you start a license activation job.

When to do

Save the current active licenses before you start a license activation job or to save the current license situation.

Before you begin

Make sure that the print system has active licenses. If Océ License Logic does not detect active licenses, the 'No active license' opens (see ‘Log on to Océ License Logic’ on page 162).

How to save the license

1. Log on to Océ License Logic.
   The 'View licenses' window opens.
2. Click the 'Save' button.
   The 'Save licenses' window opens.
3. Select a directory, enter the file name and click the 'Save' button to back-up the current active licenses.

Result

All current active resale and demo licenses are stored into one single file.
Perform a license activation job

Introduction
You need to activate the licenses on the Océ system to enable an option for use. Océ delivers the new licenses through one or more license files.

Purpose
Activate the licenses for the following purposes.

- Activate a new demo or resale license to enable a new option
- Activate the saved licenses of your back-up file to return to the saved situation.

When to do
Activate the licenses in the following situations.

- Activate the new licenses when you received one or more new license files from Océ
- Activate the saved licenses when an activation job for new licenses failed.

Before you begin
To activate the new licenses, you need a license file from Océ. Perform a license activation job per new license file. Make sure you use the correct license file: the host id in the license file must be the same host id as the host id on your Océ system. Make sure the license file is available on the system you run Océ License Logic.

Note: If an error occurs, Océ License Logic displays a message. Read the message carefully and follow the instructions.
How to activate the licenses

1. Log on to Océ License Logic.
   The 'No active license' window opens if there are no active licenses.
   The 'View licenses' window opens if Océ License Logic detects active licenses.
2. If the 'No active license' window opens, click the 'Next' button.
   The 'View licenses' window opens.
3. Click the 'Activate' button.
4. Click the 'Browse' button to select the location of the license file and click 'OK'.
5. Click the 'Next' button.
   A preview of the new license situation displays. What you see depends on the license types in the license file you use (see ‘The structure of license files and licenses’ on page 78). You see one of the following options.
   - If you use a license file with demo licenses, the current active and the new demo licenses display
   - If you use a license file with resale licenses, the current active and the new resale licenses display
   - If you use a saved file with demo and resale licenses, the demo and resale licenses display like the time you created the back-up file.
6. Click the 'Next' button.
   The end user license agreement displays.
7. Read the end user license agreement carefully. If you agree, select 'I accept'.
8. Click the 'Finish' button to activate the license.
   The 'View licenses' window displays.
9. Restart the controller of the Océ system.

Result

The licenses are active and the options are ready for use.
Chapter 10
Print jobs
Use the printer drivers to send jobs to the Océ TDS450 printer

Introduction

The Océ TDS450 printer is delivered with a driver pack CD-ROM. You can also download the latest Océ drivers, free of charge, from our Web site www.oce.com.

With these drivers PC users can access the Océ TDS450 printer remotely from their applications, to print their files.

Note: More information about how to install, configure and use the drivers is available in the documentation provided with the drivers.

Available printer drivers

(see ‘Specifications drivers and job submission software’ on page 318) for a list of the available printer drivers that you can use to print files from your software applications.

Note: Please check at www.oce.com, section drivers for the latest driver-updates.
Use Océ Print Exec® Workgroup LT to send print jobs to the Océ TDS450 printer

Introduction

Océ Print Exec® Workgroup LT is an print job submission application that allows you to send print jobs to the Océ TDS450 printer through your web browser. Upgrades to a full version are available as an option.

Note: For this application a separate Océ Print Exec® Workgroup user manual is available.

When to do

Use Océ Print Exec® Workgroup LT to do the following.

1. Select and collect the files to print (documents and drawings), in a print job. You can add a maximum of 100 documents or drawings to a print job.
2. Configure the print job.
   You can set the document or drawing settings and the print job settings. You can add a banner to the print job and add a settings configuration for a print job.
3. Submit the print jobs to the printer queue or inbox queue.
4. Check the print job and the printer configuration status.
   You can view the status information of the printer configuration and the available media.

Required tools

Microsoft® Internet Explorer® 5.0 (or higher versions) or Netscape Navigator® 6.0 (or higher versions).

TCP/IP network that connects the printer and the end user workstation.

How to connect to Océ Print Exec® Workgroup LT

1. Enter the following URL in your workstation browser: http://'printer name'.
   Note: 'Printer name' is the name of printer that you use for your print jobs.
   Note: If you enter the URL for the first time, the required software is installed automatically at your workstation.
Print on a cut sheet

Introduction

Use the printer drivers or job submission software to create a copy job or a print job on a cut sheet.

Before you begin

Use the ▼ key, the ► key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the manual feed media type at the printer operator panel

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Media settings' and select this menu.
3. Navigate to 'Manual feed' and select this menu.
4. Navigate to 'Material' and select this menu.
5. Navigate to the required media type and select this value.
6. Press the 'on-line' key to turn the printer on-line.

Note: To change the manual feed time-out (see ‘Define the manual feed time-out at the printer operator panel’ on page 133)
How to print on a cut sheet

1. Send the print job.
2. Align the cut sheet manually with the format indication and the label on the manual feed table of the printer.
3. Feed the media manually and hold it until the printer pulls in the first part of the cut sheet.
   After a few seconds, the printer pulls in the complete sheet.
   **Note:** *The printer prints the image face-up.*
4. If the print job or the copy job requires more cut sheets, repeat steps 2 and 3 until the display no longer indicates to feed the next sheet.
Cancel a print job

Introduction

Cancel a print job before you start the print job or while you print.

How to cancel a print job

1. Press the red 'stop' key.
2. The print job stops.

Result

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer already started the print job</td>
<td>The printer:</td>
</tr>
<tr>
<td></td>
<td>■ stops printing immediately.</td>
</tr>
<tr>
<td></td>
<td>■ cuts the paper.</td>
</tr>
<tr>
<td></td>
<td>■ ejects the paper.</td>
</tr>
<tr>
<td></td>
<td>The print job is cancelled.</td>
</tr>
<tr>
<td>The printer did not start the print job</td>
<td>The print job is cancelled</td>
</tr>
</tbody>
</table>
Chapter 11
Copy jobs
Introduction to copy jobs

Introduction

A basic copy job takes two steps. Feed the original and press the start key. Every other type of copy job is called an extended copy job. An extended copy job takes one additional step, define the copy job settings at the scanner operator panel. When you turn the Océ TDS450 on or when you select 'Copy', the scanner operator panel shows five copy job templates. The copy job templates provide access to the different settings per copy job template. When you select a copy job template, the scanner operator panel shows the top 5 settings of the selected copy job template. The top 5 settings are the most often used settings. You can define the top 5 settings for each copy job template with the Océ Settings Editor. You can use the scroll wheel to see the other settings. After you start a copy job, you can manage your jobs from the Océ Queue Manager.

Illustration

![Copy job templates diagram]

[34] The copy job templates

Steps in a basic copy job

1. Feed the original.
2. Press the green start key.
**Result**

You do a basic copy job in 2 steps. The basic copy job uses the settings of the first template.

**Steps in an extended copy job**

1. Feed the original.
2. Define the job settings.
   Select the required template at the scanner operator panel and change the pre-defined settings only if necessary.
3. Press the green start key.

**Result**

An extended copy job takes one additional action only.
Use the scanner operator panel

Introduction

Use the scanner operator panel to define the job settings. You can define the job settings in two ways.

■ Use the left softkeys and the scroll wheel.
  You can use this method if you prefer a general step by step method.
■ Use the scroll wheel and scroll-wheel key only.
  You can use this method if you prefer a fast method.

Know that the scanner operator panel also uses icons to explain a setting. The following illustration shows the scanner operator panel of the Océ TDS450 scanner.
(see table 2 on page 25).
Illustration

[35] The operator panel of the Océ TDS450 scanner
Define job settings with the left soft keys and the scroll wheel

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey.  
The five job templates appear.
2. Select a job template with one of the left softkeys.  
The top 5 settings appear.
3. Find a setting with the scroll wheel.  
   A small rectangle in front of a setting name indicates the focus of the scroll  
   wheel.
4. Select a setting with the left softkey.  
   There are several types of settings. The behaviour of the scanner operator panel 
   and the definition of a setting depends on the type of setting you selected. You 
   can select one of the following types of settings.
   ■ A setting that contains two values only, like 'On' or 'Off'.  
     When you select this setting while the setting was not in focus, the setting 
     becomes in focus. When you select this setting while the setting was already 
     in focus, the setting stays in focus and there are no changes. 
     Change the value of the setting with the left softkey. The value and icon  
     changes.
   ■ A setting that contains a list of values, like 'Lighter/darker'.  
     Define the required value with the scroll wheel. The value and icon changes.
   ■ A setting that contains a list of settings, like 'Media'.  
     Define the required value with the scroll wheel. The value and icon changes. 
     Select the next setting of the list of settings with the left softkey.

   **Note:** You can enter a numeric value with the numeric keys. To enter a negative 
   numeric value, scroll to a negative value first and than enter the value with the 
   numeric keys.

5. Select 'Close' with the lower-right softkey.
6. Repeat from step 4 to define the next setting.

   **Note:** Use the 'Defaults' option at the lower-left key to set all settings of the job 
   template to default.
Define job setting with the scroll wheel and scroll-wheel key only

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey. The five job templates appear.
2. Focus on a job template with the scroll wheel. A small diamond in front of a template indicates the focus of the scroll wheel.
3. Select a job template with the scroll-wheel key. The top 5 settings appear.
4. Find a setting with the scroll wheel. A small rectangle in front of a setting name indicates the focus of the scroll wheel.
5. Select the setting with the scroll-wheel key. There are several types of settings. The behaviour of the scanner operator panel and the definition of a setting depends on the type of setting you selected. You can select one of the following types of settings.
   - A setting that contains two values only, like 'On' or 'Off'. Change the value of the setting with the scroll-wheel key to change the value of the setting. The value and icon changes.
   - A setting that contains a list of values, like 'Lighter/darker'. Open the setting with the scroll-wheel key. Define the required value with the scroll wheel. The value and icon changes. Close the setting with the scroll-wheel key.
   - A setting that contains a list of settings, like 'Media'. Focus on a setting with the scroll wheel. The bold text of a value indicates the focus of the scroll wheel. The icon changes. Open the setting with the scroll-wheel key. The list of values appears. Open the setting with the scroll-wheel key. Define the required value with the scroll wheel. The value and icon changes. Close the setting with the scroll-wheel key.

Note: You can enter a numeric value with the numeric keys. To enter a negative numeric value, scroll to a negative value first and then enter the value with the numeric keys.
6. Select 'Close' with the lower-scroll-wheel key.
7. Repeat from step 4 to define the next setting.

Note: Use the 'Defaults' option at the lower-left key to set all settings of the job template to default.
Do a basic copy job

Introduction

The main steps of a basic copy job consists of the following steps.

- Feed the original.
- Press the green start key.

How to copy on the Océ TDS450

1. Place the original face down and right aligned.
   The scanner takes the original.

2. Press the green start key.
   The scanner operator panel shows the copy job number and the status of the copy job.

   Note: *You can copy faster when you feed the original landscape.*

Result

The Océ TDS450 makes a copy.
Do an extended copy job

Introduction

The main steps of an extended copy job are the following.

- Feed the original.
- Define the job settings.
- Press the green start key.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor. After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.

How to copy on the Océ TDS450

1. Place the original face down and right aligned.
   The scanner takes the original.

[37] Place the original face down and right aligned
2. Define the job settings.

- Select 'Copy' with the upper-left softkey.
  The copy job templates appear.
- Open a copy job template with a left softkey.
  The top 5 settings appear.
- Scroll to a setting.
- Select a setting with the left softkey.
- Scroll to the required value.
- Select the next setting with the left softkey.
- Scroll to the required value.
- Select 'Close' to close the setting.

3. Define the number of copies if necessary and press the green start key.

   **Note:** *You can copy faster when you feed the original landscape, unless you must scale your original to another media size. In that case you must feed the original portrait.*

**Result**

The Océ TDS450 makes a copy according to the defined settings.
Stop a copy job

Introduction

You can stop a copy job with the red stop key on the scanner operator panel.

How to stop a copy job

1. Press the red stop key.
   
   **Note:** *This will not affect a set job.*

Result

When you press the red stop key while the scanner scans, the scan process stops. The scanner rewinds the original and the copy job is cancelled.
When you press the red stop key while the scanner rewinds, the rewind process continues. The copy job is cancelled.
Extended copy jobs

Available settings for copy jobs

Introduction

The Océ TDS450 provides a lot of settings to manage all your different copy jobs. These settings are used for extended copy jobs. The following table gives an overview and a very short description of the available settings. This table is not complete, because a setting can contain more than one setting. You find a detailed description of each setting in the on-line help at the Océ Settings Editor. You can change the default value of a setting that you use very often in the job template at the Océ Settings Editor.
### Available settings for copy jobs

<table>
<thead>
<tr>
<th>Setting</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Original type'</td>
<td>Define the type of original you use</td>
</tr>
<tr>
<td>'Scale'</td>
<td>Scale an original</td>
</tr>
<tr>
<td>'Media'</td>
<td>Define the type of media you use</td>
</tr>
<tr>
<td>'Lighter/darker'</td>
<td>Make a lighter or darker copy</td>
</tr>
<tr>
<td>'Remove strip'</td>
<td>Copy without strips</td>
</tr>
<tr>
<td>'Original width'</td>
<td>Define the width of the original</td>
</tr>
<tr>
<td>'Delete area'</td>
<td>Copy without a specific area</td>
</tr>
<tr>
<td>'Cut method'</td>
<td>Define the cut method of the printer</td>
</tr>
<tr>
<td>'Add strip'</td>
<td>Copy with a strip</td>
</tr>
<tr>
<td>'Alignment'</td>
<td>Align the image of the copy</td>
</tr>
<tr>
<td>'Shift'</td>
<td>Shift the image of the copy</td>
</tr>
<tr>
<td>'Mirror'</td>
<td>Mirror the image of the copy</td>
</tr>
<tr>
<td>'Drawing method'</td>
<td>Define the legend location</td>
</tr>
<tr>
<td>'Stamp'</td>
<td>Copy with a stamp</td>
</tr>
<tr>
<td>'Collate'</td>
<td>Define how to collate the copies.</td>
</tr>
<tr>
<td>'Scan quality'</td>
<td>Optimize the copy</td>
</tr>
</tbody>
</table>

[30] The available settings for copy jobs, a setting can contain more than one setting.
Improve the copy quality according to the original

Introduction

You can improve the copy or scan quality even more for the following situations.

- You have an original from a special type.
  The Océ TDS450 scanner makes sure that the copy or the scanned file has a sharp image. You can define the 'Original type' setting manually to improve the copy or scan quality according to the type of original you use.

- You have a dark or light original.
  The Océ TDS450 scanner detects the brightness of the image on the original automatically and makes sure that the copy or the scanned file has a bright image. You can adjust the brightness manually with the 'Lighter/darker' setting to improve the copy or scan quality according to the type of original you use.

- You have an original with very fine details.
  The Océ TDS450 scanner optimizes the image of the original automatically. You can optimize the image manually to sharpen the fine details with the 'Scan quality' setting.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor.

After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.
How to improve the copy quality of originals from a special type

1. Place the original face down and right aligned. The scanner takes the original.
2. Define the job settings.

   [39] The 'Lines&text' icon of the 'Original type' setting

   - Select 'Copy' with the upper-left softkey. The copy job templates appear.
   - Open a copy job template with a left softkey. The top 5 settings appear.
   - Scroll to 'Original type' and open this setting with the left softkey.
   - Scroll to the original type you have.

3. Define the number of copies if necessary and press the green start key.

Result

The copy quality was improved according to the original type.
How to improve the copy quality of dark and light originals

1. Place the original face down and right aligned. The scanner takes the original.
2. Define the job settings.
   - Select 'Copy' with the upper-left softkey. The copy job templates appear.
   - Open a copy job template with a left softkey. The top 5 settings appear.
   - Scroll to 'Lighter/darker' and open this setting with the left softkey.
   - Adjust the required value. A positive value lightens the copy, a negative value darkens the copy.

3. Define the number of copies if necessary and press the green start key.

Result

The copy quality improved according to the brightness of the original.
How to improve the copy quality of an original with very fine details

1. Place the original face down and right aligned. The scanner takes the original.
2. Define the job settings.

![Image of 'Best' icon]

[41] The 'Best' icon of the 'Scan quality' setting

- Select 'Copy' with the upper-left softkey. The copy job templates appear.
- Open a copy job template with a left softkey. The top 5 settings appear.
- Scroll to 'Scan quality' and open this setting with the left softkey.
- Scroll to 'Best'.

3. Define the number of copies if necessary and press the green start key.

Result

The copy quality improved according to the fine details on the original.
Make multiple sets of copies

Introduction

You can use the 'Create set' option to make multiple sets of copies.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor. After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.

Illustration

[42] The 'By set' (left) and 'By page' icon of the 'Collate' setting.
How to make multiple sets of copies sorted by set

1. Feed the first original face down and right aligned.
   The scanner takes the original.
2. Define the job settings.
   ■ Select 'Copy' with the upper-left softkey.
      The copy job templates appear.
   ■ Open a copy job template with a left softkey.
      The 'Create set' option appears at the upper-right corner of the screen.
   ■ Select 'Create set' with the upper-right softkey.
      The 'Cancel set' option appears at the upper-left corner of the screen. The
      'Close set' option appears at the upper-right corner of the screen.
   ■ Scroll to 'Collate' and define 'By set' with the left softkey.
      This setting is disabled after you press the green start key for the first time.
   ■ Scroll to another setting if necessary, select the setting with the left softkey
      and define the value with the scroll wheel.
   ■ Define the number of copies and press the green start key.
      You can not change the number of copies after you press the green start key
      for the first time.
   ■ Feed the next original, define the enabled settings for this original if
      necessary and press the green start key.
      Repeat this step until all originals are fed.
3. Select 'Close set' with the upper-right softkey.
How to make multiple sets of copies sorted by page

1. Feed the first original face down and right aligned. The scanner takes the original.

2. Define the job settings.
   - Select 'Copy' with the upper-left softkey. The copy job templates appear.
   - Open a copy job template with a left softkey. The 'Create set' option appears at the upper-right corner of the screen.
   - Select 'Create set' with the upper-right softkey. The 'Cancel set' option appears at the upper-left corner of the screen. The 'Close set' option appears at the upper-right corner of the screen.
   - Scroll to 'Collate' and define 'By page' with the left softkey. This setting is disabled after you press the green start key for the first time.
   - Scroll to another setting if necessary, select the setting with the left softkey and define the value with the scroll wheel.
   - Define the number of copies for the first original if necessary and press the green start key.
   - Feed the next original, define the enabled settings and the number of copies for this original if necessary and press the green start key. Repeat this step until all originals are fed.

3. Select 'Close set' with the upper-right softkey.

Result

The Océ TDS450 copies a set of originals sorted by set or by page.
Make a copy with a stamp

Introduction

A stamp is a pre-defined text you can set on every copy. The stamp function is an option. Use Océ License logic to enable this option. Use the Océ Settings Editor to define a maximum of 10 stamps and their default values.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor. After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.
How to make a copy with a stamp

1. Place the original face down and right aligned. The scanner takes the original.
2. Define the job settings.

[43] The stamp icon

- Select 'Copy' with the upper-left softkey. The copy job templates appear.
- Open a copy job template with a left softkey. The top 5 settings appears.
- Scroll to 'Stamp' and open this setting with the left softkey.
- Select a stamp with the scroll wheel.
- Select 'Position' with the left softkey. Select a position with the scroll wheel.
- Select 'Size' with the left softkey. Select a size with the scroll wheel.
- Select 'Colour' with the left softkey. Select a colour with the scroll wheel.

3. Define the number of copies and press the green start key.

Result

The copy contains the selected stamp.
Scale to another media size

Introduction

You can use the 'Scale' setting to copy to a larger or smaller media format. Use one of the following methods to scale a copy.

- Select another media format with the 'To fit' setting.
- Adjust a value in terms of percentage with the 'Custom' setting.
  You can adjust a value between 25 and 400%. A value lower than 100% reduces the copy, a value greater than 100% enlarges the copy.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor.

After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.
How to copy to another media size

1. Place the first original face down and right aligned. Make sure that you feed the original portrait.
   The scanner takes the original.
2. Define the job settings.
   
   ![Example of a 'Scale' icon]

   - Select 'Copy' with the upper-left softkey.
     The copy job templates appear.
   - Open a copy job template with a left softkey.
     The top 5 settings appear.
   - Scroll to 'Scale' and open this setting with the left softkey.
     The 'To fit' and the 'Custom' setting appear.
   - Define the media format at the 'To fit' setting with the scroll wheel.

3. Define the number of copies and press the green start key.

Result

The Océ TDS450 copies to another media size.
Make a copy on a cut sheet

Introduction

You can copy on cut sheet media if the required media type or size is not available on the media rolls of the printer.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor.
After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.

How to copy on a cut sheet

1. Place the original face down and right aligned.
   The scanner takes the original.
2. Define the job settings.
   - Select 'Copy' with the upper-left softkey.
     The copy job templates appear.
   - Open a copy job template with a left softkey.
     The top 5 settings appears.
   - Scroll to 'Media' and open this setting with the left softkey.
     The 'Feed' setting appears.
   - Define 'Manual' at the 'Feed' setting with the scroll wheel.
     The settings 'Size' and 'Type' appear.
   - Select 'Size' with the left softkey and define the 'Size' with the scroll wheel.
   - Select 'Type' with the left softkey and define the 'Type' with the scroll wheel.

3. Define the number of copies if necessary and press the green start key.
4. Place the cut sheet media on the manual feed table of the printer.
Note: *The printer prints the image face-up.*

Result

The Océ TDS450 copies on a cut sheet.
Make a copy and add a strip

Introduction

You can use a strip to file a drawing. Use 'Add strip' to copy an original without a strip and add a strip to the copy. Use 'Remove strip' to copy an original with a strip and remove the strip from the copy. You can adjust a strip at the leading or trailing side of a copy.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor.

After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.

How to make a copy and add a strip

1. Place the original face down and right aligned. The scanner takes the original.

2. Define the job settings.
   - Select 'Copy' with the upper-left softkey. The copy job templates appear.
   - Open a copy job template with a left softkey. The top 5 settings appears.
   - Scroll to 'Add strip' and open this setting with the left softkey.
   - Select 'Leading' or 'Trailing' with the left softkey and define the value with the scroll wheel or numeric keys.

3. Define the number of copies if necessary and press the green start key.

Note: To measure the size of a strip you can use the ruler available at the scanner (metric).
The Océ TDS450 adds a trailing or leading strip to the copy.
Make a copy and remove a strip

Introduction

You can use a strip to file a drawing. Use 'Add strip' to copy an original without a strip and add a strip to the copy. Use 'Remove strip' to copy an original with a strip and remove the strip from the copy. You can adjust a strip at the leading or trailing side of a copy.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor. After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.

**Attention:** *When you remove a strip, make sure that you copied all the required information.*

How to make a copy and remove a strip

1. Place the original face down and right aligned. The scanner takes the original.
2. Define the job settings.
   - Select 'Copy' with the upper-left softkey. The copy job templates appear.
   - Open a copy job template with a left softkey. The top 5 settings appears.
   - Scroll to 'Remove strip' and open this setting with the left softkey.
   - Select 'Leading' or 'Trailing' with the left softkey and define the value with the scroll wheel or numeric keys.
3. Define the number of copies if necessary and press the green start key.
Note: To measure the size of a strip you can use the ruler available at the scanner (metric).

Result

The Océ TDS450 removes a trailing or leading strip to the copy.
Make a copy of a specific area of an original

Introduction

You can make a copy of a specific area of an original with the 'Remove strip' setting. Define the following strips to specify the area.

- 'Leading'
- 'Trailing'
- 'Left'
- 'Right'

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor. After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.

Attention: When you remove a strip, make sure that you copied all the required information.
How to copy a specific area of an original

1. Place the original face down and right aligned. The scanner takes the original.
2. Define the job settings.
   ■ Select 'Copy' with the upper-left softkey. The copy job templates appear.
   ■ Open a copy job template with a left softkey. The top 5 settings appears.
   ■ Scroll to 'Remove strip' and open this setting with the left softkey.
   ■ Define the 'Leading' strip value with the scroll wheel or numeric keys.
   ■ Select 'Trailing' with the left softkey and define the value with the scroll wheel or numeric keys.
   ■ Select 'Left' with the left softkey and define the value with the scroll wheel or numeric keys. ‘Left' is the left side of an original that is turned face up.
   ■ Select 'Right' with the left softkey and define the value with the scroll wheel or numeric keys and close the setting. 'Right' is the right side of an original that is turned face up.
   ■ Scroll to 'Alignment' and open this setting with the left softkey.
   ■ Define the value of the 'Horizontal' setting to 'Centre' with the scroll wheel.
   ■ Select 'Vertical' with the left softkey and define 'Centre' with the scroll wheel.
3. Define the number of copies if necessary and press the green start key.

Note: To measure the size of a strip you can use the ruler available at the scanner (metric).

Result

The Océ TDS450 copies a specific area of the original to the specified position on the copy.
Make a copy and delete a specific area of an original

Introduction

You can make a copy without a specific area of an original with the 'Delete area' setting.

Attention: When you copy without a specific area, make sure that you copied all the required information.

How to copy a specific area of an original

1. Place the original face down and right aligned. The scanner takes the original.
2. Define the job settings.
   - Select 'Copy' with the upper-left softkey. The copy job templates appear.
   - Open a copy job template with a left softkey. The top 5 settings appears.
   - Scroll to 'Delete area' and open this setting with the left softkey.
   - Define the 'X Offset' with the scroll wheel or numeric keys.
   - Select 'Y Offset' with the left softkey and define the value with the scroll wheel or numeric keys.
   - Select 'Width' with the left softkey and define the value with the scroll wheel or numeric keys.
   - Select 'Length' with the left softkey and define the value with the scroll wheel or numeric keys and close the setting.
3. Define the number of copies if necessary and press the green start key.

Result

The Océ TDS450 copies an original without the specified area.
Chapter 12
Scan-to-file jobs
Introduction to scan-to-file jobs

Introduction

A basic scan-to-file job takes three steps. Feed the original, select 'Scan-to-file' and press the start key. Every other type of scan-to-file job, where you change the scan-to-file settings, is called an extended scan-to-file job. An extended scan-to-file job takes one additional step. Define the scan-to-file job settings at the scanner operator panel. When you select 'Scan-to-file', the scanner operator panel shows five scan-to-file job templates. The scan-to-file job templates provide access to the different settings per scan-to-file job template. When you select a scan-to-file job template, the scanner operator panel shows the top 5 settings of the selected scan-to-file job template. The top 5 settings are the most often used settings. You can define the top 5 settings and their values for each scan-to-file job template with the Océ Settings Editor. You can use the scroll wheel to see the other settings. After you start a scan-to-file job, you can manage your jobs from the Océ Queue Manager.

Illustration

[Image]

The scan-to-file job templates

Steps in a basic scan-to-file job

1. Feed the original.
2. Select 'Scan-to-file'
3. Press the green start key.
Result

You get a digital file of your original.

Steps in an extended scan-to-file job without fine tuned job templates

1. Feed the original.
2. Select 'Scan-to-file'.
3. Define the scan-to-file job settings at the scanner operator panel.
   ■ Open a template.
   ■ Select the first setting and define the value.
   ■ Select the second setting and define the value.
   ■ ....
   ■ Select the last setting and define the value.
4. Press the green start key.

Result

The second step takes several additional actions.

Steps in an extended scan-to-file job with fine tuned job templates

1. Feed the original.
2. Select 'Scan-to-file'.
3. Define the job settings.
   Select the required template at the scanner operator panel and change the pre-defined settings only if necessary.
4. Press the green start key.

Result

You get a tuned digital file of your original.
Use the scanner operator panel

Introduction

Use the scanner operator panel to define the job settings. You can define the job settings in two ways.

- Use the left softkeys and the scroll wheel.
  - You can use this method if you prefer a general step by step method.
- Use the scroll wheel and scroll-wheel key only.
  - You can use this method if you prefer a fast method.

Know that the scanner operator panel also uses icons to explain a setting. The following illustration shows the scanner operator panel of the Océ TDS450 scanner.

(see table 2 on page 25).
Illustration

[48] The operator panel of the Océ TDS450 scanner
Define job settings with the left soft keys and the scroll wheel

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey.
   The five job templates appear.
2. Select a job template with one of the left softkeys.
   The top 5 settings appear.
3. Find a setting with the scroll wheel.
   A small rectangle in front of a setting name indicates the focus of the scroll wheel.
4. Select a setting with the left softkey.
   There are several types of settings. The behaviour of the scanner operator panel and the definition of a setting depends on the type of setting you selected. You can select one of the following types of settings.
   - A setting that contains two values only, like 'On' or 'Off'.
     When you select this setting while the setting was not in focus, the setting becomes in focus. When you select this setting while the setting was already in focus, the setting stays in focus and there are no changes.
     Change the value of the setting with the left softkey. The value and icon changes.
   - A setting that contains a list of values, like 'Lighter/darker'.
     Define the required value with the scroll wheel. The value and icon changes.
   - A setting that contains a list of settings, like 'Media'.
     Define the required value with the scroll wheel. The value and icon changes.
     Select the next setting of the list of settings with the left softkey.

   **Note:** You can enter a numeric value with the numeric keys. To enter a negative numeric value, scroll to a negative value first and than enter the value with the numeric keys.
5. Select 'Close' with the lower-right softkey.
6. Repeat from step 4 to define the next setting.

   **Note:** Use the 'Defaults' option at the lower-left key to set all settings of the job template to default.
Define job setting with the scroll wheel and scroll-wheel key only

1. Select 'Copy' or 'Scan-to-file' with the upper-left softkey. The five job templates appear.
2. Focus on a job template with the scroll wheel. A small diamond in front of a template indicates the focus of the scroll wheel.
3. Select a job template with the scroll-wheel key. The top 5 settings appear.
4. Find a setting with the scroll wheel. A small rectangle in front of a setting name indicates the focus of the scroll wheel.
5. Select the setting with the scroll-wheel key. There are several types of settings. The behaviour of the scanner operator panel and the definition of a setting depends on the type of setting you selected. You can select one of the following types of settings.
   - A setting that contains two values only, like 'On' or 'Off'. Change the value of the setting with the scroll-wheel key to change the value of the setting. The value and icon changes.
   - A setting that contains a list of values, like 'Lighter/darker'. Open the setting with the scroll-wheel key. Define the required value with the scroll wheel. The value and icon changes. Close the setting with the scroll-wheel key.
   - A setting that contains a list of settings, like 'Media'. Focus on a setting with the scroll wheel. The bold text of a value indicates the focus of the scroll wheel. The icon changes. Open the setting with the scroll-wheel key. The list of values appears. Open the setting with the scroll-wheel key. Define the required value with the scroll wheel. The value and icon changes. Close the setting with the scroll-wheel key.

Note: You can enter a numeric value with the numeric keys. To enter a negative numeric value, scroll to a negative value first and than enter the value with the numeric keys.

6. Select 'Close' with the lower-scroll-wheel key.
7. Repeat from step 4 to define the next setting.

Note: Use the 'Defaults' option at the lower-left key to set all settings of the job template to default.
Do a basic scan-to-file job

Introduction

This section describes a general workflow for a basic scan-to-file job.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor. After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.

How to do a basic scan-to-file job on the Océ TDS450

1. Place the original face down and right aligned. The scanner takes the original.

2. Select 'Scan-to-file' with the upper-left softkey.
3. Press the green start key.

Result

The scanner scans the original and the sends the scanned file to the default scan-to-file destination.
Do an extended scan-to-file job

Introduction

This section describes a general workflow for an extended scan-to-file job.

Before you begin

If you must enter the same value for a setting very often, you can set this value as the default value for that setting in the Océ Settings Editor. After you press the start key, the scanner operator panel always shows the job number and status of the job. A copy job appears temporarily in the printer queue of the Océ Queue Manager, a scan-to-file job appears in the selected destination of the Océ Scan Manager.

How to do an extended scan-to-file job on the Océ TDS450

1. Place the original face down and right aligned.

The scanner takes the original.

[50] Place the original face down and right aligned
2. Select 'Scan-to-file' with the upper-left softkey. The scan-to-file job templates appear.

3. Define the job settings.

![Image: The top 5 settings of a scan job template](image)

(see ‘Available settings for scan-to-file jobs’ on page 222)

- Open a scan-to-file job template with a left softkey. The top 5 settings appears.
- Scroll to a setting.
- Select a setting with the left softkey.
- Scroll to the required value.
- Select the next setting with the left softkey.
- Scroll to the required value.
- Select 'Close' to close the setting.
- Repeat the selection of settings from bullet 3 if you need to define more settings.

4. Press the green 'Start' key.

**Result**

The scanner scans the original and the sends the scanned file to the defined scan-to-file destination.
Stop a scan-to-file job

Introduction

You can stop a scan-to-file job with the red stop key at the scanner operator panel.

How to stop a scan-to-file job

1. Press the red stop key.

Result

When you press the red stop key while the scanner scans, the scan process stops. The scanner rewinds the original and the scan-to-file job is cancelled. When you press the red stop key while the scanner rewinds, the rewind process continues. The scan-to-file job is cancelled.
## Settings for extended scan-to-file jobs

### Available settings for scan-to-file jobs

#### The scan-to-file settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Destination'</td>
<td>Use this setting to define the default destination for scan-to-file jobs on the controller. You can define a maximum of 10 remote destinations and one of these destinations is the default destination.</td>
</tr>
<tr>
<td>'File type'</td>
<td>Depending on the colour mode and file type you select the values for the compression mode and organisation will change. For some File types, the Compression and Organisation settings cannot be set in all situations. (see ‘File type’ on page 224)</td>
</tr>
<tr>
<td>'Resolution'</td>
<td>Use this setting to define the resolution of the scanned images. The higher the resolution you select, the finer the image quality but the larger the file size. (see ‘Resolution’ on page 226)</td>
</tr>
<tr>
<td>'Original type'</td>
<td>Use this setting to define the type of original for your scan-to-file jobs. The defined type influences the quality of the output. (see ‘Original type’ and background compensation’ on page 227)</td>
</tr>
<tr>
<td>'Original width'</td>
<td>Use this setting to define the width of the original that the scanner scans. (see ‘Original width’ on page 228)</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>'Remove strip'</td>
<td>Use this setting to define blank areas on the sides of the scanned image. (see ‘Remove strip’ on page 229)</td>
</tr>
<tr>
<td>'Mirror'</td>
<td>Use this setting to create a mirrored image of an original. Mirroring occurs in the transport direction. (The image is mirrored along the vertical axis.)</td>
</tr>
<tr>
<td>'Lighter/darker'</td>
<td>Use this setting to define the exposure of the original. Negative values mean less exposure and darker scanned output. Positive values mean more exposure and greyer scanned output.</td>
</tr>
<tr>
<td>Note:</td>
<td><strong>This setting can only be set if the colour mode you select is grey or black and white.</strong></td>
</tr>
<tr>
<td>'Checkprint'</td>
<td>Use this setting to define if the system prints a checkprint for a scan-to-file job. The checkprint represents the quality of the scanned document.</td>
</tr>
<tr>
<td>Note:</td>
<td><strong>This setting can not be used for scan-to-file jobs with colour.</strong></td>
</tr>
</tbody>
</table>
Depending on the colour mode and file type you select the values for the compression mode and organisation will change. For some file types, the Compression and Organisation settings cannot be set in all situations.

**Colour mode: Greyscale**

<table>
<thead>
<tr>
<th>Colour mode</th>
<th>File type</th>
<th>Compression</th>
<th>Organisation</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Greyscale'</td>
<td>'TIFF'</td>
<td>'None'</td>
<td>'Raw'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Packbits'</td>
<td>'Tiled'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>'LZW'</td>
<td>'Striped'</td>
</tr>
<tr>
<td>'PDF'</td>
<td></td>
<td>'None'</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Flate'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Group 4'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Packbits'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>'LZW'</td>
<td></td>
</tr>
</tbody>
</table>

**Colour mode: Black and White**

<table>
<thead>
<tr>
<th>Colour mode</th>
<th>File type</th>
<th>Compression</th>
<th>Organisation</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Black&amp;white'</td>
<td>'TIFF'</td>
<td>'None'</td>
<td>'Raw'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Group 3'</td>
<td>'Tiled'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Group 4'</td>
<td>'Striped'</td>
</tr>
<tr>
<td>'PDF'</td>
<td></td>
<td>'None'</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>'LZW'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Flate'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>'Group 4'</td>
<td></td>
</tr>
<tr>
<td>'CALS'</td>
<td>Not available</td>
<td>Not available</td>
<td>Not available</td>
</tr>
</tbody>
</table>
### Colour mode: Colour

<table>
<thead>
<tr>
<th>Colour mode</th>
<th>File type</th>
<th>Compression</th>
<th>Organisation</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Colour'</td>
<td>'TIFF'</td>
<td>- 'None'</td>
<td>- 'Raw'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 'Packbits'</td>
<td>- 'Tiled'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 'LZW'</td>
<td>- 'Striped'</td>
</tr>
<tr>
<td>'PDF'</td>
<td></td>
<td>- 'None'</td>
<td>Not available</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 'LZW'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 'Flate'</td>
<td></td>
</tr>
</tbody>
</table>
Use this setting to define the resolution of the scanned images. The higher the resolution you select, the finer the image quality. Select the required scan resolution with the scroll wheel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value in dots per inch</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Resolution'</td>
<td>■ '72 dpi'</td>
</tr>
<tr>
<td></td>
<td>■ '100 dpi'</td>
</tr>
<tr>
<td></td>
<td>■ '150 dpi'</td>
</tr>
<tr>
<td></td>
<td>■ '200 dpi'</td>
</tr>
<tr>
<td></td>
<td>■ '300 dpi'</td>
</tr>
<tr>
<td></td>
<td>■ '400 dpi'</td>
</tr>
<tr>
<td></td>
<td>■ '600 dpi'</td>
</tr>
</tbody>
</table>

Note: A higher resolution increases the file size.
'Original type' and background compensation

Use the 'Original type' setting to define the type of original for copy and scan-to-file jobs. The defined type influences the quality of the output. Use the 'Backgnd comp' setting to define the background compensation for your original.
Select the type of original and the background compensation with the scroll wheel.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
</table>
| 'Original type' | ■ 'Lines&text' for paper  
|               | ■ 'Greys&Lines'  
|               | ■ 'Dark original'  
|               | ■ 'Blueprint'  
|               | ■ 'Photo'  
|               | ■ 'Transparent' for transparencies                                   |
| 'Backgnd comp' | When the background on the original has pollution, use this setting to improve the quality of the background. The compensation depends on the type of the originals. If enabled, the background compensation for 'Photo' or 'Greys&Lines' originals is a standard value. |

**Note:** If the colour mode of a scan to file job is set to colour, the original type is fixed.
'Original width'

Use this setting to define the width of the original that the scanner scans.

Select one of the following.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Icon</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Auto'</td>
<td><img src="image" alt="Auto Icon" /></td>
<td>The scan width is automatically determined based on the actual width of the original.</td>
</tr>
<tr>
<td>'Standard'</td>
<td><img src="image" alt="Standard Icon" /></td>
<td>Use this setting to a 'Standard' width of the original. The standard widths that you can select depend on the media series that you selected in the Océ Settings Editor.</td>
</tr>
<tr>
<td>'Custom'</td>
<td><img src="image" alt="Custom Icon" /></td>
<td>Custom-selected width. Use this setting if the 'Auto' setting or the 'Standard' setting does not give the required result.</td>
</tr>
</tbody>
</table>
'Remove strip'

Use the 4 settings below to define the blank areas around the image.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Icon</th>
<th>Result</th>
</tr>
</thead>
</table>
| 'Remove strip' - 'Leading' | ![Icon] | Use this setting to remove a strip at the top of the image. This action decreases the print or file length.  
**Note:** The top side of the image is the side that you feed into the scanner. |
| 'Remove strip' - 'Trailing'  | ![Icon] | Use this setting to remove a strip at the bottom of the image. This action decreases the print or file length.                      |
| 'Remove strip' - 'Left'    | ![Icon] | Use this setting to remove a strip from the left side of the image/original viewed from the face-up direction. This action decreases the print or file width. |
| 'Remove strip' - 'Right'   | ![Icon] | Use this setting to remove a strip from the right side of the image/original viewed from the face-up direction. This action decreases the print or file width. |

[31] Remove strips
Chapter 13
Finish copy and print jobs
Overview of the finishing settings

Introduction

Before you use the folder, switch the lever downward. If you want to use the Integrated Receiving Tray, switch the lever upward.

The lever

[52] To fold, switch the lever downward
Overview of the finishing settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Menu path</th>
<th>Description</th>
</tr>
</thead>
</table>
| Folded output delivery       | 'Folding' - 'Delivery' | Determines where the folder must deliver the output.  
- Select 'Stacker' if you have output with a maximum length of 2.5 m that must be folded completely (first fold and second fold) and that you want to collect in the stacker (2) (second fold delivery). You can collect a maximum of 25 PPP.  
- Select 'First Fold' if your output must be folded in one direction only. The output will be collected in the First Fold Delivery (8).  
- Choose 'Belt' if you have output with a maximum length of 2.5 m that must be folded completely (first fold and second fold) and that you want to collect in belt (3). You can collect a maximum of 75 PPP.  
(see ‘Define the folded output delivery’ on page 236) |

**Note:** The 'First Fold' option is selected automatically if the length of your output is between 2.5 m and 6 m.  
**Note:** You can only choose 'Belt' if your folder has a belt unit. (see ‘The belt unit’ on page 244)
<table>
<thead>
<tr>
<th>Setting</th>
<th>Menu path</th>
<th>Description</th>
</tr>
</thead>
</table>
| Folding legend               | 'Folding' - 'Input' - 'Legend'     | Use this setting to define if the legend of your drawing is on the trailing side of your drawing or on the leading side. The folder folds the output in such a manner that the legend of the drawing is on top of the folded output.  
  ■ Select 'Trailing' if the legend of your drawing is on the trailing side.  
  ■ Select 'Leading' if the legend of your drawing is on the leading side.  
  (see ‘Define the folding legend’ on page 237)  
  **Note:** The leading side of the drawing is the side that you feed into the scanner. |
| Drawing method               | 'Folding' - 'Input' - 'Method'     | Use this setting to select a folding method that depends on the drawing method you use. If you select 'Afnor' you can define the length, the width and the binding edge of your folded package.  
  ■ Select 'Standard' if......  
  ■ Select 'Afnor' if...  
  ■ Select 'Ericsson' if...  
  (see ‘Define the drawing method’ on page 238) |
| Binding method               | 'Folding' - 'Binding' - 'Method'   | ■ Select 'Off' if you don't want your folded output to have a strip that you can perforate for filing purposes.  
  ■ Select 'On' if you do want your folded output to have a strip that you can perforate for filing purposes.  
  ■ Select 'Reinforce' if you want your folded output to have a reinforced strip that is pre-perforated for filing purposes.  
  (see ‘Define the binding method’ on page 239)  
  **Note:** You can only choose 'Reinforce' if your folder has a reinforcement unit. (see ‘The reinforcement unit’ on page 243) |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Menu path</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binding edge value</td>
<td>'Folding' - 'Binding edge' - 'Method'</td>
<td>Determines the width of the strip if you have selected that your binding method is 'On'. (see ‘Define the binding edge value’ on page 240)</td>
</tr>
<tr>
<td>Folded package length</td>
<td>'Folding' - 'Package' - 'Length'</td>
<td>Select this setting if you want to define the length of your folded output. (see ‘Define the folded package length’ on page 241)</td>
</tr>
<tr>
<td>Folded package width</td>
<td>'Folding' - 'Package' - 'Width'</td>
<td>Select this setting if you want to define the width of your folded output. (see ‘Define the folded package width’ on page 242)</td>
</tr>
</tbody>
</table>
Define the folded output delivery

**Before you begin**

Use the ‹ key, the › key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

**How to define the folded output delivery**

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding' and select this menu.
3. Navigate to 'Delivery' and select this menu.
4. Select 'Stacker', 'First Fold' or 'Belt'.
5. Press the 'on-line' key to turn the printer on-line.
Define the folding method

Define the folding legend

Before you begin

Use the ← key, the → key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the folding legend

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding' and select this menu.
3. Navigate to 'Input' and select this menu.
4. Navigate to 'Legend' and select this menu.
5. Select 'Trailing' or 'Leading'.
6. Press the 'on-line' key to turn the printer on-line.
Define the drawing method

Before you begin

Use the ▲ key, the ▼ key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the drawing method

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding' and select this menu.
3. Navigate to 'Input' and select this menu.
4. Navigate to 'Method' and select this menu.
5. Select 'Standard', 'Afnor' or 'Ericsson'.
6. Press the 'on-line' key to turn the printer on-line.
Define the binding method

Before you begin

Use the ▽ key, the ▼ key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the binding method

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding' and select this menu.
3. Navigate to 'Binding' and select this menu.
4. Navigate to 'Method' and select this menu.
5. Select 'Off', 'On' or 'Reinforce'.
6. Press the 'on-line' key to turn the printer on-line.
Define the binding edge value

Before you begin

Use the ← key, the → key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the binding edge value

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding' and select this menu.
3. Navigate to 'Binding edge' and select this menu.
4. Navigate to 'Method' and select this menu.
5. If you selected 'On' in the (see ‘How to define the binding method’ on page 239) procedure, enter a range between 15 - 30 mm, in steps of 1 mm; Default value is 20 mm.
6. Press the 'on-line' key to turn the printer on-line.
Define the folded package size

Define the folded package length

Before you begin

Use the key, the key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the folded package length

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding' and select this menu.
3. Navigate to 'Package' and select this menu.
4. Navigate to 'Length' and select this menu.
5. Enter a range between 276 - 310 mm in steps of 1 mm; Default value is 297 mm.
6. Press the 'on-line' key to turn the printer on-line.
Define the folded package width

Before you begin

Use the ◀ key, the ▶ key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the folded package width

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Folding' and select this menu.
3. Navigate to 'Package' and select this menu.
4. Navigate to 'Width' and select this menu.
5. Enter a range between 186 - 230 mm in steps of 1 mm; Default value is 210 mm.
6. Press the 'on-line' key to turn the printer on-line.
The reinforcement unit

Introduction

If your folder has a reinforcement unit, you can deliver your output with a perforated, self-adhesive strip.

Example of a reinforcement strip

Note: You can only use reinforcement strips with the 'Standard' folding method. The reinforcement strip allows you to store your copy in a binder. The punch holes will not wear out. You can unfold a folded map in a binder while the binding mechanism remains closed.

Example of a folded map with a reinforcement strip

The reinforcement unit supports all media sizes larger than A4.
The belt unit

Introduction

If your folder has a belt unit, you can stack a maximum of 75 folded A0 prints.

You can adjust the side guides of the belt, depending on the width of the folded package.

Before you begin

Select 'Belt' as folded output delivery, as described in the (see ‘How to define the folded output delivery’ on page 236) procedure.

How to adjust the side guides of the belt

1. Loosen the nuts

2. Adjust the plate in accordance with the width of the fold package.

3. Tighten the nuts.
Off-line folding

Introduction

An important feature provided by the folder is off-line folding. You can use the same settings for off-line folding and normal folding. Define the default settings for off-line folding in the Océ Settings Editor. Do not fold Polyester or transparent media. This media can cause media jams.

Note: Use off-line folding only for the sheets that do not exceed a maximum length of 6 m. If you try to fold a sheet longer than 6 m, an error occurs.

How to make off-line folds

1. Press the 'on-line' key on the printer operator panel and watch the light on the top cover of the folder.

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>the light is off</td>
<td>the printer is on-line and off-line folding is not possible.</td>
</tr>
<tr>
<td>the light blinks slowly</td>
<td>the printer is off-line but the folder is still processing the last prints.</td>
</tr>
<tr>
<td>the light blinks rapidly</td>
<td>an error has occurred</td>
</tr>
<tr>
<td>the light is on</td>
<td>the printer is off-line and you can feed a sheet.</td>
</tr>
</tbody>
</table>

[32] Indication light folder

Note: See the label on the top cover of the folder.

2. Make any setting for (off-line) folding on the printer operator panel.
3. Feed the sheet of paper face down and with the legend on your right-hand side.
   Note: Wait until the light on the folder no longer blinks before you feed a new sheet. A media jam can occur.
4. Collect your output.
Chapter 14
Maintain the Océ TDS450
Clear the set memory

Introduction

The Océ TDS450 has the following two memories.

- The set memory.
  The set memory contains the copy and print jobs. The Océ System Control Panel shows the use of the set memory.

- The temporary store.
  The temporary store contains the files you made with the scan-to-file jobs. You can clear the temporary memory with the Océ Scan Manager (see ‘Clear the temporary store’ on page 154).

Before you begin

The system tells you when you need to clear the set memory. You can clear the set memory at the Océ Queue Manager and at the printer operator panel. Océ advises you to clear the set memory with the Océ Queue Manager if possible. When you clear the set memory at the printer operator panel, use the ◀ key, the ► key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

Attention: When you clear the set memory at the printer operator panel, all copy and print jobs are deleted. You can never undo this action.

Clear the set memory at the Océ Queue Manager

1. Start the Océ Queue Manager.
2. Delete jobs from the Océ Queue Manager.
   (see ‘How to cancel jobs from the Océ Queue Manager’ on page 145)
Clear the set memory at the printer operator panel

1. Make sure you have access to the system settings.
   (see ‘How to access the system settings’ on page 123)
2. Navigate to ‘Clear setmem’ and select this setting.
3. Select 'Yes'
4. Press 'next/select' to confirm.
5. Press 'on-line' to put the printer on-line again.
6. Shut down the Océ Power Logic controller.
   (see ‘How to shut down the Océ Power Logic® controller’ on page 114)
Maintain the Océ TDS450 scanner

Clear an original jam

Introduction

A red light at the scanner operator panel indicates that an original jam occurred.

How to remove a jammed original

1. Pull the top cover towards you and lift the top cover to open it.

2. Remove the original.
3. Lift the top cover, turn the top cover towards you and push the top cover backwards until you hear or feel a click.

Result

The green light at the scanner operator panel is on.
Scanner error-messages and solutions

Introduction

When an error occurs, the Océ TDS450 scanner shows the following information.

- The error-message icon
- The error message
- A description of the solution
- An error code
- Functions at the lower softkeys.
  In some cases you need these functions, like wind and rewind for example, to come to the solution.

How to handle error messages at the scanner

1. Read the error message carefully

2. Follow the instructions on the scanner operator panel.

Result

You solved the error with the help of the instructions on the scanner operator panel.
Calibrate the scanner

Introduction

You can calibrate the scanner when you are not satisfied with the scan quality. Use the calibration wizard to calibrate the scanner.

How to calibrate the scanner

1. Select 'System' with the lower-right softkey. The 'System settings' screen opens.
2. Select 'Scanner calibration' with a left softkey to start the calibration wizard. The message 'Insert calibration sheet' and the following icon appears.

3. Insert the calibration sheet and press the green start key to start the calibration process. The message 'Scanner is calibrating...' and the following icon appears.

When the calibration process is ready, the message 'Press OK to continue' and the following icon appears.

4. Select 'OK' with the lower-right softkey.
Note: When the calibration process stops or fails, follow the instructions on the scanner operator panel carefully.

Result

The Océ TDS450 scanner is calibrated and the scan quality is correct again.
Clean the scan area

Introduction

You need to keep the glass plate clean. A dirty glass plate causes a decreased copy and scan quality. Clean the glass plate when you have lines on the image that are not on the original.

Required tools

Océ cleaner A, part of cleaning kit with codenumber 1068117

Two lint-free cloths

**Attention:** Use Océ cleaner A to get the best results.

**Attention:** Make sure you do not damage the sensor at the right of the glass plate.

How to clean the glass plate

1. Turn off the Océ TDS450 scanner.
2. Pull the top cover towards you and lift the top cover to open it.
3. Clean the glass plate and the white plate with a lint-free cloth and a small quantity of the cleaner.

4. Dry the glass plate and the white plate with another lint-free cloth.

5. Clean the white plate.

6. Lift the top cover, turn the top cover towards you and push the top cover backwards until you hear or feel a click.

7. Turn on the Océ TDS450 scanner.
Maintain the Océ TDS450 printer

Media

Load the media

Introduction

The Océ TDS450 printer is available with a roll unit for one or two rolls. You can load each of the rolls on the Océ TDS450 printer with print media of a different size or type. The size and type of the available media are indicated on the operator panel.

If you install new print media, you must tell the system the size of the material and the type of print material. (paper, transparent, or polyester)

When a roll is empty during a print job, a ‘Roll empty’ message is displayed on the printer operator panel. The message appears also on the Océ System Control Panel application. You must install a new roll of print material.

Install the paper on roll 1

1. Open the drawer completely.

[63] Open the drawer
2. Remove the roll holder from the drawer

3. Remove the empty core from the roll holder when you press the knob.

4. Slide the roll holder in the new roll of media while pressing the knob. Make sure that the knob is at the right side and that the media is positioned as shown in the figure below.

[64] Removing the roll holder from the drawer

[65] Press the knob
5. Align the roll with the correct lines on the roll holder while pressing the knob. The line must be visible.

6. Put the roll holder with the media in the drawer

7. Feed the media between the input guide plates against the rollers.

8. Turn the rollers until the media is visible. Also refer to the label inside the drawer.

9. If you inserted a roll with another media or with a different width, you must program the correct width and material type. If you need to cut the paper to get a straight leading strip, select ‘Cut media’.

10. Close the drawer.

11. Press the On-line key.
Install the media on roll 2

1. Open the flap to get access to roll 2.

2. Remove the roll holder.
3. Remove the empty core from the roll holder when you press the knob.

4. Slide the roll holder in the new roll of media while pressing the knob. Make sure that the knob is at the right side and that the media is positioned as shown in the figure below.

![Press the knob](image)

5. Align the roll with the correct lines on the roll holder while pressing the knob. The line must be visible.

6. Put the roll holder with the media in the lower paper compartment.

![Reposition the roll](image)
7. Feed the media between the input guide plates against the rollers.
8. Turn the rollers until the media is visible. Also refer to the label inside the drawer.

9. If you inserted a roll with another media or with a different width, you must program the correct width and media type. If you need to cut the paper to get a straight leading strip, select 'Cut media'.
10. Close the lower media compartment.
11. Press the On-line key.
Define the media type and media size

Introduction

One of the features of the Océ TDS450 printer is the automatic media change function. This function allows the printer to take another roll of the same media format and media type in case you run out of media during a print job. You can activate this function in the Océ Settings Editor.

Note: The media change will only take place if both rolls contain the same media format and media type.

Note: The Océ TDS450 printer can not identify the media format and media type. After you fill the media you must indicate the media type and media format in this menu.

Purpose

To define the media type and media size of a media roll

When to do

After you insert a new media roll.

Before you begin

Use the  key, the  key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the media size

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Media settings' and select this menu.
3. Navigate to 'Roll 1' or 'Roll 2' and select this menu.
4. Navigate to 'Width' select this menu.
5. Navigate to the required media size and select this value.
6. Press the 'on-line' key to turn the printer on-line.
How to define the media type

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Media settings' and select this menu.
3. Navigate to 'Roll 1' or 'Roll 2' and select this menu.
4. Navigate to 'Material' select this menu.
5. Navigate to the required media type and select this value.
6. Press the 'on-line' key to turn the printer on-line.
Cut the media

When to do

If the media does not have a straight leading strip, you can cut the media at a right angle from the roll.

Before you begin

Use the ⬅️ key, the ➤️ key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to cut the media

1. Press the 'on-line' key to turn the printer off-line.
2. Open the drawer and feed the media manually until it is 5 cm above the top drawer.
3. Close the drawer.
4. Navigate to 'Media settings' and select this menu.
5. Navigate to 'Cut media' and select this value.
6. Open the drawer and remove the scrap of media.
7. Feed the media until it is visible.
8. Close the drawer.
9. Press the 'on-line' key to turn the printer on-line.
Define the media series of the Océ TDS450 printer

Introduction

You need to define which media series to use.

Before you begin

Use the ▼ key, the ▲ key and the 'previous' key to navigate. Use the 'next/select' key to select a menu or a value.

How to define the media series of the Océ TDS450 printer

1. Press the 'on-line' key to turn the printer off-line.
2. Navigate to 'Configuration' and select this menu.
3. Navigate to 'Paper series' and select this menu.
4. Navigate to the required media series and select this value.
5. Press the 'on-line' key to turn the printer on-line.

Result

The required media series is defined.
Refill the toner

Introduction

If the ‘Refill toner’ message appears on the printer panel, you must refill the toner immediately.

Attention: *Use only B5 toner.*

Refill the toner

1. Turn off the printer.
2. Open the left cover.
3. Shake the toner bottle thoroughly and open the bottle.
4. Screw in the bottle clockwise in a slanted position.

5. Move the toner bottle upwards into a vertical position

6. Tap the toner bottle gently to let the toner flow from the bottle.
7. When the toner bottle is empty, return the bottle to the original position. Turn the bottle in counter clockwise direction to remove.
Replace the waste toner bag

**Attention:** *Replace the toner waste bag, when you refill the toner.*

1. Pull the waste toner bag from the holder and place the cap provided on the bag on the opening.

2. Slide a new waste toner bag over the holder.
3. Close the cover.
4. Turn on the printer.
**Introduction**

The following table shows a list of error messages. You can use this table to find a description and the solution.

**The error messages**

<table>
<thead>
<tr>
<th>Error message</th>
<th>Description / solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Copy too late'</td>
<td>A media jam occurred. Remove the stuck media and press on-line.</td>
</tr>
<tr>
<td>'Remove paper'</td>
<td>(see ‘Clear media jam in the media feed section of the printer’ on page 274)</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td>(see ‘Clear media jam in the fuser section’ on page 275)</td>
</tr>
<tr>
<td>'Speed failure'</td>
<td>A media jam occurred. Remove the stuck media and press on-line.</td>
</tr>
<tr>
<td>'Remove paper'</td>
<td>(see ‘Clear media jam in the media feed section of the printer’ on page 274)</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td>(see ‘Clear media jam in the fuser section’ on page 275)</td>
</tr>
<tr>
<td>'Knife 1 error'</td>
<td>An error occurred during the cut of the roll. Check the media on roll 1 and remove scrapped media if necessary. Press on-line.</td>
</tr>
<tr>
<td>'Remove paper'</td>
<td>(see ‘Load the media’ on page 256)</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Knife 2 error'</td>
<td>An error occurred during the cut of the roll. Check the media on roll 1 and remove scrapped media if necessary. Press on-line</td>
</tr>
<tr>
<td>'Remove paper'</td>
<td>(see ‘Load the media’ on page 256)</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Roll retract err'</td>
<td>A media roll error. Check the media on the rolls and press on-line.</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td>(see ‘Load the media’ on page 256)</td>
</tr>
<tr>
<td>Error message</td>
<td>Description / solution</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>'Roll init error'</td>
<td>The media of a roll was not in the start position while the printer was turned on. Place the media back into the start position and press on line. (see ‘Load the media’ on page 256)</td>
</tr>
<tr>
<td>'Open roll unit'</td>
<td></td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Input too late'</td>
<td>The input sheet is too late. Open the roll unit, withdraw roll and rewind. Press on-line</td>
</tr>
<tr>
<td>'Open roll unit'</td>
<td></td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Deposit error'</td>
<td>An error occurred in the compact output stacker. The compact output stacker stops. The print process continues. Press &lt;on-line&gt;.</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Illegal language at controller'</td>
<td>The controller has an illegal language. The controller uses the English language instead of the selected language. Call your Océ representative and press on-line.</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Close roll unit'</td>
<td>The roll unit was opened during the print process. Open the roll unit, rewind the paper and close the roll unit. Press on-line</td>
</tr>
<tr>
<td>'Rewind paper'</td>
<td></td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Error 1st fold'</td>
<td>A media jam occurred in the first fold section of the folder. Clear the media jam and press on-line. (see ‘Clear media jams in the folder’ on page 293)</td>
</tr>
<tr>
<td>'Error in folder'</td>
<td>A tape jam occurred in the reinforcement unit or a media jam occurred in the folder. A media jam can occur in the transport section of the folder or in the reinforcement unit of the folder. Clear the tape jam or clear the media jam and press on-line. (see ‘Clear media jams in the folder’ on page 293) (see ‘Clear tape jam in the reinforcement unit’ on page 291)</td>
</tr>
<tr>
<td>'Error 2nd fold'</td>
<td>A media jam occurred in the second fold section of the folder. Clear the media jam and press on-line. (see ‘Clear media jams in the folder’ on page 293)</td>
</tr>
<tr>
<td>'Wrong format'</td>
<td>The folder detected a media format other than specified on the printer operator panel. Correct the format at the printer operator panel. (see ‘Define the media type and media size’ on page 262)</td>
</tr>
</tbody>
</table>
# Printer system-messages and solutions

## Introduction

The following table shows a list of system messages. You can use this table to find a description or solution.

## The system messages

<table>
<thead>
<tr>
<th>System message</th>
<th>Description / solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Off-line'</td>
<td>The printer is off-line. You can change the settings.</td>
</tr>
<tr>
<td>'Roll empty'</td>
<td>Try the following solutions.</td>
</tr>
<tr>
<td></td>
<td>■ Load new media on the roll. (see ‘Load the media’ on page 256)</td>
</tr>
<tr>
<td></td>
<td>■ Make sure that the media is fixed on the roll holder.</td>
</tr>
<tr>
<td></td>
<td>■ Make sure the media contains no bulge.</td>
</tr>
<tr>
<td>'Open left cover'</td>
<td></td>
</tr>
<tr>
<td>'Refill toner'</td>
<td>■ Refill the toner. (see ‘Refill the toner’ on page 266)</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Remove original'</td>
<td>Try the following solutions.</td>
</tr>
<tr>
<td></td>
<td>■ Close the top cover.</td>
</tr>
<tr>
<td></td>
<td>■ Make sure that all media scraps are removed.</td>
</tr>
<tr>
<td></td>
<td>■ Turn the printer off and on. (see ‘Turn the Océ TDS450 printer on and off’ on page 115)</td>
</tr>
<tr>
<td>'Cutter error'</td>
<td>■ Make sure that the media thickness is according to the specifications. (see ‘Specifications Océ TDS450 scanner’ on page 302)</td>
</tr>
<tr>
<td>System message</td>
<td>Description / solution</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 'Connecting...'  | There is no connection between the controller and the printer. Try the following solutions  
|                  | ■ Wait for five minutes.  
|                  | ■ Turn the system off and on.  
|                  | (see ‘Turn the Océ TDS450 scanner on and off’ on page 112)  
|                  | (see ‘Turn the Océ TDS450 printer on and off’ on page 115)  
|                  | (see ‘Turn on and shut down the Océ Power Logic® controller’ on page 114)             |
| 'Reset printer'  | Turn the printer off and on again.  
<p>|                  | (see ‘Turn the Océ TDS450 printer on and off’ on page 115)                            |
| 'Printer asleep' | The printer is in low power mode to save energy.                                      |
| 'Please wait'    | The printer downloads the language.                                                    |
| 'Printer ready'  | The printer is ready to print.                                                        |
| 'Preparing job'  | The printer prepares a copy or print job.                                              |
| 'Load roll 1'    | The required media is not loaded on roll 1. Load the required media.                   |
| 'A2'             | (see ‘Load the media’ on page 256)                                                     |
| 'Paper'          |                                                                                       |
| 'Load roll 2'    | The required media is not loaded on roll 2. Load the required media.                   |
| 'A2'             | (see ‘Load the media’ on page 256)                                                     |
| 'Paper'          |                                                                                       |
| 'Manual feed'    | The required media is not found. Feed the required media at the manual feed table.     |
|                  | (see ‘Make a copy on a cut sheet’ on page 201)                                         |
| 'Conditioning'   | The printer optimizes the toner concentration. Please wait.                            |
| 'Printer ready'  | Media roll 1 is empty. Reload roll 1.                                                  |
| 'Roll 1 empty'   | (see ‘Load the media’ on page 256)                                                     |
| 'Printer ready'  | Media roll 1 is empty. Reload roll 1.                                                  |
| 'Roll 2 empty'   | (see ‘Load the media’ on page 256)                                                     |
| 'Printer running' | Media roll 1 is empty. Reload roll 1 when the printer is ready.                     |
| 'Roll 1 empty'   | (see ‘Load the media’ on page 256)                                                     |</p>
<table>
<thead>
<tr>
<th>System message</th>
<th>Description / solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Printer running' Roll 2 empty'</td>
<td>Media roll 2 is empty. Reload roll 1 when the printer is ready. (see ‘Load the media’ on page 256)</td>
</tr>
<tr>
<td>'Job cancelled'</td>
<td>The active print or copy job is cancelled.</td>
</tr>
<tr>
<td>'Close roll unit'</td>
<td>The roll unit is open. Close the roll unit.</td>
</tr>
<tr>
<td>'Sensor not free' Remove paper '</td>
<td>The media of a roll was not in the start position while the printer was turned on. Turn the media back into the start position and press on line.</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Paper retracted' Remove paper '</td>
<td>The cut sheet was retracted. Feed the cut sheet at the manual feed table.</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Copy too short' Remove paper '</td>
<td>Use an original longer than 420 mm.</td>
</tr>
<tr>
<td>'Press &lt;on-line&gt;'</td>
<td></td>
</tr>
<tr>
<td>'Input flap open' Remove paper '</td>
<td>The input flap was opened during the print process. Remove the media and close the input flap again.</td>
</tr>
<tr>
<td>'Close input flap'</td>
<td></td>
</tr>
<tr>
<td>'Roll 1 empty' Open roll unit'</td>
<td>Replace the media on roll 1 (see ‘Load the media’ on page 256)</td>
</tr>
<tr>
<td>'Roll 2 empty' Open roll unit'</td>
<td>Replace the media on roll 2 (see ‘Load the media’ on page 256)</td>
</tr>
<tr>
<td>'Wait for folder'</td>
<td>The communication between the printer and the folder starts up. Please wait.</td>
</tr>
<tr>
<td>'Folder is off'</td>
<td>The folder is turned off. The communication between the printer and the folder was not created.</td>
</tr>
<tr>
<td>'Folder belt full'</td>
<td>Empty the folder belt.</td>
</tr>
<tr>
<td>'RU tape empty'</td>
<td>The tape roll of the Reinforcement Unit is empty. Open the reinforcement unit and replace the tape roll. (see ‘Insert a new tape roll’ on page 277)</td>
</tr>
</tbody>
</table>
Clear media jam in the media feed section of the printer

Introduction

If a media jam occurs, a message appears on the operator panel. In that case check if
■ The roll is installed correctly and the media is fed as indicated.
■ The correct media is used ((see ‘Available media types’ on page 310) and (see ‘Available media sizes’ on page 312)).
■ No pieces of media block the paper path.

Clear a media jam in the media feed section

1. Turn off the printer.
2. Open the correct roll compartment.
   Note: You must open one (1) compartment at a time.
3. Lower the feed table, use the two locks on the front below the feed table.
4. Remove the jammed media.
5. Close the feed table.
6. Close the roll compartment.
7. Turn on the printer.
   Note: If you can not clear the media jam by opening the feed table, then open the fuser section. See (see ‘Clear media jam in the fuser section’ on page 275)
Clear media jam in the fuser section

Clear the jam in the fuser section

**Caution:** Open the fuser only to remove the media after a media jam. Do not remove the materials from the fuser without heat-protective gloves. The surface of the fuser is hot.

1. Turn off the printer.
2. Loosen the screw at the left hand side of the machine and open the cover.

3. Lift the green handle.
4. Open the fuser unit.

5. Remove the jammed material.
6. Lift the green handle and close the fuser unit.
7. Close the left cover and tighten the screw.
8. Turn on the printer.
Maintain the finishing options

The reinforcement unit

Insert a new tape roll

Introduction

When the tape roll is empty while the printer is in stand-by, the following message will appear on the display: 'RU tape empty'. Open the reinforcement unit and replace the empty tape roll.

Remove an empty tape roll

Attention: To prevent damage to the reinforcement unit, only use the original reinforcement strips from Océ.

1. Open the side door of the reinforcement unit.

[75] Opening the side door of the reinforcement unit
2. Turn the two guide plates away from the pin roller and lock the two guide plates into their open position.

![Opening the guide plates](image1)

3. Remove the trailing strip of the old tape.

![Removing the trailing strip of the old tape](image2)

4. Open the front side plate of the roll holder (remove the screw and the old kernel.)

**Note:** *Clean the reinforcement knives before you put in a new roll. See *(see ‘Clean the reinforcement knives’ on page 287)*
Insert a new tape roll

1. Put the new roll and close the side plate. Make sure that the roll is placed with the holes to the back and the protection sheet to the front.

2. Loosen the end of the roll and lead the tape over the large guide roller.
3. Guide the tape between the upper and lower knife and over the pin roller.

4. Make sure that at least 200 mm (2 strip lengths) of tape bulges out of the knife section.

[80] Leading the tape between upper and lower knife

[81] Protruding tape
5. Align the holes in the tape with the hole pattern on the label. (You can find the label on the frame plate of the reinforcement unit.) Lift the tape from the pin roller and push the tape between the two knives until the holes are aligned.

6. Close the guide plates of the pin roller.
Prepare the tape roll for operation

1. Remove the protection sheet from the tape.

2. Guide the protection sheet back between the upper and lower knife.
3. Lift the guide and move the protection sheet between the protection sheet rollers. Pull the protection sheet tight.

![Image of protection sheet being moved between rollers]

[86] Leading the protection sheet between the rollers

4. Insert the strip of the tape into the closed section of the slide.

![Image of tape being inserted into closed section]

[87] Inserting the tape into the closed section of the slide.
5. Hold the upper guide plate down and cut the tape at the knife section. (Quickly pull the strip up so that the upper knife cuts the tape.)

6. Close the side door of the reinforcement unit.
Empty the waste box

Introduction

If a reinforcement unit is installed, the protective sheet from the reinforcement tape is stored in a waste box. For each roll of tape, you must empty the box twice.

Empty the waste box

1. Open the waste box:
   - First pull the waste box to the left hand side
   - Next pull the waste box to the front

[89] Opening the waste box
2. Empty the box.
3. Close the waste box (and)
   - First push the waste box forward
   - Next push the waste box to the right hand side

[90] Closing the waste box
Clean the reinforcement knives

Introduction

The knives of the reinforcement unit get sticky from the glue on the reinforcement tape. You must clean the knives regularly. If you clean the reinforcement knives, you must put the knives in such a position that you have access to all the parts.

You are recommended to clean the knives when
- You install a new tape roll (see ‘Insert a new tape roll’ on page 277) or
- When an error in the reinforcement unit has occurred.

Clean the reinforcement knives

**Attention:** Only use the original Cleaner K and Fixing Unit Cleaning Oil (silicon oil) from Océ, to prevent damage to the reinforcement unit.

1. Press the On-line key on the printer operator panel.
2. Select ‘Folding’ with the left or right key.
3. Press the down key to enter the ‘Folding’ menu.
4. Select ‘Clean RU knife’ with the left or right key.
5. Press the down key to put the reinforcement unit knives in the correct position.
6. Open the side door of the reinforcement unit.
7. Clean the upper and lower knife using Cleaner K.
8. Use the Fixing Unit Cleaning Oil (silicon oil) to oil the felt.

![Diagram of oiling the felt](image)

9. Close the side door of the reinforcement unit. The knives are automatically put back in their home positions. This depends on whether or not a job was interrupted to clean the knives.

10. Press the On-line key.
Handle errors at the reinforcement unit

No reinforcement strips on the output

Introduction

When there is no reinforcement strip on the output, then
- The reinforcement strip is not correctly installed, or
- The reinforcement strip is not available.

Install a new reinforcement strip

1. Press the On-line key on the operator panel to put the printer off-line.
2. Open the side door of the reinforcement unit.
3. Check for loose reinforcement strips in the unit with the protection sheet on (see situation B in figure 118).

[93] Situation A: No mechanical error. Situation B: Mechanical error.
4. If there are, remove the tape strips in the reinforcement unit.

Note: If the protection sheet is not on the reinforcement strip, there is no mechanical error. You must insert a new tape roll (see ‘Insert a new tape roll’ on page 277). If this error frequently occurs, you must call your Océ representative.

5. Remove all tape between the rollers and the knives.

6. Install a new trailing strip of tape between the rollers and the knives.
Clear tape jam in the reinforcement unit

Introduction

When a tape jam occurs in the reinforcement unit, the following message appears on the display: 'Error in folder'.

Illustration

[95] Location of the reinforcement unit

Clear a tape jam

1. Open the front door of the reinforcement unit

[96] Opening the front door of the reinforcement unit
2. Turn the two guide plates away from the pin roller and lock the two guide plates into their open position.

3. Remove all tape between the rollers and the knives.

4. Move a new trailing strip of tape between the rollers and the knives.
Handle media jams at the folder

Clear media jams in the folder

Introduction

Any jams in the folder can occur in either the first fold section, the folder transport section, the second fold section or the belt unit.

Clear a jam in the first fold section

1. Open the top cover of the folder. The green light on the right of the folder blinks quickly.
2. Remove any jammed material.
3. Open the cover of the first fold section.

4. Open the guide plate.

5. Remove any jammed material.
6. Close the guide plate.
7. Close the cover of the first fold section.
8. Close the top cover of the folder.
Clear a jam in the folder transport section

1. Open the cover of the transport section to the first fold delivery.

2. Remove any jammed material.

3. Close the cover of the folder transport section from the left side. (Lift and push the hinge to the rear.)

Clear a jam in the second fold section

1. Open the front door of the second fold section.
2. Remove any jammed material at the bottom of the second fold section.
3. Close the front door of the second fold section.
4. If you have a belt unit, put the belt in an upward position.

5. Open the delivery unit.
6. Open the guide plate with the green lever.

7. Remove any jammed material.

8. Open the vertical transport unit with the green lever.
9. Remove any jammed material.
10. Close the vertical transport unit.

[107] Closing the vertical transport

11. Close the guide plate.
12. Close the delivery unit.

[108] Closing the delivery unit
Clear a jam in the belt unit

1. Open the door of the belt unit.

2. Press the two green knobs in the upper section of the belt unit and open the plate.
3. Remove any jammed material.
4. Press the two knobs again and put the plate in its original position.
5. Release the green lever in the lower section of the belt unit. (lift and pull forward the lower section to open the lower plate.)

6. Remove any jammed material.
7. Pull the green lever again (until it locks into position) to close the plate.
8. Close the belt unit door.
9. Put the belt in the operation position (Push down carefully).
Appendix A
System specifications
## Specifications Océ TDS450 scanner

<table>
<thead>
<tr>
<th>Technology</th>
<th>■ Free-standing console</th>
<th>■ Océ Image Logic® real-time image processing</th>
<th>■ 1 x Reduction type CCD camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan speed (standard)</td>
<td>Black&amp;white</td>
<td>■ 3 m/min. or 2 inch/sec.</td>
<td>Greyscale &amp; Colour</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ 1 m/min. or 0.7 inch/sec.</td>
<td></td>
</tr>
<tr>
<td>Scan speed (option)</td>
<td>Black&amp;white</td>
<td>■ up to 5 m/min. or 3.3 inch/sec.</td>
<td>Greyscale &amp; Colour</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ up to 4 m/min. or 2.8 inch/sec.</td>
<td></td>
</tr>
<tr>
<td>Resolution</td>
<td>575 dpi</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Camera</td>
<td>3 colour linear CCD</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>21360 Pixels</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>24 bits colour</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scan width</td>
<td>914.4 mm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Original feed</td>
<td>Right aligned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Original size</td>
<td>Minimum</td>
<td>■ 210 mm x 210 mm (L x W)</td>
<td>Maximum</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ 6000 mm x 1016 mm (L x W).</td>
<td></td>
</tr>
<tr>
<td>Maximum media thickness</td>
<td>1.5 mm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale method</td>
<td>■ Scale to format.</td>
<td>Scale range 25% - 400% (0.1% fixed step interval).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Custom scale.</td>
<td>Scale range 10% - 1000% (0.1% fixed step interval).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Exact (1 to 1).</td>
<td>No scaling.</td>
<td></td>
</tr>
<tr>
<td>Input mode</td>
<td>■ Single sheet</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Set</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of copies</td>
<td>1 - 999 (scan once print many)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Colour space</td>
<td>SRGB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Image quality                      | ■ Original type selection (see ‘Original types for the Océ TDS450 scanner’ on page 304)  
                                 | ■ Colour selection (Black&White / Grey / Colour)  
                                 | ■ Brightness light/dark            | ■ Image optimization for fine details or speed |
|-----------------------------------|------------------------------------------------------------------------------------------|
| Image editing                     | ■ Remove strips (leading/trailing/left/right)                                            | ■ Mirroring horizontal             | ■ Delete area                      |
| Other functionalities             | ■ Pre-programming of next job                                                            | ■ Programmable default settings    | ■ Synchro cut mode                 |
|                                   | ■ Leading and trailing strip adjustment (0 mm - 400 mm)                                  | ■ Concurrent scanning and printing | ■ Scan to file Black&White / Grey (option). |
|                                   | ■ Scan to file Colour (option).                                                          | ■ Scan to file Black&White / Grey  | ■ Scan to file Colour (option).     |
| Interface                         | Firewire                                                                                 | Voltage                            | 85-264 V                          |
| Voltage                           | 85-264 V                                                                                 | Frequency                          | 47/63 Hz                         |
| Power consumption                 | In operation: 110 W                                                                       | Standby: 20 W                      |                                  |
| Dimensions                        | 1105 mm x 615 mm x 1240 mm (H x D x W)                                                    | Weight                             | 65 kg                            |
| Safety approvals                  | TüV GS, CE, UL, (c)UL, CB, EMC Directive 89/336/EEC, FCC Class A                         |                                  |                                  |
The original types that you can use for your Océ TDS450 scanner are listed in the table below.

<table>
<thead>
<tr>
<th>Original type</th>
<th>Type</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black &amp; white / grey</td>
<td>'Lines&amp;text'</td>
<td><img src="112" alt="Lines &amp; text icon" /> Lines / text icon</td>
</tr>
<tr>
<td>'Greys&amp;Lines'</td>
<td></td>
<td><img src="113" alt="Greys &amp; lines icon" /> Greys &amp; lines icon</td>
</tr>
<tr>
<td>'Transparent'</td>
<td></td>
<td><img src="114" alt="Transparent icon" /> Transparent icon</td>
</tr>
<tr>
<td>'Blueprint'</td>
<td></td>
<td><img src="115" alt="Blueprint icon" /> Blueprint icon</td>
</tr>
<tr>
<td>Original type</td>
<td>Type</td>
<td>Icon</td>
</tr>
<tr>
<td>--------------</td>
<td>---------</td>
<td>-----------------</td>
</tr>
<tr>
<td></td>
<td>'Dark original'</td>
<td>![Dark original icon] (116)</td>
</tr>
<tr>
<td>Colour</td>
<td>'Photo'</td>
<td>![Photo icon] (117)</td>
</tr>
</tbody>
</table>

[33] Original types
Specifications Océ Power Logic® controller

**Océ Power Logic® controller hardware**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform</td>
<td>Océ controller with Windows® XP embedded</td>
</tr>
<tr>
<td>Memory</td>
<td>512 Mb, expandable to 1024 Mb</td>
</tr>
<tr>
<td>Hard disc capacity</td>
<td>80 Gb. Two high speed hard discs, one dedicated to file spooling and one for set memory</td>
</tr>
<tr>
<td>Graphical user interface</td>
<td>Optional keyboard, mouse and monitor</td>
</tr>
<tr>
<td>Standard interface</td>
<td>10/100BaseT with RJ45</td>
</tr>
<tr>
<td>Optional interfaces</td>
<td>10/100BaseT with RJ45</td>
</tr>
<tr>
<td>Network protocols</td>
<td>TCP/IP, SMB, IPX/SPX, FTP, LPD</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Controller: &lt; 100 W</td>
</tr>
<tr>
<td></td>
<td>Monitor: 200 W (depends on monitor type)</td>
</tr>
<tr>
<td>Electrical requirements</td>
<td>100-120 / 230 V, 50/60 Hz</td>
</tr>
<tr>
<td>Applicable software</td>
<td>Océ Power Logic® controller software</td>
</tr>
</tbody>
</table>
**Océ Power Logic® controller software**

The Océ Power Logic® controller software consists of a basic module and a print module.

<table>
<thead>
<tr>
<th>Basic functions</th>
<th>File spooling on the controller. Concurrent receiving, processing and printing of digital jobs.</th>
</tr>
</thead>
</table>
| Basic applications | ■ Océ Settings Editor  
■ Océ System Control Panel  
■ Océ Queue Manager  
■ Océ License Logic  
■ Océ Remote Logic®  
■ Océ Print Exec® Workgroup LT. |
| Optional | ■ Océ Account Center. |

[34] Basic module

<table>
<thead>
<tr>
<th>Print processing technology</th>
<th>Océ Image Logic</th>
</tr>
</thead>
</table>
| Number of prints | 1 - 999  
Set memory: send once, process once, print many |
| Roll selection and switching | Manual  
Automatic |
| Print manipulation | Rotation  
Auto-scaling  
Positioning  
Pen management  
Trailing strip adjustment; add up to 400 mm |
| Colour modes | ■ Black & White  
■ Greyscale  
■ Colour |
| Quality modes | ■ Standard  
■ Lines & Text  
■ Poster |
| Language sensing | Automatic Language Sensing (ALS) |
| Standard file formats | ■ Vector: HPGL, HPGL/2, Calcomp  
■ Raster: HP-RTL, TIFF 6.0, NIFF, CALS-I, NIRS, C4, ASCII |
<table>
<thead>
<tr>
<th>Cut length</th>
<th>■ Standard cut</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>■ Synchro cut</td>
</tr>
<tr>
<td></td>
<td>■ Custom cut</td>
</tr>
<tr>
<td>Optional</td>
<td>Adobe® PostScript 3™ PDF printing</td>
</tr>
</tbody>
</table>

[35] Print module
## Specifications Océ TDS450 printer

<table>
<thead>
<tr>
<th>Technology</th>
<th>Electrophotography (LED) with organic photoconductor (OPC) drum and closed toner system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>600 dpi</td>
</tr>
<tr>
<td>Print speed</td>
<td>3 linear meters per minute or approximately 2A0s per minute.</td>
</tr>
<tr>
<td>Media sources</td>
<td>1 roll version with manual feed</td>
</tr>
<tr>
<td></td>
<td>2 roll version with manual feed</td>
</tr>
<tr>
<td>Guaranteed print length</td>
<td>15 meters</td>
</tr>
<tr>
<td>Output delivery</td>
<td>Standard Integrated Receiving Tray (IRT)</td>
</tr>
<tr>
<td>Output sizes</td>
<td>From A3 to A0 and 36”</td>
</tr>
<tr>
<td>Warm up time</td>
<td>None, instant behaviour</td>
</tr>
<tr>
<td>Media types</td>
<td>Plain, translucent, transparent, recycled, fluorescent and coloured papers.</td>
</tr>
<tr>
<td></td>
<td>Films and vellum</td>
</tr>
<tr>
<td>Voltage</td>
<td>100/115/230 V</td>
</tr>
<tr>
<td>Frequency</td>
<td>50/60 Hz</td>
</tr>
<tr>
<td>Power consumption</td>
<td>Standby: 30 W</td>
</tr>
<tr>
<td></td>
<td>In operation: 1,5 kW</td>
</tr>
<tr>
<td>Dimensions</td>
<td>1250 mm x 899 mm x 1352 mm (H x D x W), including Integrated Receiving Tray</td>
</tr>
<tr>
<td>Weight</td>
<td>Model with 1 roll: 149 kg.</td>
</tr>
<tr>
<td></td>
<td>Model with 2 rolls: 159 kg.</td>
</tr>
</tbody>
</table>
Supported media types and sizes for the Océ TDS450 printer

Available media types

Introduction

Océ machines and media are matched for the best quality and performance. Océ advises only approved Océ media. You can receive a full list of the Océ media that you can use in your printer (that includes plain paper, transparent paper, coloured papers and different polyester films) from your Océ representative.

Attention: Do not store the paper in rooms where temperature and humidity are high. Avoid dust and direct sunlight. Wrap not used paper in the plastic to prevent it absorbing moisture.

Media types

The following media types are available for the Océ TDS450 printer:

<table>
<thead>
<tr>
<th>Media</th>
<th>Type</th>
<th>Océ TDS450</th>
</tr>
</thead>
<tbody>
<tr>
<td>Océ Papers</td>
<td>LFM 110 Océ Top Label Paper 60 g/m²</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>LFM 115 Océ Top Label Paper 75 g/m²</td>
<td>****</td>
</tr>
<tr>
<td></td>
<td>LFM 116 Océ Top S Label Paper 75 g/m²</td>
<td>****</td>
</tr>
<tr>
<td></td>
<td>LFM 120 Océ Top Label Paper 90 g/m²</td>
<td>***</td>
</tr>
<tr>
<td></td>
<td>LFM 124 Océ Top Label Paper 100 g/m²</td>
<td>** 1)</td>
</tr>
<tr>
<td></td>
<td>LFM 050 Océ Red Label Paper 75 g/m²</td>
<td>****</td>
</tr>
<tr>
<td>Media</td>
<td>Type</td>
<td>Océ TDS450</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td>LFM 021 Océ Black Label Paper 75 g/m²</td>
<td>****</td>
</tr>
<tr>
<td></td>
<td>LFM 010 Eng. Standard Paper 75 g/m²</td>
<td>****</td>
</tr>
<tr>
<td></td>
<td>LFM 140 Océ Green Label TCF 80 g/m²</td>
<td>****</td>
</tr>
<tr>
<td>Océ Transparent Papers</td>
<td>LFM 220 Océ Translucent Paper 80 g/m²</td>
<td>**</td>
</tr>
<tr>
<td></td>
<td>LFM 230 Océ Translucent Paper 90 g/m²</td>
<td>**</td>
</tr>
<tr>
<td></td>
<td>LFM 240 Océ Translucent Paper 110 g/m²</td>
<td>** 1)</td>
</tr>
<tr>
<td>Océ Polyester Films</td>
<td>LFM 310 Océ Polyester Film 3.5 mm</td>
<td>***</td>
</tr>
<tr>
<td></td>
<td>LFM 320 Océ Antistatic Film 3.5 mm</td>
<td>***</td>
</tr>
<tr>
<td>Océ Specialities</td>
<td>LFM 410 Océ Fluorescent Paper 90 g/m²</td>
<td>**</td>
</tr>
<tr>
<td></td>
<td>LFM 420 Océ Coloured Paper 80 g/m²</td>
<td>****</td>
</tr>
</tbody>
</table>

**Note:** 1) Guaranteed up to 50% ambient relative humidity

**** = Excellent

*** = Very Good

** = Good

* = Fair

**Note:** Visit Océ on the internet at www.oce.com for the latest information.
Available media sizes

Introduction

Océ machines and media are matched for the best quality and performance. Océ advises only approved Océ media. You can receive a full list of the Océ media that you can use in your printer (that includes plain paper, transparent paper, coloured papers and different polyester films) from your Océ representative.

Attention: Do not store the paper in rooms where temperature and humidity are high. Avoid dust and direct sunlight. Wrap not used paper in the plastic to prevent it absorbing moisture.

Media sizes

DIN range

<table>
<thead>
<tr>
<th>Media</th>
<th>Width [mm]</th>
<th>Length [mm]</th>
</tr>
</thead>
<tbody>
<tr>
<td>A3</td>
<td>297</td>
<td>420</td>
</tr>
<tr>
<td>A2</td>
<td>420</td>
<td>594</td>
</tr>
<tr>
<td>A1</td>
<td>594</td>
<td>841</td>
</tr>
<tr>
<td>A0</td>
<td>841</td>
<td>1189</td>
</tr>
</tbody>
</table>

Engineering Inch range

<table>
<thead>
<tr>
<th>Media</th>
<th>Width [inch]</th>
<th>Length [inch]</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 inch / B</td>
<td>11</td>
<td>17</td>
</tr>
<tr>
<td>17 inch / C</td>
<td>17</td>
<td>22</td>
</tr>
<tr>
<td>22 inch / D</td>
<td>22</td>
<td>34</td>
</tr>
<tr>
<td>34 inch / E</td>
<td>34</td>
<td>44</td>
</tr>
</tbody>
</table>
### Architectural Inch range

<table>
<thead>
<tr>
<th>Media</th>
<th>Width [inch]</th>
<th>Length [inch]</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 inch / B+</td>
<td>12</td>
<td>18</td>
</tr>
<tr>
<td>18 inch / C+</td>
<td>18</td>
<td>24</td>
</tr>
<tr>
<td>24 inch / D+</td>
<td>24</td>
<td>36</td>
</tr>
<tr>
<td>36 inch / E+</td>
<td>36</td>
<td>44</td>
</tr>
</tbody>
</table>

### Others

<table>
<thead>
<tr>
<th>Media</th>
<th>Width</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>30 inch</td>
<td>30 inch</td>
<td>12 inch</td>
</tr>
<tr>
<td>B1+</td>
<td>700 mm</td>
<td>1000 mm</td>
</tr>
<tr>
<td>B1 (DIN)</td>
<td>707 mm</td>
<td>1000 mm</td>
</tr>
<tr>
<td>B2+</td>
<td>500 mm</td>
<td>700 mm</td>
</tr>
<tr>
<td>B2 (DIN)</td>
<td>500 mm</td>
<td>707 mm</td>
</tr>
</tbody>
</table>
Standard scale factor

Introduction

The Océ TDS450 can scale (reduce and enlarge) the image to a defined format. The overview below shows the scale factor if you need to copy on media of different sizes.

Attention: *If you select the wrong scale factor you can lose information.*

Supported DIN media series

The table shows the scale factor if you copy from one media size (original column) to another media size (first row)

```
<table>
<thead>
<tr>
<th>Origina ls</th>
<th>Standard scale fixed steps for the DIN media series [%]</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A0</td>
<td>A1</td>
<td>A2</td>
<td>A3</td>
<td>36 Inch</td>
<td>B1</td>
</tr>
<tr>
<td>A0</td>
<td>100</td>
<td>71</td>
<td>50</td>
<td>35</td>
<td>109</td>
<td>84</td>
</tr>
<tr>
<td>A1</td>
<td>141</td>
<td>100</td>
<td>71</td>
<td>50</td>
<td>153</td>
<td>119</td>
</tr>
<tr>
<td>A2</td>
<td>200</td>
<td>141</td>
<td>100</td>
<td>71</td>
<td>218</td>
<td>168</td>
</tr>
<tr>
<td>A3</td>
<td>283</td>
<td>200</td>
<td>141</td>
<td>100</td>
<td>308</td>
<td>238</td>
</tr>
<tr>
<td>36 Inch</td>
<td>107</td>
<td>65</td>
<td>46</td>
<td>32</td>
<td>100</td>
<td>77</td>
</tr>
<tr>
<td>B1</td>
<td>119</td>
<td>84</td>
<td>59</td>
<td>42</td>
<td>129</td>
<td>100</td>
</tr>
<tr>
<td>B2</td>
<td>168</td>
<td>119</td>
<td>84</td>
<td>59</td>
<td>183</td>
<td>141</td>
</tr>
</tbody>
</table>
```

[36] DIN table
Generic ISO media series

The table shows the scale factor if you copy from one media size (original column) to another media size

<table>
<thead>
<tr>
<th>Originals</th>
<th>Standard scale fixed steps for the ISO media series [%]</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A0</td>
</tr>
<tr>
<td>A0</td>
<td>100</td>
</tr>
<tr>
<td>A1</td>
<td>141</td>
</tr>
<tr>
<td>A2</td>
<td>200</td>
</tr>
<tr>
<td>A3</td>
<td>283</td>
</tr>
<tr>
<td>A4</td>
<td>400</td>
</tr>
<tr>
<td>A5</td>
<td>565</td>
</tr>
</tbody>
</table>

[37] ISO table
## Specifications Océ Scan Logic®

<table>
<thead>
<tr>
<th>Application</th>
<th>Océ Scan Manager, integrated scanning solution with Océ View Station LT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan destinations</td>
<td>Maximum of 10 destinations.</td>
</tr>
<tr>
<td></td>
<td>■ Scan to the local controller</td>
</tr>
<tr>
<td></td>
<td>■ Scan to a Microsoft® Windows network location with Server Message Block (SMB)</td>
</tr>
<tr>
<td></td>
<td>■ Scan to an internet location with File Transfer Protocol (FTP).</td>
</tr>
<tr>
<td>Resolution</td>
<td>72, 150, 200, 300, 400, and 600 dpi.</td>
</tr>
<tr>
<td>File formats</td>
<td>■ TIFF</td>
</tr>
<tr>
<td></td>
<td>■ PDF</td>
</tr>
<tr>
<td></td>
<td>■ CALS-I.</td>
</tr>
<tr>
<td>Available file organization types for TIFF files</td>
<td>■ RAW</td>
</tr>
<tr>
<td></td>
<td>■ Stripped</td>
</tr>
<tr>
<td></td>
<td>■ Tiled.</td>
</tr>
<tr>
<td>Available file compression methods</td>
<td>TIFF file format</td>
</tr>
<tr>
<td></td>
<td>■ None (uncompressed)</td>
</tr>
<tr>
<td></td>
<td>■ Group 3 2D</td>
</tr>
<tr>
<td></td>
<td>■ Group 4</td>
</tr>
<tr>
<td></td>
<td>■ Packbits</td>
</tr>
<tr>
<td></td>
<td>■ LZW.</td>
</tr>
<tr>
<td></td>
<td>PDF file format</td>
</tr>
<tr>
<td></td>
<td>■ Group 4</td>
</tr>
<tr>
<td></td>
<td>■ Flate</td>
</tr>
<tr>
<td></td>
<td>■ LZW.</td>
</tr>
<tr>
<td></td>
<td>CALS-I file format</td>
</tr>
<tr>
<td></td>
<td>■ Group 4</td>
</tr>
<tr>
<td>Available colour depths</td>
<td>TIFF file format</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>■ Black &amp; white, 1 bit per pixel</td>
<td></td>
</tr>
<tr>
<td>■ Greyscale, 8 bits per pixel</td>
<td></td>
</tr>
<tr>
<td>■ RGB, 24 bits per pixel</td>
<td></td>
</tr>
<tr>
<td>PDF file format</td>
<td></td>
</tr>
<tr>
<td>■ Black &amp; white, 1 bit per pixel</td>
<td></td>
</tr>
<tr>
<td>■ Greyscale, 8 bits per pixel</td>
<td></td>
</tr>
<tr>
<td>■ RGB, 24 bits per pixel</td>
<td></td>
</tr>
<tr>
<td>CALS-I file format</td>
<td></td>
</tr>
<tr>
<td>■ Black &amp; white, 1 bit per pixel</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scan mode</th>
<th>Single scan.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File naming</td>
<td>Automatically generate unique file names for each scan.</td>
</tr>
<tr>
<td>Viewing</td>
<td>View scans at point of scanning.</td>
</tr>
<tr>
<td>Océ Image Logic®</td>
<td>The best scan quality for different image types.</td>
</tr>
<tr>
<td>Ease of use</td>
<td>Job templates</td>
</tr>
<tr>
<td></td>
<td>Scan to file from the scanner operator panel.</td>
</tr>
<tr>
<td></td>
<td>Scan directly to a local or a remote destination.</td>
</tr>
<tr>
<td>Requirements</td>
<td>Océ Power Logic® Controller and a graphical user interface</td>
</tr>
<tr>
<td>Options</td>
<td>Océ View Station for editing and enhancement of scanned documents</td>
</tr>
<tr>
<td></td>
<td>Océ Batch Processor for automated editing.</td>
</tr>
</tbody>
</table>
Specifications drivers and job submission software

Océ drivers

<table>
<thead>
<tr>
<th>Software environment</th>
<th>Required driver</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD® 14 ( for Windows)</td>
<td>ADI Plotter Driver for AutoCAD® 14</td>
<td>The driver allows you to plot from the AutoCAD® R14 application for Windows® 95, Windows® 98, Windows® ME, Windows® NT to Océ printers.</td>
</tr>
<tr>
<td>Graphical application</td>
<td>Océ TDS/TCS Adobe® Postscript 3 Drivers</td>
<td>The drivers allow you to print from a Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000®, Windows XP®, Macintosh MacOS 8.6/9.x or Macintosh Mac OS X application to an Océ TDS300, Océ TDS450 Océ, Océ TDS600, Océ TDS800 or Océ TCS400 wide-format printer.</td>
</tr>
</tbody>
</table>
Optional application software

<table>
<thead>
<tr>
<th>Function</th>
<th>Application software</th>
</tr>
</thead>
</table>
| Job submission      | ■ Océ Print Exec® Workgroup   
|                     | ■ Océ Print Exec® Pro     
|                     | ■ Océ Repro Desk           |
| Viewing             | ■ Océ View Station         
|                     | ■ Océ View Station and Batch Processor                      |
| Account Logging     | ■ Océ Account Center      |
Appendix B
Miscellaneous
Reader's comment sheet

Questions

Have you found this manual to be accurate?
O Yes
O No

Were you able to operate the product, after reading this manual?
O Yes
O No

Does this manual provide sufficient background information?
O Yes
O No

Is the format of this manual convenient in size, readability and arrangement (page layout, chapter order, etc.)?
O Yes
O No

Could you find the information you were looking for?
O Always
O Most of the times
O Sometimes
O Not at all

What did you use to find the required information?
O Table of contents
O Index

Are you satisfied with this manual?
O Yes
O No

Thank you for evaluating this manual.
If you have other comments or concerns, please explain or suggest improvements overleaf or on a separate sheet.
Comments:
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------
---------------------------------------------------------------------------------------------

Date:

This reader's comment sheet is completed by:
(If you prefer to remain unknown, please do fill in your occupation)

Name:

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V.
For the attention of ITC User Documentation.
P.O. Box 101,
5900 MA Venlo
The Netherlands

Send your comments by E-mail to: itc-userdoc@oce.nl

For the addresses of local Océ organisations see: http://www.oce.com
Addresses of local Océ organisations

<table>
<thead>
<tr>
<th>Country</th>
<th>Address</th>
<th>Website</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>P.O. Box 363</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ferntree Gully MDC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vic 3165</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Australia</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Austria</td>
<td>Océ-Österreich GmbH</td>
<td><a href="http://www.oce.at/">http://www.oce.at/</a></td>
</tr>
<tr>
<td></td>
<td>Postfach 95</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1233 Vienna</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Austria</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oce.at/">http://www.oce.at/</a></td>
<td></td>
</tr>
<tr>
<td>Belgium</td>
<td>Océ-Belgium N.V./S.A.</td>
<td><a href="http://www.oce.be/">http://www.oce.be/</a></td>
</tr>
<tr>
<td></td>
<td>J. Bordetlaan 32</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1140 Brussel</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Belgium</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oce.be/">http://www.oce.be/</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Av. das Nações Unidas, 11.857</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Brooklin Novo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>São Paulo-SP 04578-000</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Brasil</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oce-brasil.com.br/">http://www.oce-brasil.com.br/</a></td>
<td></td>
</tr>
<tr>
<td>Canada</td>
<td>Océ-Canada Inc.</td>
<td><a href="http://www.oce.ca/">http://www.oce.ca/</a></td>
</tr>
<tr>
<td></td>
<td>4711 Yonge Street, Suite 1100</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Toronto, Ontario M2N 6K8</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Canada</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oce.ca/">http://www.oce.ca/</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Xu Mu Cheng</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chaoyang District</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Beijing 100028</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>China</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oce.com.cn">http://www.oce.com.cn</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hanusova 18</td>
<td></td>
</tr>
<tr>
<td></td>
<td>140 21 Praha 4</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Czech Republic</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oce.cz/">http://www.oce.cz/</a></td>
<td></td>
</tr>
<tr>
<td>Denmark</td>
<td>Océ-Danmark a/s</td>
<td><a href="http://www.oce.dk/">http://www.oce.dk/</a></td>
</tr>
<tr>
<td></td>
<td>Vallensbækvej 45</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2605 Brøndby</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Denmark</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oce.dk/">http://www.oce.dk/</a></td>
<td></td>
</tr>
<tr>
<td>Finland</td>
<td>Océ Finland OY</td>
<td><a href="http://www.oce.fi">http://www.oce.fi</a></td>
</tr>
<tr>
<td></td>
<td>Valkjärventie 7 D, PL 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>02130 Espoo</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Finland</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oce.fi">http://www.oce.fi</a></td>
<td></td>
</tr>
<tr>
<td>Germany</td>
<td>Océ-Deutschland GmbH</td>
<td><a href="http://www.oce.de/">http://www.oce.de/</a></td>
</tr>
<tr>
<td></td>
<td>Solinger Straße 5-7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>45481 Mülheim/Ruhr</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Germany</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oce.de/">http://www.oce.de/</a></td>
<td></td>
</tr>
<tr>
<td>Hong Kong</td>
<td>Océ-Hong Kong and China head office</td>
<td><a href="http://www.oce.com.hk/">http://www.oce.com.hk/</a></td>
</tr>
<tr>
<td></td>
<td>12/F 1202 The Lee Gardens</td>
<td></td>
</tr>
<tr>
<td></td>
<td>33 Hysan Avenue</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Causeway Bay</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Hong Kong</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oce.com.hk/">http://www.oce.com.hk/</a></td>
<td></td>
</tr>
<tr>
<td>Company Name</td>
<td>Address</td>
<td>Country</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Océ-Ireland Ltd.</td>
<td>3006 Lake Drive, Citywest Business Campus, Saggart, Co. Dublin</td>
<td>Ireland</td>
</tr>
<tr>
<td>Océ-Japan Corporation</td>
<td>3-25-1, Nishi Shinbashi, Minato-Ku, Tokyo 105-0003</td>
<td>Japan</td>
</tr>
<tr>
<td>Océ-Belgium S.A.</td>
<td>Rue Astrid 2/A, 1143 Luxembourg-Belair</td>
<td>Luxembourg</td>
</tr>
<tr>
<td>Océ-Mexico S.A. de C.V.</td>
<td>Prolongación Reforma 1236, 4to Piso, Col. Santa Fé, Del. Cuajimalpa, C.P. 05348, México, D.F.</td>
<td>México</td>
</tr>
<tr>
<td>Océ-Norge A.S.</td>
<td>Postboks 4434 Nydalen, Gjerdrums vei 8, 0403 Oslo</td>
<td>Norway</td>
</tr>
<tr>
<td>Océ-Lima Mayer, S.A.</td>
<td>Av. José Gomes Ferreira, 11 Piso 2 - Miraflores, 1497-139 Algés</td>
<td>Portugal</td>
</tr>
<tr>
<td>Océ-Singapore Pte Ltd.</td>
<td>190 MacPherson Road, #03-00 Wisma Gulab, Singapore 348548</td>
<td>Singapore</td>
</tr>
<tr>
<td>Océ Printing Systems (PTY) Ltd.</td>
<td>P.O.Box 629, Rivonia 2128</td>
<td>South Africa</td>
</tr>
<tr>
<td>Océ España SA</td>
<td>Océ-Svenska AB</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
<td></td>
</tr>
<tr>
<td>Business Park Mas Blau</td>
<td>Sollentunavägen 84</td>
<td></td>
</tr>
<tr>
<td>Osona, 2 08820 El Prat de Llobregat</td>
<td>191 27 Sollentuna</td>
<td></td>
</tr>
<tr>
<td>Barcelona</td>
<td><strong>Sweden</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Spain</strong></td>
<td><a href="http://www.oce.se">http://www.oce.se</a></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Océ-Schweiz AG</th>
<th>Océ (Thailand) Ltd.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sägereistrasse 10</td>
<td>B.B. Building 16/Floor</td>
</tr>
<tr>
<td>CH8152 Glattbrugg</td>
<td>54 Asoke Road</td>
</tr>
<tr>
<td><strong>Schweiz</strong></td>
<td>Sukhumvit 21</td>
</tr>
<tr>
<td><a href="http://www.oce.ch">http://www.oce.ch</a></td>
<td>Bangkok 10110</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Océ-Nederland B.V.</th>
<th>Océ (UK) Limited</th>
</tr>
</thead>
<tbody>
<tr>
<td>P.O.Box 800</td>
<td>Océ House</td>
</tr>
<tr>
<td>5201 AV ’s-Hertogenbosch</td>
<td>Chatham Way</td>
</tr>
<tr>
<td><strong>The Netherlands</strong></td>
<td>Brentwood, Essex CM14 4DZ</td>
</tr>
<tr>
<td><a href="http://www.ocenl.nl/">http://www.ocenl.nl/</a></td>
<td><strong>United Kingdom</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Océ North America Inc.</th>
<th><a href="http://www.oce.co.uk">http://www.oce.co.uk</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>5450 North Cumberland Avenue</td>
<td>Océ (UK) Limited</td>
</tr>
<tr>
<td>Chicago, IL 60656</td>
<td>Océ House</td>
</tr>
<tr>
<td><strong>USA</strong></td>
<td>Chatham Way</td>
</tr>
<tr>
<td><a href="http://www.oceusa.com">www.oceusa.com</a></td>
<td>Brentwood, Essex CM14 4DZ</td>
</tr>
</tbody>
</table>

**Note:** The web site http://www.oce.com gives the current addresses of the local Océ organisations and distributors.

**Note:** The addresses of local Océ organisations for information about the Wide Format Printing Systems and the Production Printing Systems can be different from the addresses above. Refer to the web site http://www.oce.com for the addresses you need.
access system settings 123
add a leading strip 203
add a trailing strip 203
auto original feed setting 139
auto view 153
automatic logon
   enable 71
available media sizes 312
available media types 310
available settings 188

basic copy job 184
belt unit 92, 95
   definition 244
   media jam 299
binding edge value 233
binding method 233

calibrate scanner 252
calibrate wizard 252
cancel
   print job 176
clean the glass plate 254
clean the scan area 254
clear an original jam 250
clear set memory 248
colour mode
   black and white 224
   colour 225
greyscale 224
common user 18
compact output stacker 92

components
   folder 95
   océ power logic® controller 28
   océ tds450 printer 82
   océ tds450 scanner 22

controller
   hardware
      specifications 306
   software
      specifications 307
controller 82
controller setup 103

copy
   a specific area 207, 209
   on a cut sheet 201
   with a stamp 197
copy an area 207
copy jobs
   introduction 178
copy jobs
   available settings 188
   basic copy job 184
   clear an original jam 250
   extended copy job 185
   stop a copy job 187
copy quality, according to
   fine details 190
   original brightness 190
   original type 190
copy sets 194
cut sheet
   print 174
cut sheet 201
cut the media of the printer 264

default gateway 127
define
   the binding edge value 240
   the binding method 239
   the drawing method 238
   the folded output delivery 236
the folded package length 241
the folded package width 242
the folding legend 237
define media series
printer 265
define the media size of the printer 262
define the media type of the printer 262
delete an area 209
demo print 118
destination
manage 150
dhcp server 124
din media series 314
display languages
controller 119
printer 120
scanner 119
drawing method 233
drivers 318

E
error messages
printer error messages 269
scanner error messages 251
extended copy job 185

F
file name
define 152
file type
scan to file 224
finishing options
belt unit 92
compact output stacker 92
folder 92
output delivery tray 92
reinforcement unit 92
finishing options 92
finishing settings
overview 232
folded output delivery 233
define 236
folded package length 233
folded package width 233
folder 92
belt unit 95
components 95
media jam 293
reinforcement unit 95
stacker 95
folding
off-line 245
folding legend 233
fuser section
media jam 275

g

gateway 127
glass plate 254

I
install reinforcement strip
reinforcement unit 289
ip address 125
iso media series 314

J
job submission 98
printer drivers 172
job templates 137
scan-to-file 212

K
key operator 18

L
licenses 75
load media 256
M
manual feed media type 174
media 256
media feed section
  media jam 274
media jam
  belt unit 299
  folder 293
  fuser section 275
  media feed section 274
media series setting 142
media sizes 312
media types 310
menu card 116

N
network settings 122
  default gateway 127
  dhcp server 124
  ip address 125
  subnet mask 126

O
océ engineering exec® 109
océ license logic 75
océ power logic® controller 28
  applications 29
  location 28
océ print exec® workgroup 173
océ repro desk 108
océ settings editor
  auto original feed 139
  job templates 137
  media series 142
  original release mode 140
  paper series 142
  stamp creation 141
  stamp settings 141
  top 5 settings 137
océ tds450 printer 82
océ tds450 scanner 22
océ view station lt 57

off-line folding 245
operator panel
  scanner operator panel overview 24
  scanner operator panel usage 180, 214
original release mode setting 140
original type
  background compensation 227
  blueprint 227
  dark original 227
  greys & lines 227
  lines / text for paper 227
  photo 227
  transparent for transparencies 227
original types for the scanner 304
original width
  auto 228
  custom 228
  standard 228
output delivery tray 92
overview 99
overview of the finishing settings 232

P
paper series setting 142
password 72, 73
power logic controller
  log off 74
  log on 74
  queue manager 50
  remote logic 62
  settings editor 33
  start the applications 40
  supported languages 67
  system control panel 44
print
  océ print exec® workgroup 173
print configuration report 117
print demo print 118
print job
  cancel 176
print menu card 116
print on a cut sheet 174
print system configuration 43
printer
  cut the media 264
  define media series 265
<table>
<thead>
<tr>
<th>Q</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>queue manager</td>
<td>cancel jobs 145</td>
</tr>
<tr>
<td></td>
<td>history queue window 54</td>
</tr>
<tr>
<td></td>
<td>icons 56</td>
</tr>
<tr>
<td></td>
<td>inbox queue window 54</td>
</tr>
<tr>
<td></td>
<td>job priority 146</td>
</tr>
<tr>
<td></td>
<td>menu bar 53</td>
</tr>
<tr>
<td></td>
<td>overview of the functions 50</td>
</tr>
<tr>
<td></td>
<td>place jobs on hold 146</td>
</tr>
<tr>
<td></td>
<td>print jobs 144</td>
</tr>
<tr>
<td></td>
<td>printer window 54</td>
</tr>
<tr>
<td></td>
<td>restart jobs on hold 146</td>
</tr>
<tr>
<td></td>
<td>status bar 54</td>
</tr>
<tr>
<td></td>
<td>structure 52</td>
</tr>
<tr>
<td></td>
<td>toolbar 54</td>
</tr>
<tr>
<td></td>
<td>user modes 51</td>
</tr>
<tr>
<td></td>
<td>user operations 144</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>S</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>scale</td>
<td>199</td>
</tr>
<tr>
<td>scale formats</td>
<td>standard 314</td>
</tr>
<tr>
<td>scan area</td>
<td>254</td>
</tr>
<tr>
<td>scan manager</td>
<td>57</td>
</tr>
<tr>
<td>scan quality</td>
<td>252</td>
</tr>
<tr>
<td>scan to file</td>
<td>colour mode 224</td>
</tr>
<tr>
<td></td>
<td>compression method 224</td>
</tr>
<tr>
<td></td>
<td>file type 224</td>
</tr>
<tr>
<td></td>
<td>organisation 224</td>
</tr>
<tr>
<td>scan to file jobs</td>
<td>resolution 226</td>
</tr>
<tr>
<td>scanned file</td>
<td>delete 154</td>
</tr>
<tr>
<td></td>
<td>print 153</td>
</tr>
<tr>
<td></td>
<td>view 153</td>
</tr>
<tr>
<td></td>
<td>view the properties 154</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>R</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>refill the toner</td>
<td>266</td>
</tr>
<tr>
<td>reinforcement knives</td>
<td>287</td>
</tr>
<tr>
<td>reinforcement unit</td>
<td>287</td>
</tr>
<tr>
<td>reinforcement strip</td>
<td>289</td>
</tr>
<tr>
<td>reinforcement unit</td>
<td>92, 95</td>
</tr>
<tr>
<td>definition</td>
<td>243</td>
</tr>
<tr>
<td>install reinforcement strip</td>
<td>289</td>
</tr>
</tbody>
</table>

| printer          | 28                                                               |
| printer configuration report | 117                      |
| printer demo print | 118                          |
| printer drivers  | 172                                                              |
| printer error messages | 269                        |
| printer menu card | 116                                                              |
| printer operator panel | 84                         |
| keys             | 85                                                               |
| screen           | 85                                                               |
| printer sleep mode time-out | 133                      |
| printer system messages | 271                        |
| remote logic     | add system 69                                                    |
|                 | connect to controller 69                                         |
|                 | install                                                          |
|                 | unix 64                                                          |
|                 | windows 63                                                       |
|                 | remove system 70                                                 |
| remote logic     | applications 62                                                  |
|                 | command line parameters 66                                       |
|                 | start applications 66                                             |
|                 | remove a leading strip 205                                       |
|                 | remove a trailing strip 205                                      |
|                 | remove strip                                                     |
|                 | leading 229                                                      |
|                 | left 229                                                         |
|                 | right 229                                                        |
|                 | trailing 229                                                     |
| repro operator   | 18                                                               |
| resolution       | scan to file jobs 226                                            |

| scanner          |                                                                 |

330 User manual
original types 304
specifications 302
scanner 22
scanner error messages 251
scanner operator panel
  overview of functions 24
  overview of keys 24
  usage 180, 214
scanner operator panel time-out 131
scanner sleep mode time-out 130
scan-to-file
  job templates 212
scan-to-file job 212
  basic 212
  basic 218
  extended 212
  extended 219
  introduction 212
scan-to-file jobs
  checkprint setting 222
  destination setting 222
  lighter/darker setting 222
  mirror setting 222
  settings 222
scan-to-file jobs
  clear an original jam 250
  stop 221
set memory 248
set time-out 132
sets copy 194
settings editor
  key operator settings 31, 41
  load settings 43
  save settings 42
  system administrator settings 31, 41
shut down the controller 114
solutions
  printer error messages 269
  printer system messages 271
  scanner error messages 251
specifications
controller
  hardware 306
  software 307
drivers 318
océ scan logic” 316
optional application software 319
printer 309
scanner 302
stacker 95
stamp 197
stamp creation setting 141
stamp settings 141
standard scale formats 314
stop
  scan-to-file jobs 221
  stop a copy job 187
strip
  add a leading or trailing strip 203
  remove a leading or trailing strip 205
subnet mask 126
system administrator 18
system control panel
  icons 49
  menu bar 46
  print a list of current settings 43
  print system configuration 43
  status bar 48
  toolbar 47
  user operations 44
system messages
  printer system messages 271
system settings 123
  default gateway 127
dhcp server 124
  ip address 125
  subnet mask 126

T

tape jam
  reinforcement unit 291
tape roll
  reinforcement unit 277
temporary store
  clear 154
the binding edge value
  define 240
the binding method
  define 239
the drawing method
  define 238
the folded package length
  define 241
the folded package width
define 242
the folding legend  define 237
time out settings
  printer sleep mode time-out  128, 133
  scanner operator panel time-out  128, 129, 131
  scanner sleep mode time-out  128, 129, 130
  set time-out  128, 129, 132
toner
  refill 266
top 5 settings  137
turn the system on/off
  océ power logic® controller  114
  océ tds450 printer  115
  océ tds450 scanner  112

U
user mode  57, 73
users  18
  anonymous user  18
  common user  18
  key operator  18
  repro operator  18
  system administrator  19

W
waste box
  reinforcement unit  285
workflow  100
workflow  12
  documents  12
  jobs  12
  overview  12
  products  12

Z
zoom  199